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Elements is a photo editor and org¢
gives you the control to find, cataloc
and share your favourite images ef

It is very likely that in this digital age, the number of photos you have on your
computer is vast. It is very easy to take photos and deposit them on your computer
and never look at them again. It is also likely that you have photos that you really
like but that might be underexposed, badly lit; or could be improved if you were
able to remove an annoying background distraction. You may even want to cut you
subject out, put it into another scene entirely and create a new look for an image.

If you've ever wanted to do more with your photo collection but didn't need the
advanced power of Adobe Photoshop CC, then Elements is for you.

Now, thanks to Adobe Photoshop Elements, you have an easy and affordable
means to find all those elusive images, organise them and manipulate your favourite
ones to make them even better. It is easier than ever to quickly and easily make your
images look amazing with just a few clicks of your mouse. From automated and
guided edits to hands-on expert modes, you can create exactly what you want. The
only thing holding you back is your imagination.
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Free Media Download

We have compiled this exclusive media
download so you can work alongside
our expert team with our step-by-

step guides. To take full advantage of
this exclusive offer for all readers of

this publication, you simply need to
download these essential free resources,
To do this, just visit us at:

LOOK OUT FOR
THIS LOGO

Any tutorial
displaying it
indicates that it
will be available
to download
from ouwur site.

This tutorial
content is
available for
download

bdmpublications.com/ultimate-photoshop

Then you will need to register, log in and finally select this title from the listings to
begin your download. So visit www.bdmpublications.com/ultimate-photoshon today
and take advantage of this amazing opportunity to enhance your reader experience.



AT
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Starting with
Photoshop
Elements

If you are new to Photoshop Elements, cataloguing your
photos and digitally manipulating them may seem like a whole
new world you have to conquer. Do not worry though, we will
guide you through the basics and get you started on your way
to becoming a skilled user of the software. We hope to have
you importing, tagging, organising and editing your photos
like a pro in no time at all. With that in mind, let’s begin the
journey and get you more familiar with how it all works.

6 BDM's independent Manuai Series | Volume 19
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STARTING WITH PHOTOSHOP ELEMENTS

What is Photoshop
Flements?

Let's take a moment to get to know a little more about the software
and how it can help you with your day to day image editing.

a dobe Photoshop Elements is a
great option for those who want
an extensive toolset that can take

on most of their image editing needs,

without the requirement of highly
advanced features such as you would
find in Photoshop CC. It is also a great
choice for those who only need one-
click solutions to their image editing
needs, or perhaps want to start to

learn how to take on the more involved

techniques and tools that Elements has !":Kd {]bE‘. Ph Otos h O |:J = [E ments 2019

to offer. Another big plus point in its

favour is that it is one of the very few
remaining Adobe products that can be
purchased outright, without the need
for subscription,

A Worthy Alternative

There was a time when, in certain
quartars, Elemeants was considerea a
dumbed-down version of Photoshop
with a limited toolset, that was

only meant for beginners with no
aspirations to advance to the more
technically advanced techniques seen
In Fnotashop. However, recent versions
of Elements have shown that it s a
worthy standalone alternative to using
Photoshop. It is a focused image editor
and cataloging application that is more
than capable of taking on any image
editing task you care to send its way.

In its current form, Adobe Photoshop
Flements is comprised of two main
components. One 15 the image editing
module of the software whera you
can touch up your phofos or even
manipulate and transform them bevond
recognition. The Edit section 1s broken
down into three sections. The first is
the Guick Edit mode, then comes the
Cuideg Mode section and finally theare is
the Expert mode.

Make the Most of Modules

Each module has its own set of tools
and preset options that can quickly get
the job done. Quick Edit, a5 the name
suggests, contains the basic editing

Adobe Elements

Organizer 2019
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The Adobe Photoshop Elements and Organiser interfaces are
designed to be as intuitive as possible with plenty of options
for beginners and experienced users alike.

tools such as colour correction, cropping,
quick selection, spot healing, sharpening and
lighting fixes. You can also apply some one-
click presets such as Smart Fix, Exposure
and Lighting.

Helping Hand

The Guided modulea is also fairly self-
explanatory. Here you can make any numiber
of popular image adjustments to your
photos, with guided step-by-step tutorials,
such as altering brightness and contrast,
resizing photos, rotating and straightening
yvour images and adding vignettes. It also
has a number of specialised and fun options
for restoring old photaos, creating your own
frammes and replacing backgrounds.

More Advanced Options

WHAT IS PHOTOSHOP ELEMENTS?

Finally comes the Expert mode. This has
more of the feel of its big brother, Photoshop
to it. It has a toolbar ranged down the left
hand side of the workspace and on the right
15 the layers panel that behaves much in the
same way as Photoshop's layers palaette. Here
you also have access to a number of pholo
colour presets such as Faded Fhoto, Glow
and Monotone Color. There are also a number
of filters for more artistic effects such as
coloured penc |5, watercolours, distortion
effects and sketch filters. You can also add
Bevels, Patterns, Strokes, Photographic
Effects and much more by accessing the
icons in the lower right of the taskbar at the
bottorm of your workspace, Expert mode

Is the most hands-on of the three modes

you can employ and gives you access to

all the tools, so you can apply all your own
advanced edits to your photos.

Getting Organised

The second main component of the latest
Adobe Photoshop Elements i1s the Elerments
2019 Organiser. At its heart, this 15 a
cataleguing and pheto crganising program
that lets yvou import, sort, tag and rate your
photos. IF you wish, yvou can create albums
and use names, |locations, date, time and GPS
data to sort them. The program can even
ermploy face recognition to find and sort
photos of people and tag tham much as you
would in Facebook. Indeed, you can actually
import your list of Facebook friends as an
aid to tagging the people in yvour photos. If

a2 — s
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it detects a2 similar name being entered
as a tag, it will display those existing
names similar enough as a match to be
an option for tagging

The two components of Photoshop
Elements and Elements Organiser
are separate programs, which can be
a bit of nuisance if vou need to keep
switching between them but you have
at vour disposal a set of powerful

i e el
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editing tools that will keep beginner and
expert hapoy.

Ower the page we'll begin to delve
deeper into the workspaces offered by
the Editor and Elements Qrganiser. It is
Best to consider the Editor module as your
cigital aarkroorm and design studio and to
think of Elements Crganiser as your library,
where you keep all your media itemns such
as photos and videos.
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The Elements
Home Screen

We start the journey by becoming more familiar with all the module

environments you will be working with.

Welcome Home

When you open Adobe Photoshop
Elements 2019, you are presented with a
Home screen. This simple screen is your
gateway to the Photo Editor program or
the Organiser. The third option available
is to activate the Adobe Premiere
Elements Video Editor, if you have
purchased that as well. If not, it will ask
if you want to download a trial version.

You also have the option at the
top of the Home screen to search for
help on things you want to achieve in
the programs or to click on any of the
featured Try This guides and What's New
itemns and Inspiration articles ranged
across the screen.

On the extreme top right of the page
are buttons for Facebook and Twitter
and a Help button that takes you to
Adobe Customer Support.

o Search Option

From the home page you can can search
for things yvou need to learn more about.
If wou want to learn how to make a
calendar for instance, type that in the
search bar and it will show you links to
help files that can tell yvou more.

9 Featured Guides

Ranged along the top of the home page
are a number of clickable guides and
inspirational media that gets you into the
heart of what Photoshop Elements 2019
15 all about. There are several themeas
you can access, Try This are guided
tuterials that help you create exciting
media and art. What's New highlights all
the step-by-step features that are new
to this version. Inspiration is a collection
of stories and articles to get you in a
creative mood.
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What would you like to do today?

e.9. | would like to make a greeting card

Create a Slideshow

3

Auto Creations

Import more media
for Auto Creations

Add media to your
Organizer to receive
creations of your favorite
memaories.

Add Media




o Auto Creations

When you open the home page for the
first time, you will be prompted to add
media for Auto Creations to make a
series of personalised creations, such as
slide shows that use your own photos
and videos.

o Add Media

Auto Creations are created with media
(photos or videos) that you've imported.
If vou haven't imported any media vet,
click Add media under Auto Creations on
the Home screen and relaunch the app.
You can open and edit any Auto Creation
and instantly share it with vour family
and friends

o Program Chooser

To the right of the home page are the
icons for Organiser, Photo Editor and
Video Editor. You can click aon these to
activate the relevant program. If you do
not have the Adcbe Premiere Elemeants
video editor program for instance, it will
ask you If yvou want to try if for free with
the option to purchase later if you wish.

o Recent Files

Any images you have been working on
recently will be displayed here for guick
access. Click on the image yvou want
to continue working on and it will be
opened within the relevant program

Q00
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THE ELEMENTS HOME SCREEN

o Facebook Button

Click this button to go to the Adobe
Photoshop Elements Facebook page.

o Twitter Button

When yvou click this button, it will take
yvou to the Photoshop Elemments Twitter
feed where you can view, reply to,
retweet and like tweets,

o Help Button

f wou need further assistance, you can
click this button to be directed to the
Adobe Customer Support webpage.

Explore the Guides

For those who are in need of more guidance, or just
some creative inspiration, go ahead and click on any of
the featured guides and articles to explore more of the
online world of features Adobe Photoshop Elements has
to offer.

WHAT'S NEW
4

-
£

Adobe Premiere EI&:

Guide » Introduction to Adobe Premiere Elements

3 Fade Transition effect - Guided E

itic scene transition by foding in the colors!

Add luma fade transitions Add a spe

d edit to create a cool transition effect between two video clips, two imag
ion effect creates a dramatic scene transition by fading in the colors from da

information, see Create o Lumna Fode Transition effect - Guided Edit

5

Video
Editor

Photo

Organizer Editor

o RECENT FILES

T dawlish 1.jpg
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STARTING WITH PHOTOSHOP ELEMENTS

The Quick
Mode Workspace

For fast and simple edits, this is the mode to get you editing
quickly, with one-click results for better photos.

One-click Power N

Although this mode is designed to

be quick and simple to use, it is still a
powerful method to rapidly improve
your photos with easy one-click
presets that give you instant feedback
on how your image will look with the
new adjustments applied. There are
many filters to choose from and many
ways you can adjust your image to
make it perfect, so you can share it
with the world.

o The File Menu

Although a number of file menu option
will not be accessible, the main ones
that you need will be available. All the
Enhance options are there as well as the
Filter Gallery preseats,

o Mode Selector

Here can you can exit the current mode
and choose to enter the Guided or
Expert modes.

o The Open Button

This is a simple button to specify a new
project to work on. Click it to create a
new document at the size you want.
When you click OK, the document will be
created and can be worked on in either
Cluick mode or Expert mode.

o The Toolbar

The Quick mode toolbar has a core set
of tools to get yvour image looking great Hand
with minimal effort. You can make guick . y
selections to specific areas of the photo, 1 o
crop it, straighten the horizon, whiten -
teeth and fix eyes as well as adding text

and a number of varied filters, textures & |7 12 IR 54 ") 1)

and adjustments. FhotoBin Tosi Options® Unde  Fedo  Aotale  Organizer Home Screen

L L LT

P Screen Fil Sereen Print Sine
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o The Tool Options Bar

For every tool you activate in the toolbar,
vou have another panel called the Tool
Options bar that gives you many moaore
choices as to how that tool can be
modified and controlled. There are also
additional tools that can be accessed in
the Tool Cptions bar.

o The Taskbar

The taskbar is situated at the bottom
of the workspace and contains all the
most frequently used actions, which are
displayed as buttons, Click each one
and you can see all the images you are
working on at that time, display or hide
the Toolbar Options bar and Undo or

redo any steps you have performed on
your image. You also have the option
to rotate the image and activate the
Elements Organiser if you need to,

o View Options

Clicking on this button reveals the View
options. This s useful iIf yvou want to
compare a before and after view of yvour
currently active image, to see how much
the image has changed from its original
untouched state.

o Active Image Area

The image you are working on is
displayed in this area. It will either be as
a single image or, if you have chosen a

X B

(s
L2

R
id

|.'

Lighting

BallE

= ~ @O

Adjustments Effects  Texbures Frames |

THE QUICK MODE WORKSPACE

different view option, as two images that
represent the before ana after state of
the photo.

o Zoom Slider

his slider lets you quickly zoom your
image from 1% all the way up to 3200%,

@ Create and Share

These two dropdown menus display
options for creating slide shows, photo
bocks, greetings cards, calendars,
Facebock Covers and much more, You
can also share yvour works of art on
Facebook, Flickr and Twitter.

Q The Panel Bar

This panel changes content depending
on what adjustment or effect you are
using. If you are using the Adjustment
tools, then they will be displayed in

the right hand panel bar. ltems such as
Smart Fix, Exposure, Lighting and Colour
will be available here and each can be
clicked to reveal ILs availlable options. The
Effects menu, Textures and Frames are
also available to be accessed here,

Create and Share

Don't forget to check out the Create and Share
options. Whether you want to share your creation
online and on social media or make prints of your
photos or even calendars, click the buttons to
explore further.

-«

o Il Slideshow i
e slideshow
o Photo Collage
#=3  Photo Prints
IE Photo Book
-° Greeting Card
E Photo Calendar
=] cD Jacket
a. DVD Jacket
3/DVD Label

wyovbdmoublicationscom 13
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STARTING WITH PHOTOSHOP ELEMENTS

The Guided
Mode Workspace

This mode is great for accomplishing a variety of effects, with
a handy guide for each one you use.

o Category Selector o Black & White o Special Edits

Here can you can select which effect you This section has a number of effects More specialised image manipulation
want to apply to vour image. There are centred around monochrome. Black and effects are kept in this section of the
six categories of effects to choose from. White, B&W Colour Pop, BE&W Selaction, Guided edit workspace. It contains

3 High Key, Line Drawing and Low Key. Raeplace Background, Depth Of
o Basics . Field, Frame Creator, Orton Effect,

e Fun Edits Perfect Portrait, Recompose, Replace

Contains the Basic effects Brightness Background, Restore Old Photg,
and Contrast, Correct Skin Tone, Crop You can find a lot more creative edits Scratches And Blemishes, Text
Photo, Levels, Lighten and Darken, Resize under this category. You have some and Border Overlay, Tilt-shift and
Your Photo, Rotate and Straighten, diverse effects to try out such as Double Watercolour Effect
Sharpen and Vignette Effect. Exposure, Effects Collage, Meme Maker,

QOut of Bounds, Painterly, Partial Sketch,

Multi-photo Text, Old Fashioned Photo, o Phﬂtﬂmergﬂ
o Colour

Photo Text, Picture Stack, Pop Art, The Photomerge section mainly
This category contains Enhance Colour, Puzzle Effect, Reflection, Shape Overlay concentrates on blending two or more
Lomo Camera Effect, Remove Colour Effect, Speed Effect, Speed Pan and pholtos ar extracting and merging
Cast and Saturated Film Effect. Zoom Burst Effect, subjects from one shot into another.
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There's Photomerge Compose,
Photomerge Exposure, Photomerge
Faces, Photomerge Group Shot,
Photomerge Scene Cleaner and
Photomerge Panorama.

o Open

f vou choose to select a new image from
the Cpen menu during a8 guided edit, you
will be asked if you want to discard the
current guide, in order to start a new one
with the image you are about to open.

o Zoom Tool

Click the Zoom Tool icon or press £ to
activate the zoom tool. You can magnify
the image up to 3200%. Wherever you
click with the mouse, the image will be
magnified and the point you clicked will
be placed in the centre of the workspace.
Press the Alt key on your keyboard to
decrease the magnification factor.

@ Hand Tool

Click the Hand Tool icon or press H to
bhe able to move your magnified image
arcund, With the Hand Tool active, click
and drag your photo to mowve it around
within the active iImage area.

0 View Options

Clicking on this button reveals the View
options. This is useful if you want to
compare a before and after view of your
currently active image, to see how much
the image has changed.

ASCES HRIIDESEE LHIEEETCL OO Tl Lon st

@ Photo Bin view

Where appropriate, this menu button
displays options on how to view

any currently active images that are
contained in your Photo Bin.

@ The Taskbar

The taskbar is situated at the bottom of
the workspace and contains all the most
frequently used actions,

@ Active Image Area

This is where the image you are working
on will be displayed.

@ Zoom Slider

This shder lets you quickly zoom vour
image from 1% all the way up to 3200%

@ Guided Steps Panel

Whichever effect you choose to apply
to yvour image, the steps required 1o
complete it are displayed as numberad
steps in the guidance panel an the
right of the active image area. You can
follow the steps, clicking the appropriate
buttons and altering parameters until
vou are ready to commit the changes.,

@ Next and Cancel

Click Next to commit the changes of the
guided edit you have just applied or click
Cancel to cancel the edit entirely and
beqin again.

WVlwy 1N LN

|
e

e B8

THE GUIDED MODE WORKSPACE

@ Save

Once you have clicked Next, you can
choose to save your image or save it
undsr a new name an-:;;"c-f mage format.
You can also elect to continue working
on the image in either Expert or Quick
mode. You can also choose Share to
upload it to Facebook, Twitter or Flickr.

@ Done

Simply returns you to the Guided
category page, |f you look in your

Photo Bin, your image will have a small
brush icon in its top right corner, which
indicates it has edits applied. If you close
the image and haven't saved it, vou will
be prompted to do so if you wish,

Create -~ Share -~

Picture Stack L7

What would you like to do riesdt?

Savi

@ Adobe Photoshop Elements 20

View: After Only

"4 Pictures

After (Roll over to
1. Select Number

!!"‘* I Ir'! =-‘h.

8 Pictures

2. Change Border Width

12 Pictures

» @
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STARTING WITH PHOTOSHOP ELEMENTS

The Expert
Mode Workspace

For those who have developed their skills to the point where they
are comfortable getting more hands-on with their images.

1 Imege Enhance Layer Select Filter View Window Help

o The File Menu

Most of the File menu options will be

made available to you in this particular E.E.QT
workspace, since all the tools and o
effects parametears are there Lo be used = L.

rmanually with little or no guidance from =N
the program. L]

) The Open Button %i :

Commaon to each workspace, click on =
the Open button to view any recently i, 3 :
acltive images you have been working on

or to create a new blank file ready to be é B
worked on. F &
T 7 B
€) The Tools Panel o [
Rry

This panel contains all the essential tools o as
you are going to need for powerful and
flexible image editing. It Is broken down
into View, Enhance, Draw, Modify and - |
Colour sections.

o Document Tab

Each imaage that is open will be markegc
by a documeant tab to identify sach
image. It will display the filename cf the
photos currently open.

9 Active Image Window

This displays the current image vou are
working on.

o Document Info

You can choose what information about
vour active document is displayed here

o Tool Options Panel

This IDEIF'“ID| Is context sensitive andg
displays additional options and controls
for each toal that vou select from the
tool panel.

B o c Du o

Fhoto Bin - Tl Dptions ©  Urdo Aeda Arae Layout  Organizer Home Screen

O 00D
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o Photo Bin

The Photo Bin panel displays thumbnails

of all open photos currently being used
by the program.

o Undo/Redo

Clicking the Undo button allows you to

step back through any actions you have

performed on your image, Redo allows
vou to step forward.

@ Rotate Tools

Allows you to rotate vour image in 45°
steps eitner clockwise or anticlockwise.

o Layout

If you have a number of documents

open at one time, yvou can choose from a
number of layout options to display them
all at once within yvour active image area.

@ Switch to Organiser

Clicking on this button will open up the
Elements Organiser program where you
can view and select images that you
have imported and catalogued.

@ Home Screen

Click this button if you want to return to
the Home screen.

= FridMar 073641

inho | haviganes

Lapers  Effects  Fibers Styles  Graphics Mo

THE EXPERT MODE WORKSPACE

@ Layers

One of the key aspects of more
advanced image editing is to be able to
work across multiple layers within your
active document

@ Effects

This will display all the effects options
currently installed. They range from
rubber stamp effects to pencil sketch
effects and colour tints, which can all be
applied to your photos.

@ Filters

Ranging from artistic effects to brush
strokes and distortion and pixelation
options, clicking the Effects icon will
cdisplay all the creative effects available
to be applied to the image

0 Styles

There are a number of colour, texture
and special effects that can be appliec
to any subject that is currently on a layer.
They range from fibreglass textures to
fire, chrome, bevelled edges and tints

@ Graphics

These are background graphics that can
e downloaded and used as backdrops
In your compositions.

@ More

A pop up menu where you can open
more currently hidden panels,

@ Layer Options

This panel allows vou to add new layers,
group selected lavers, adjustment layers
and masks.

@ Layers Panel

This is where layers are viewed and
consists of the base background layer
and any subseguent layver copies, brand
new layers or layer adjustments.

@ Layer Properties

For each layver adjustment yvou add, you
have the carresponding properties panal
to control its effect

When you click on any of the Layers, Effects,
Filters Styles and Graphics buttong, the main
panel on the right of the screen will display the
corresponding panel for each one you choose. Our
example is currently displaying the Layers Panel.

wuwbdmoublicationscom 17




STARTING WITH PHOTOSHOP ELEMENTS

The Expert

Mode Toolbar

All the main editing tools you need in Expert mode are accessible

from the toolbar on the

f you've used older versions of Elements
I or Photoshop, the main components

of the toolbar will be familiar to you.
There have been updates and additions
to the tools available but most will be
recognisable for what they are and you
should be able to get to grips with the
newest ones without too much issue.
Although each tool has additional options
displayed down in the Tools Options
Panel, if you hold the Alt key and click on
a toolbar icon, you can cycle though all
variants of that particular tool to get to
the one you want. Here is a breakdown of
the toolset available in Adobe Photoshop
Elements 2019.

g
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When you click on any of the Layers, Effects,
Filters, Styles and Graphics buttons, the main
panel on the right of the screen will display
the corresponding panel for each one you
choose. Our example is currently displaying
the Layers Panel.

The Tool Options bar

The Tool Options bar

appears at the bottom of the
Photoshop Elements window
and it displays the options for
any selected tool in Expert and
Quick mode

1 Active Tool

The currently active tool is
highlighted.

2 Related Tools

Any related tools associated
with the main tool, selected
from the taolbar, will be
displayed here.

3 Additional Options

Far any tool that you have
selected and have active, there
are a number of additional
options that let you control
various parameters relating to
that particular tool.

20% | 2
] | ™ ©proxmiy maten | srush:
: (O Content Aware
5 s L1 Smempie
2.9 C >R
Tool Options®  Undo Redo  Rotate Layout Organizet




THE EXPERT MODE TOOLBAR -

Key to Symbols

O

=P (@7 PP (e
EdNEDAR

50
View Tools use targeted contrast effects on your 39 Ellipse Shape (U)
photos and much more. 40 Polygon Shape (U)
The tools found in the View Tools section 41 Star Shape (U)
of the toolbar are designed for basic 14 Evye (Y) 42 Line Shape ()
rmagnification: zooming in and out of 15 Spot Healing Brush (J) 43 Shape Select (L)
yvour photo and moving it around the 16 Healing Brush (1) 44 Horizontal Type (T)
screen to view a portion of the zoomed 17 Smart Brush (F) 45 ‘“ertical Type (T)
image at your chosen magnification. 18 [etailed Smart Brush (F) 46 Horizontal Type Mask (T)
19 Clone Stamp (5) 47 “ertical Type Mask (T)
1 Zoom (Z) 20 Pattern Stamp (5) 48 Text on Selection (T)
2 Hand (H) 21 EBlur (R) 49 Text on Shape (T)
22 Sharpen (R) 50 Text on Path (T)
Select Tools 23 Smudge (R) 51 Pencil (N)
24 Sponge (R) .
This section covers all the tools that 25 Dodge (R) Mﬂdlfy Tools
allow you to select all or parts of your 26 Burn (R)
Image for targeted editing, cutting out or This set of tools is primarily concerned
duplication to new layers. Draw Tools with how vou can affect the crop and
intelligently move items in the frame for
3 Maowve (V) The Draw section of the toolbar contains different compaositions.
4 Rectangular Margquee (V) various elements that let yvou paint, draw,
5 Elliptical Marquee (V) erase and sample colours in your photos. §52 Crop (C)
6 Lasso (L) The text tools are also in this section. 53 Cookie Cutter (C)
7  Polygon Lasso (L) 54 Perspective Crop (C)
B Magnetic Lasso (L) 27 Brush (B) 55 Recompose (W)
9 Quick Selection (A) 28 |Impressionist Brush (B) 56 Content-Aware Mave (Q)
10 Selection Brush (A) 29 Colour Replacement Brush (B) 87 Straighten (P)
N Magic Wand (A) 30 Eraser (E)
12 Refined Selection (A) 31 Magic Eraser (E) Colour Tools
13  Auto Selection (A) 32 Backaround Eraser (E)
33 Paint Bucket (K) Here you can set your foreground and
Enhance Tools 34 Gradient (&) background colours, swap them over if
35 Evyedropper/Color Picker (1) required, access the colour picker and
The set of tocls found in this section of 36 Custom Shape (L) set back to default as required.
the toolbar are for enhancing the image. 37 Rectangle Shape {U)
You can heal, clone, blur, sharpen and 38 Rounded Rectanale Shape (L) 58 Colour Tools

wuovbdmoublicgtionscom 19




STARTING WITH PHOTOSHOP ELEMENTS

The File
Menu Layout

Get yourself familiar with the file menu system and you will see
just how powerful the program can be.

@ Adobe Photoshop Elaments 2018 Editoer File Edit Image Enhance Layer Sedect Filter WView Window Help
About This Mac

dobe Photoshop
Elements has many one-

click solutions to make System Preferences...
yvour photos look their best App Store... 140 jpg & S6.7% [Loves 1, Layor Mask/8) = | ¥ monument-valley-53637 jpg @ 50% (RGE/E) *
but over time you may find the Recent [tame : '

need to dig deeper into the

5 Force Quit Adobe Photoshop Elemenis 2079 Editor
more advanced options that are JE e S Fhaehop Eleme g

on offer with the Photo Editor. Sleep

Many options are presented in Restart...

the taskbar at the bottom and Shut Down..

the panel bar on the right. If Lock Screen

you need them however, the Log Out Mark Frost...

File Menu is where you can find
all the vital tools.

About Photoshop Elements.. Undo Rectangular Marquee 3 Z Rotate
About Plug-in Dp en... = l‘.'J T

- ransform
Legal Notices... Open in Camera Raw... W 3#0 Revert {+38 A c
Preferences Open Recently Edited File [ Col 9 X rop
Duplicate... e Recompose

VRS Copy o Divide Scanned Photos

) Close 3 W Copy Merged {+38C ¥
. F %i E

Hide Photoshop Elements saH Close All W Paste a8 \ Resize

Hide Others = oH Save % G Paste Into Selection Qv

Save As... 43S Delete Mode

Quit Photoshop Elements #Q Save for Web... NO#HS Fill Selection... LONTVIRE Loy S oii

Stroke (Outline) Selection...

File Info...

Place...

Organize Open Files...
Process Multiple Files...
Import

Color Settings...
Preset Manager...

Print Start Dictation...

Contact Sheet Il...
Picture Package...

From this menu Yyou can see One of the Key Meanus you Im many ways, Edit is qguite Here you can make many

the About screen and manage access at the start and end of similar to the options available changes to your photos. You
any Plug-ins as well as update & session. You can create new on a word processor. You can have various rotation and

vour Preferences and quit j¢L| ents, opan existing oneas copy. paste, delete or merge transformation options along
FPhotoshop Elements. You can and save tm:rrl You can also images. You can also fill with cropping and resizing. You
alzo view any legal notices or ||'r|r ort or print your documents selections, alter colour settings can also convert the colour
hide the workspace. and create contact sheets. and undo acticns. mode or profile of the image.
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EEE CTE

Auto Smart Fix

ALTO Smart Tone...
Auto Levels

Auto Contrast

Auto Haze Remowval
Auto Color Correction
Auto Shake Reduction
Auto Sharpen

Auto Red Eye Fix

Adjust Color

Adjust Lighting

Adjust Smart Fix...

Convert to Black and White...
Haze Removal...

Adjust Shanpness...
Dpen Closed Eyes...
Adjust Facial Features...
Shake Reduction...
Unsharp Mask...

Mary of the main adjustment
options are found here. Theay
range from contrast, brightness
tone, sharpness and colour. Youl

can also access the Open Closed

Eyes feature and much more.

View

New Window for mill-1620440.jpg

Zoom In
Zoom Out

Fit on Screen
Actual Pixels
Print Size

v Selection
Rulers
Grid

anap To

Lock Guides

New Guide...

Some of the basic zoom in
and zoom out options are
kept here including being able
to view the print size of your
image or turn the visibility of
rulers, grigs and selections on
and off,

yer
New »>
Duplicate Layer...
Delete Layer

Rename Layer...
Layer Style

New Fill Layer
New Adjustment Layer

Type

Layer Mask
Create Clipping Mask

Group Layers

Hide Layers

Arrange

Merge Down
Merge Visible
Flatten Image

A vital aspect of image
manipulation is the ability to
add layvers of affects to vour
Image. Here you can adda new
layers, fill layers and adjustment
layers for non-destructive edits.

Images
v Tools

Actions
Adjustments
Color Swatches
Effects
Favorites
Filters
Graphics
Histogram
History
Info

v Layers
MNavigator
Styles

v Panel Bin
Reset Panels

hong-kong-1990268.jpg
v mill-1620440.jpg

Inis menu lets you contro

the visibility of certain tools
ang panels and turn them on
and off as needad. The major
adjustrent panels, including
Effects, Layers and Filters, can

pe controlled hare

Select

All

Deselect H#D

Inverse ol

All Layers
Deselect Layers
Feather... HED
Refine Edge...

Modity g

Grow
Similar

Transform Selection

Save Selection...

Every time you make a
selection of all or part of vour
Image, vou can modify its
propearties here, You can feather
the edges, expand or contract
It, invert it and save it.

Search

Photoshop Elements Help...
Getting Started...

Key Concepts...

Support...

Video Tutorials...

Forum...

Home Screen...

System Info...
Manage My Account...
Sign Out (mark.frost@bdmpu

Should you need i, you can
enter search parameters for
any issues you encounter. There
are also a number of options
presented to yvou that can help
youl in certain situations should
they arise.

at A

THE FILE MENU LAYOUT

Filter Gallery...

Correct Camera Distortion...

Adjustments
Artistic

Blur

Brush Strokes
Distort
Moise
Pixelate
Render
Sketch
Stylize
Texture
Other

F ¥ Y Y ¥y Y Y Y °YT

v

Digimarc

This menu has all the creative
and fun filters that can add
new life to your photos. Add
blur, sharpening, distortion
and artistic effects at the

click of a button.

Shortcuts

When you explore the file menus on
offer in Adobe Photoshop Elements,
each menu and sub-menu will
always display the keyboard short
cut next to the action or tool. To
speed up your work flow, it's always
a good idea to become familiar with
those short cuts.

'..WEL'-L'.ggm E}Migﬂigr‘;.ﬁm
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STARTING WITH PHOTOSHOP ELEMENTS

Guided Mode
Categories

Here is a quick reference sheet of all the current guided tutorials
available in Adobe Photoshop Elements 2019.

Your Guide

Easy-to-follow guides

At the time of writing, there are
currently 53 guided edits available in
i Adobe Photoshop Elements 2019, Just as the name
1 File > They can be accessed from suggests, the Guided

- the Guided workspace mode is designed to help

After (Roll over to see Before.

1. Select Number of Pictures

NS

what each effect is rest for you.
designed to achieve.

page and are you produce a number C el | & -ri
distributed under of creative and artistic ‘: A N
e W - six categories. effects by taking you — = ]
- ~; ¥ g Each one through the process in 4 Pictures 8 Pictures 12 Pictures
W cde has a small numbered steps. It is
3¢ § SR before and a semi-automatic edit Bl P
ry' after slider where you click various
{3 S BN EE” that gives you a available options and - - -
B quick overview of Elements does the
Small

Medium Large

3. Change Background
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GUIDED MODE CATEGORIES

Brightness and Contrast Correct Skin Tone

o This lets yvou adjust the brightness of your photo and 9 Your photos may suffer from a colour cast that can make
control how much contrast i1s present. You can view the vour human subject’s skin look a little off in terms of
after image only or view both the before and after images either its colour tone, This guided edit can alter the tan, blush and
vertically or horizontally. lightness of skin.

After;

Levels

Crop Photo
o A crop box will be drawn on your photo so you can resize o This uses a levels adjustment whereby you can alter the

that box to whatever size and proportion you like. You can shadows, highlhghts and middle tones brightness of yvour
restrict it to certain proportions and change the overlay to Grid selected image. Any adjustments are made globally across the
or Rule of Thirds. entire image.

T E'S Himms T H R
Lighten and Darken Resize Your Photo

o The Lighten and Darken option can be viewed as a more o You can output for web and print and will be presented
simplified version of the Levels adjustment option. You with a couple of options that control the final size of your
are given three sliders that affect the brightness of Shadows, image. You can specify width and height pixel dimensions and

Midtones and Highlights. apply the result,

bdmgub et 23




STARTING WITH PHOTOSHOP ELEMENTS

Rotate and Straighten Sharpen Photo

o You have the options to rotate yvour photo clockwise and o You can use an Auto Fix sharpening effect or vou can use
anticlockwise and if you have a sloping image, you can use the supplied slider to manually increase the amount of
the Straighten Tool to bring it back to level sharpening until yvou have it how you want it,

Enhance Colours

o This lets you add a soft dark or light border to your image. @ You have an Auto Fix option to make a best-guess at

You can control its intensity and use sliders to change the the correct colour balance and contrast in the photo.

softness of the vignette and its roundness. Otherwise, vou can use the Hue, Saturation and Lightness sliders
to fine tune it.

|

Lomo Camera Effect Remove a Colour cast

0 This replicates the effect of the popular and cheap cameras @ A colour cast is an unwanted bias towards a tone that
that create a very specific look due to their low guality spails the look of your photo. You can use the colour picker
manufacture. You can also add a vignette to the photo. to find an area of pure grey, white or black to remnove the cast
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GUIDED MODE CATEGORIES

Saturated Film Effect Black and White
@ Applying this effect makes your photo look as though @ This is a quick black and white conversion with four
it was shot on old slide film for a much more saturated presets ranging from light to dark. If you want, you can
look. You can add the effect a number of times to increase the add a diffuse glow to the imaage for a dreamy effect or increase

intensity of the effect. the contrast,

— s . g R , T -
“Before S -- - "*--f‘-ﬁftef_ rE:-eﬁ:-ne _ oy \4.' After
€ -

| 1

B&W Colour Pop B&W Selection

@ Select a preset colour or use the colour picker to keep one @ You can use a selection brush to selectively pick cut
colour and turn the rest of the image to black and white. the areas you want converted to black and white whilst
You can refine the effect and also increase the saturation of the retaining colour elsewhere. You also have the option to invert the

remaining colour. effect if required.

Line Drawing

0 High key images are characterised by their very bright @ This effect mimics the look of a pencil drawing. Click to
appearance with very little shadow detail left in the photo convert the photo into a pencil sketch and if you want to,
You can use a colour or black and white high key effect vwou can add a small amount of colour back into the image and

darken the linas,
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STARTING WITH PHOTOSHOP ELEMENTS

Double Exposure

@ Works in the opposite manner to a high key image. It is @ You can combine and blend two images together for a
characterised by small amounts of highlight detail and is more creative effect. You can use a preset image or one
dominated by darker tones. You have the colour and black and of your own photos and superimpose it over the subject in your

white options. main composition.

Before

wit A =

Effects Collage Meme Maker

9 With this effect, your chosen image is split into a number of @ Great for creating memes for social media. This tool guides

sections chosen by vou and then a number of effect styles wou Dy letting you create a meme template, edit your text

are added to each saction of the collage. and resize the main subject’'s photo. You can apply new borders
and add effects for a memorable look,

After,

Multi-Photo Text Old Fashioned Photo

@ You can create visual text using this guide, placing a @ Converts yvour photo using one of three black and white
different photo inside each letter. Add your text and then presets; also lets you adjust the tone of the conversion and
one by one, you can place a photo inside each letter. You can the tint colour of the image to create an old fashioned photo.

also add a new background and add effects to the text.
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GUIDED MODE CATEGORIES

Out of Bounds Painterly
This effect can take vour primary subjact and make it look @ Turn your photo into a painting with this artistic effect. It
like it is escaping from the frame of the photo. You can add provices you with a number of preset brushes to paint onto
a frame and then select the area of the shot you want to extend vour photo, Choose a canvas colour and texture and then add an

outside the frame and add a shadow for more depth. optional effect to enhance the painterly feal.

Partial Sketch Photo Text
@ This gives you a choice of effects that you can apply to @ Lse yvour photo as the basis of creating some creative text
vour photo. Then you can simply paint using a2 brush over effects. Choose your font and how you would like it to
your image where yvou want the chozen effect to appear. You appear on your photo, then select the background style. You can
can work with more detail if required and change the size and also choose the intensity of bevel drop shadow and outline of
opacity of the brush you use, vour text,

Picture Stack Create Pop Art
@ Turn your photo into a collage with the Picture Stack @ Lo psvchedelic and turn vour phato inte some fun pop art,
affect. Choose the number of pictures you want yvour photo Choose from the styles available and then convert it into
divided intc and then add a border to each element. Then you a monoachrome or posterised version. You can also add a neon

can add a selid or gradient background for the finishing touch. glow if you wish, or tint it a single colour.
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Puzzle Effect

9 Your photo can be turned into a jigsaw puzzle with this
effect. Choose the puzzle piece size you want to use.
Extract pieces for a more creative effect and arrange them oy
moving them to another part of the design and rotate the pieces
f nesasd,

9T A L
Shape Overlay Effect

@ Choose from a series of different shapes and then position
it over yvour photo and scale it to the required size. Then
you can add an effect to both the inside and outside of the
shape's area, before cropping it to your preferred proportions.

Speed Pan

@ Add motion blur to vour backgrounds to give the
impression of fast motion. Select your main subject using
the selection tools and then add motion blur to the background,
Keeping your main subject sharp.
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Create Reflections

@ Add reflections to vour photos for eye catching results.
Simply add the reflection and then use the tools provided
te colour the reflection, fill the background and then make the
reflection lock more like glass or water,

Speed Effect

@ Add some great blurred speed lings for a little more zoom
in yvour photos. Use a selection tool and choose an area of
your image to apply the effect to. Then yvou can acdd the speed
effect and then precisely refine the look of your finished effect,

Zoom Burst Effect

@ This mimics the effect of rapidly zooming vour camera lens

while you take the photo. You can crop your photo in arder
to put your primary subject in the centre of the shot and then
add the zoom burst effect, Refine the area of focus and add an
optional vignette.




Depth of Field

@ You can make your subject stand out in the photo by making
the distracting background blurred as it photographed with
very shallow depth of field. You can add simple bBlur or use more
precise selections for more targeted effects.

Create Orton Effect

@ Basaed on an old slide film technigue pioneered by Michagl
Orton, yvou can add a soft and dream-like gquality to vour
photos. Apply the Crton effect as many times as you wish and
then use the sliders to enhance the effect even further.

Recompose

@ This works much in the same way as Photoshop's content-
aware scale tool, This tool lets you scale an image but
maintain the important content and detail in the photo. You also
have the option to mask areas for greater control,

Frame Creator

@ Use yvour own photos and graphics to create frame designs.
Use the tools to select the areas you want to be vour frame
and then save that frame design s¢ you can work on it further in
Expert mode

\ CF
| .l'I ]
A

Perfect Portrait

@ For great looking skin in your portrait photos use these
tools to heal blemishes in skin, remove red eve and whiten
teeth. For a glamorous look to yvour shots, you can also add a
glow effect and even slim your subjects down if required.

Replace Background

@ With this set of tools, vou can select your primary subject
using one of a number of selection tools and then remove
their background. Select a new background or texture and

then place it behind the original to match the colour tones for a
convincing rasult.
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STARTING WITH PHOTOSHOP ELEMENTS

I{'_

a

Restore Old Photo

@ If vou have a number of olg scanned photos that have many

blemishes on them, then this tool can make them loak new

again. Using healing tools, blur tools and clone stamp copies, you

can improve those old photos with ease.

Text and Border Overlay

Choose from a selection of border designs to frame your

favourite photos. Choose its size and colour and then add
a text overlay using the type tool. You can then specify the taxt's
position and edit the text style used.

Before

Watercolour Effect

@ A simple and effective way to turn your favourite photaos
nto watercolour paintings. Choose an effect, add a
watercolour paper overlay and a canvas texture. Then you can
refine the effect and add captions in various text styles.
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Scratches and Blemishes

@ For any small blemishes and flaws in a photo, use this tool
to quickly fix those troublesome areas with the spot healing
brushes, Larger areas will benefit from the application of the
nealing brush,

Tilt-shift

@ Turn your images into miniature effect photos using this

specialised blur tool. It works best on photos taken from

above your subject and from a distance. It mimics the effect of
expensive tilt-shift lenses. Modify the focus area and add blur,

contrast and saturation,

Photomerge Compose

@ This allows you to select two photos you wish to work on
and extract from one photo and place it on another to
combine the two. You have selection tools to help you accurately

extract your first sulpject, then you can place it, move and scale it
on the second photo.




GUIDED MODE CATEGORIES

Photomerge Exposure Photomerge Faces

This is a form of high dynamic range photography. This tool @ Combine facial features from two different portrait photos

lets you combine two or more different exposures of the for humoraus results. Select two faces and open tham. You
same shot to create a much more exposed version. Use automatic  can then use the alignment tool to pick out three distinct areas
or manual modes for the final result on each face and then blend them together.

| P

Photomerge Group Shot Photomerge Scene Cleaner
LIse multiple group shot images to make sure everyone has @ If you have a series of photos of the same subject but there
their eyes open or 15 looking at the camera. Select two or are distractions in each, you can combine two or more
similar group shots taken together. Set one as the final image photos to clean up the scene. Use ane base image and blend in
and use additicnal photos to merge preferred elements into the the best parts of additional photos to create a finished result.
final photo.

Try This

Don't forget to check out the

inspirational news stories — | =

and guide information What would you like to do today

available on the Home e.g. | would like to make a greeting card

screen. There is plenty
to pique your interest.

Create a watercolor effect

Photomerge Panorama

Turn any photo into a beautiful, textured
watercolor — and even add text. Try now

@ Great for creating super-wide panoramic shots, Combine

a sequence of several photos that captures a very wide i
panoramic scene by merging them. Select vour photos, choose

vour panorama layout and type of settings and the program

does the rest for vou. cre. .




Using Adobe

Most modern digital cameras allow you to shoot in a picture
format known as Raw mode. Raw mode is a pure digital readout
of the data captured by the sensor. This offers amazing scope
when it comes to getting the very best out of your photos.

Step inside your very own digital darkroom and take control of
the final look of your photos. More than that, see how you can
iIntegrate Adobe Camera Raw (ACR) and Photoshop Elements
for a professional looking workflow solution.
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34

USING ADOBE CAMERA RAW

The Camera

Raw Interface &&

L et's take a look at the ACR interface, see what it has to offer and
also how it can integrate with the Elements Photo Editor.

In the Raw

Adobe Photoshop Elements 2018
comes with Adobe Camera Raw
supplied. It is more usually referred

to as ACR and lets you process Raw
files from digital cameras as the first
step of your digital photo processing
workflow; but you don't have to stop
there. You can process your Raw file
and then continue to work with it in
the Photo Editor in either the Quick
or Expert editing modes. It is easy to
get started. Let's take a look at the
ACR interface, see what it has to offer,
and also how it can integrate with the
Elements Photo Editor to help you get
more out of your favourite photos.

o Zoom Tool

A standard zoom in and zoom out

tool that lets you view your image

at increasing or decreasing levels of
magnification, Each time you click the
zoom tool, the image will be enlarged
to the next level of magnification.
Wherever you click on your image,

it will magnify and centre it in the
workspace using that clicked point. If
vou press Alt on your keyboard, you
can decrease the level of magnification
and zoom out. Right-click the image to
call up the context menu to display all
the preset zoom levels available.

o Hand Tool

The Hand Tool allows vou to move your
magnified image around the screen by
clicking and dragging.

BEDOM's Independent Manual Series | Valume 19
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e White Balance Tool

[0 help you remove colour cast from
vou photo, you can use the White
Balance Tool to bring the image bac

to a more nautral colour cast. Click on
the tool and then place the eyvedropper
cursor over an area of your picture that
s either meant to be white, middle grey
or solid black. It will use that reference
point to neutralise any colour cast
Right-click the screen to call up the
content menu ta display all the white
balance presets available to use.

o Crop Tool

If you need to crop your image to

Crop Tool to drag a crop box over your
image and using the control points on
the box, scale and rotate it to get the
perfect crop for your photo. Right-click
on the cropped iImage to call up the
context menu to view more praportional
cropping options and to clear the crop if
vou need to start again.

9 Straighten Tool

This is particularhy useful if yvou have
strong vertical or horizontal elements In
your photo that need to be levelled so
they are perfectly vertical or horizontal.
Click the Straighten Tool and then click
anda draw a line along the part of your
photo that needs to be stralgntened out.
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THE CAMERA RAW INTERFACE

o Red Eye Removal Tool

f you happen to have a photo of a
family member or friend whose eyes are
coloured red because a camera flash
Huminated the blood vessels at the back
of their eyves causing the red-eye effect,
vou can remove the redness using this
tool. Click and drag a marguee selection
over each eye and the program will do
the rest,

o Open Preferences

Opening this dialog box allows you to

set some Camera Raw Freferences such
as where your image settings are saved
and whetner yvou automatically sharpen
all images. You can also set other auto

functions such as tone adjustments and
also specify how DNG files are handled.

o Rotate Image

ets you rotate your photo clockwise or
anti-clockwise in 90° increments

Control Tabs

Continue over the page and we delve into the
control tabs, colour treatment options and profiles
of the Adobe Camera Raw interface.

I 200
: 213
B: 227

SMH

/71 1200 s
IS0 31 15-30@15 mm

Basic =
Treatment: O Color Black & White
Profile: Adobe Standard . gg
White Balance: Custom
Temperature 6200

to Default

[ +0.80
_—— 3
*7
T T T
-83
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USING ADOBE CAMERA RAW

The Camera
Raw Interface

Our journey around the Adobe Camera Raw interface continues
with more of the tools to bring the most out of your photos.

Carrira Rav 11,

o Ful I Sc rEE“ Mnde o .dr.lLte Photoshop Elements 2018 Editer  File Edu

o R

Clicking this button lets yvou toggle the |=ﬂ'. M F e ‘e
full screen mode. When you do, no file
menus will be visible until you toggle
full screen off again.

@ Shadow Clipping

Shadow Clipping is there to warn you if
any of the darkest tones in your photo
become solid black. A blue highlight
will appear to warn you which parts of
the photo are clipped.

o The Histogram

This is a graphical representation of the
distribution of colour and tonal values
throughout the image. The amount

of tones in any given part of the tonal
range are shown as peaks along the
length of the histogram.

@ Highlight Clipping

This works In the same way as the
Shadow Clipping warning. If any of

the brightest highlights in the image
are solid white, or get pushed to solia
white as a result of editing, they will be
displayed as red highlights.

@ Information Panel

The left side of the panel shows the
RGE values of the image at the cursor
position. The right sice of the panel
displays the exposure information for
the image such as aperture, shutter
speed and IS0,

+ B Bits/Channel
16 Bits/Channel

B Bits/Channel

Depth:

1600%

ML NEF

Fit in View

Save image._.. Dagdsc | B DEyTharne -
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@ Control Tabs

The ACR interface breaks down the
workflow process into discreet sections,
First is the Basic panel where the
majority of your processing will be
done. You can control all the basic
exposure and colour adjustments

heare. The Detail tab reveals sliders

for controlling Sharpening and Noise
Reduction. The Camera Calibration tab
lets you specify the calibration process
YOU are using.

@ Treatment and Profile

Gives you the choice of processing your
photos in the main colour workspace or
in the Black and White workspace, The

1 - Hlkon DE10

Profile menu allows you to choose from
a number of preset colour profiles and
a series of artistic, modern and vintage
effects too.

@ Zoom Levels

Instead of using the Zoom Tool, you can
use the Zoom Level options.

QView and Settings

The buttons let yvou cycle through the
available before and after view options,
swap the before and after settings, copy
the current settings to the before image
and toggle between the current settings
and the default settings.

F FriB M 08:15:06

@ ffa 30.00 s
ISO 180

16-30@15 mm

Treatment: O Color

J Profile: Adobe Standard

Black & White

= Mbhs
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Tressment: ) Colker Fnce B WRAE

=]=]
Pralle fdobe 5priam
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Temperaturg ring
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Shadows +11
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Blacks +5
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oo Vibranze
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'

Ssbsratmn

Bags =

= BaW
P Modern

» Vintage

- =
Cuoine Cancel LEI:IIH Imlﬂl_:'

THE CAMERA RAW INTERFACE

@ Help and Save

Help accesses the Adobe el files for
ACR processing, whilst the Save button
allows you to save yvour current edits to
DMNG file format.

(&) Depth

Choose from 8 Bits/Channel and 16 Bits/
Channel colour depth

@ Done, Cancel, Open Image

Done Commits all edits and exits without
opening the file. Cancel gquits without
acceplting any changes and Open Image
will apply changes and open the image
in the Photo Editor.

The Profile Browser

Click on the Profile Browser button and you can
view all the standard and artistic calour presets
you can use on your photo to alter its colour. There
are a number of camera matching profiles as well
as artistic, modern, black and white and vintage.

g - 8

Adobe Vivid

e e !

-
Adobe Standard

¢ Adobe Raw

¢ Camera Matching

> Legacy

W Artistic

Artistic O7 Artistic 0B
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ADOBE CAMERA RAW

This tutorial
content is
available for
download

Processing

ACR lets you process Raw files from digital cameras as the first step

of your digital photo processing workflow; but you don’t have to stop
there. You can process your Raw file and then continue to work with it in
the Photo Editor, in either the Quick or Expert editing modes.
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Create glass pane effects

. Organizer

RECENT FILES

Photo
Editor

b

Video
Editor

T _MRKZO70.NEF ‘a hong-kong-1990268. ..

T switzerland-862870.jpg '3 polynesia-3021072.ipg

T dog-3277416.pg T monument-valley-53

o To begin, you'll need to open Photoshop Elements 2019
and from the home page click on the Photo Editor icon, this
will activate the Photo Editor program. The default is to open in
Expert mode, You can access Adobe Camera Raw (ACR) from
either the Quick, Guided or Expert mode workspaces.

p _raw

<>
=

Shared Folder

6 The Raw file, in this case a seascape shot in Cornwall, will

apen in the ACR workspace, as ACH runs In a separate
window to the Elerments Photoe Editor. You can use the zoom
tools to fill the active image area of the workspace; you can
clearly see the effect your edits will have on the photo.

CAMERA RAW PROCESSING

ients 2019 Editor File Edit Enhance Layer Select Filter Y

MNew >
Open in Ca Raw... . “¥O0

Open Recently Edited Fia (2

Image

Process Multiple Files...
Import

Contact Sheet II...

Picture Package...

o Go to File = Open in Camera Raw (Alt + Crd + O) to open
vour file browser and navigate to the folder that contains
the Raw file you wish to process, Once you have located it,
double-click the file or highlight it and press Open at the bottom
right of the browser window.

B Adobe Photoshop Elements 2019 Edito
i,

QM 2 b =k e =

straighten Tool (A)

& G

o A good place to start with a landscape shot like this is

to ensure a nice level haorizan. If yours is sloping, use the
Straighten Tool (A). Click on one side of your horizon line, then
drag across to the other side and release the button to bring it
back to level.
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R: ---
f71 1/2
G: --- |
B o IS0 31 15 P Highlight clipping warning (O
Basic Basic
Treatment: © cColor
< TR—
G 71 1200 s
Temperature 5700 N Lok
- o IS0 31 15-30@15 mm
Tint -3
e — S MH
el Basic =
Exposure +1.00
1 ; ) : Treatment: © Color () Black & White
Contrast 0
e————————————————— T
ighli ‘ o0
Highlights N 0 Profile: | Adobe Color A
Shadows 0
9 Click on the Basic tab to make sure it is the active tab and o If you turn on your Highlight clipping warning (O} and yvour
viau will see the range of adjustments available: vou can use Shadow clipping warning (U, yvou will be shown any areas
these to get tha most out of your image. The photo is slightly aof your image that are turning solid black or solid white, These
underexposed, 50 a good place to start is to increase the value of areas will suffer a loss of detail so having the warnings turned on
the Exposure by moving the slider to the right. s useful to avoid degrading the image.

[ ] Doy s W1 i (0T | e Bew'Rd P S |

o Mow, as you move the slider and increase the exposure, o An alternative to viewing the highlight clipping warning is
ary areas that are becoming too overexposad will now to press and hold the Alt key while moving the Exposure,
be highlighted in red. You can often get away with just a slight Highlights and Whites sliders to see just the affected highlight

overexposure in your images but beware of pushing it too far and areas without the image itself being seen. It does give you the

destroying the image. chance to fine tune the exposure without taking it too far,
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CAMERA RAW PROCESSING

e R A - e DG

S M fa s S

=

o IT vou are adjusting the Shadows and Blacks sliders, too
much underexposure will be highlighted in blue by the
Shadows clipping warning. Solid black areas are much like
highlighted areas: yvou can hawve a small amount of solid black
areas but beware of heavy underexposure.

Temperature 5700
e :
Tint -

N

@ Deiault
EIﬂﬂSUI‘E * +0.95

Contrast | | 0 |
Highlights i
Shadows - 0 |
e —
Whites | a
Blacks - 0 |

10

Holding down the Alt key while making Shadows and
Blacks adjustments, just the darkest areas turning solic
black will be seen to warn you there is a potential Shadows

clipping problem

0 If you want ACR to do some of the heavy lifting for you,

there is always the aption to click the Auto button. When
i o this, ! 0grs vill atlte 2L el ad “Tale
au co this, the program will attempt a set of best adjustments

that it thinks will suit the image for optimal exposure. It is
certainly a good baseline for you to continue editing,

Temperature 5700
___
Tint -1

i

Auto Default
Exposure +0.78
“'—=- 1

Contrast i
Highlights -75
Shadows +55
. e : "
Whites -10
—_— ;

Blacks 0

12

Adjustments are 2 personal thing of course but we opted
to increase the Exposure, reduce the Highlights to -75, to
recapture detail in the lightest parts of the image, and pushed
Shadows to +55 to make sure detail was kept in the darkest areas
of the shot, Whites were also reduced slightly to help keep detall

in the brightest parts of the scene.
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Blacks 0

Clarity

Vibrance

Saturation 0

@ Mext are the three slicers that affect midtone contrast
and how vivid the colours are. Clarity is a refined version
of global contrast, affecting the middle tones for more detail.
Vibrance affects muted colours first and Saturation is a more
general adjustrment for much more vibrant colours.

Datail 28
P 171 Y200 s Masking 0
B - S0 3 15-30815 mm ol

._._ #ﬂ Moise Reduction
Detall Detail = Luminance 0

Sharpening T .
Amaunt a0 .
minance Contras
Rads 1.0
=0 Colar 5
[epdwmil % )
[ Color Detall 50
Masking 0 b
Color Smoothness 50
Moise Reduction
Luminance o

@ The Detail and Masking sliders control artefacts caused

by over-sharpening. The Moise RBeduction settings let vou
control image noise present in high 1SO photos. Beware of very

high noise reduction settings that can make your photo look

: == f71 1/200s
= 0 IS0 31 15-30@15 mm
Salal Detail =
Sharpening
Amount 40
i
| 0 Y L ]

@ Click on the Detail tab to control Sharpening ang Naisa
Reduction in your photo. Sharpening is essentially an
increase of contrast between the brightest and darkest edges of
YOUr Image.

AT EOU S
150 31 15-30@15 mm

Calibration

Process

Version 3 (2012)
Version 2 (2010])
Version 1 (2003]

@ The Calibration tab is best left at its most current version,
For ACE in this form, Version 4 is the maost up to date
Process that offers the most recently improved tools and
functions within ACR. Changing it to older versions will result in
certain improvements not being possible.

Calibration
Image Settings
Camera Raw Defaults

Previous Conversion
v Custom Settings

muddy and lacking in detail.

? . & i e
Liear imporied aettings

Save New Camera Raw Defaults
Reset Camera Raw Defaults

0 To the far right of the adjustment pansls, is a small icon

comprised of four linas. When you click on this, you can call

up your image's settings, Save New ACR defaults and reset to
the standard default settings.
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QM > Bge ‘o =0C
v Normal

1t01
203
3tod
4105
5to7
91016

Custom...
+ Constrain to Image
+ Show Overlay

@ Cince yvou have adjusted the image to vour taste, one final
option is to crop your image. Use the Crop Teol (C) to draw
a crop box over your image to remove any unwanted area of the
photo and create a more pleasing composition,




hﬁ.pp |y changes_: and dismiss dialog without

CAMERA RAW PROCESSING

| E Apply changes and open image. Option-click to

e —

——— opening image.
. Daone Cancel @

open image without updating image metadata.

» IC:E:nlf.:IEﬁHT:j (Opﬂi Imag@

Done

@ If vou are happy with yvour photo and the edits yvou've made
vou can simply click the Done button and vour adjustments
will lbe saved in what is known as a Sidecar file with an XMP file
extension. This file remembers the edits you've made and applies
therm non-destructively to vour Haw file when openead,

- m
e

@ You also have the option to click Open Image and continue
to work on the photo in either of the Quick, Guided or
Expert modes on offer in the Elements Photo Editor. You can
then save the result as a PSD file or jpeg. We've decided the sky
neads to be worked on so we're going to open it

Background

Brighiness/

Hue/Saturation...
Gradient Map...
Photo Filter...

Invert
Themeimel-

The image file will now open in the Elements Photo Editor,

We're going to work on it in Expert mode because we will
need a few extra adjustments and layers to achieve our goal of
making the sky more dramatic.

0@ 0 a 5

E;lmh_

Levels 1

Layer thumbnail

B
Background

@ The 'Levels 1 laver will appear above your base iImage
which will be on a default locked layer called 'Background".
You will see that it is split into a layer thumbnail and a layer mask
thumbnail. The layer thumbnail controls the levels properties and
the layer mask controls masking properties.

@ The first thing you need to do is create a new adjustment
layer. Click on the Create New Fill or Adjustment Laver
icon to expand the dropdown menu anda you will see a number
of adjustment layer choices. Click on Levels to add a 'Levels 1’
adjustment layer to the layer stack in the right hand panel.

@ When you create an adjustment layer, its properties are
displayed in a paneal that will appear when it is added to
the layer stack. In the case of a levels adjustment, there are
three sliders that control brightness of the shadows, middle
tones and highlights.
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T
f::ﬁti}":gﬁ” .

_E}-ﬂ':'-i".“'l\-«.
Skl aifunmy

@ Move the middle tone shider from the middle to the right;
as you do so, the whole image will get darker. You can also
drag the furthest right highlight slider to the left slightly to make
the clouds a bit whiter. Concentrate on how the sky is looking
and don't worry about the rest of the image for the moment.

;r\'; i'inl.lnii:

COLOR

Switch Foreground and Background Colors (X])

@ To do this you must first make sure your Foreground
Colour is set to Black, You can click the Switch
Foreground icon or press X on your keyvboard to swap the
default foreground and background colours arcund so black is
now the foreground colour.

BEDOM's Independent Manual Series | Valume 19

L
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@ Once you have the sky looking darker and a bit more

dramatic, yvou will see that the rest of the image is too
cdark. What you can do now is use the layer mask to only let
the levels adjustment affect the sky and level the rest of the
image unchanged.

a7/
/a

pde: | Mormal

R S

@ Mext vou need to click on the Gradient Tool (G). When
yvou do, the Tool Cptions Panel will display all Gradient
Tool options. Click on the Edit button and make sure you have
Foreground to Background set as the gradient. Then make sure
the Linear Gradient button is clicked.




@ Make sure the 'Levels 1' laver mask is clicked to maks it
active and then click and drag a line with your gradient too
that starts just below the horizon and ends just above the level of
the lighthouse.

@ If vou look at vour image now, the sky is darker at the top
and transiticns to normal at the horizon and the rest of the
Image is untouched. The mask you added only lets the
adjustment you made affect the sky at the top and fades to
zero effect wheare the layer mask is black,

iments 2019 Editor File Edit Image Enhance Layer Select Filter

MNew -
Open... 2k 0
Open in Camera Raw... LED
Open Recently Edited File >
Duplicate...

2 32% (Levels 1, Layer

a8 W

Save As...

o%S
C08S

Save for Web..

File Info...

@ If wou are happy with the image, vou can go to File > Save
As (Shift + Cmd + 5) and save your composition as a
Photoshop PSD file with the layers and adjustrments intact, which
allows you to return and adjust it still further if you wish.

CAMERA RAW PROCESSING

] O @ 8 a8 B [1]
Normal - Opacity: | 100]

Levels 1

@ When vou let go of the mouse, a gradient will be drawn
on the layer mask that fades from black to white along the
points yvou clicked with your mouse, Wherever masks are used
remember that black conceals and white reveals.

Levals

@ It doesn't have to end there. You can add another Leveals
Adjustment layver and tweak the overall brightness of the

image. You can then go back to the 'Levels 1' adjustment and

make the sky even darker by sliding the middle tone tab even
further to the right.

@ Your ACRE to Elements woarkflow example is complete, You
have processed the original Raw file non-destructively,
opened the resulting processed file in the Elements Photo Editor
and made further targeted edits using adjustment layers.
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Saving to
DNG Format

Each digital camera manufacturer has its own custom format for Raw files.
Canon cameras save their Raw files with a .CR2 file extension, whereas Nikon
cameras use their own .NEF files. Not every file format can be read by every
piece of software, hence the creation of the DNG open standard format.

o DG s & publicly available Raw image format, created by e To begin the process, you will need to access the raw
Adobe as a proprietary iImage standard. It's able to store file that needs converting to DMG format. You can open
image aata in a more ganeric format that s widely compatible Elements Organiser and search for the required image. When
with many photo-processing programs. DNG Is also known as yvou have found it, highlight it, then go down to the taskbar and
Cigital Negative. click on the Editor button.

ts 2019 Editor File Edit Image Enhance Layer Sel

New >
Open... a0
Open Recently Edited Fif&® >

v
T . F e e

o The Photo Editor will open, but since this is a Raw file,
which cannot be opened directly in the Editor workspace,

o Alternatively, vou can bypass Elements Organiser altogether
and just open the Photo Editor directhy. At this point, you

Camera Raw will be opened automatically on top of the editor can be in any of the three modes: Guick, Guided or Expert. You
workspace, with your image ready to be processed and saved in simply need to be able to click on the Open button and navigate
the alternate DMNG format. to vour Raw file, or go to File > Open in Camera Raw.

46 BDOM's Independent Manual Series | Violume 18




MRK_0016.CR2

MRK_0022.CR2

XMF

MRK_0016.xmp

MRK_0405.CR2

KMAP

MRK_0042.xmp

MR

o Select the file yvou want to open. In the case of our exampla,

we have a Raw image shot on a Canon camera with the
LCR2 extension. Double-click it to open the file in Camera Raw. At
this point, you can make any adjustments that you require using
vour preferred methods,

Save O

Save in Same Location

i ¥ Save in New Location _

Select Folder...

MJsers/markfrost/Public/BDM/The Com...€

File Naming

Example: dng conversion example.dng

dng conversion example - %

*

SAVING TO DNG FORMAT

o A simple number of adjustments have been made including
Exposure, Clarity and Saturation, along with some tweaks
to the Temperature and Tint. When your image looks right, you
can go to the bottom left corner of the Camera Raw screen and
click on the Save Image button.

Select Folder... fJUsers/markfrost/Public/BDM/The Com...9|

File Naming |
Example: dng conversion example001.dng

dng conversion example
3 Digit Serial Number v |
Begin Numbering: 001

File Extension: .dng

o The Save Options panel will open, where thers is a
comprehensive set of options for yvour Raw to DNG
conversion. At the top, vou have your Destination options. You
can choose Save in Same Location to put it in the same place as
the original Raw file, or Save in New Location.

o If vou choose Save in New Location, you can specify, or
create, a new destination folder for the converted file.
Below that, in the File Naming section, you can choose a

filename for the converted file by typing text and numerals in the
File Naming fields.

Format: Digital Negative

Compatibility: Camera Raw 7.1 and later

JPEG Preview: Medium Size

Embed Fast Load Data
Use Lossy Compression:

Embed Original Raw File

o Bealow that, vou have the Format options panel. This lets
vou choose the Compatibility of yvour file and how readable
it is by older versions of Camera Raw and Lightroom. You can
alzo select the size of the Jpeg Praview and whether you wish to
Embed Original Eaw File in the conversion file.

e- . Waiched}

New files have been found in your
Watched Folders.

Elements Catalog

@ When vou click Save, the file will be created. If vou now
quit and return to Elerments Organiser. it will be added to
vour import list, if it is within a watched folder. Now wou can
activate the DNG file and edit it as you would any other Raw file
in your catalog.
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GETTING ORGANISED

The Organiser
Workspace

Before you dive in and start using the Organiser and its tools, it's
worth taking a look at the workspace and how its tools are arranged.

Find it

Use Elements Organiser to organise and
share your photos and media files. You
can view thumbnails of all your favourite
images and media you've imported. You
can view a large thumbnail of a single
media file or smaller thumbnails of
many media files. You can fix the most
common problems in the media files by
using the tools in the Instant Fix tab of
the Task panel.

0 The File Menu

The File menu options appear In the

top left of the menu bar. These are the
basic methods for interacting with the
program, manaqing your catalogues and
finding, tagging and viewing all of your
media files.

e The Import Button

FEERER E'ﬁ'

From the drop-down menu, you can
choose to import photos from wvarious
files and folders on your computer, from
your camera and card reader, Another
option lets vou search your hard drive.

@ Albums and Folders

Click the Aloums button to view any
Photo Albums yvou may have created.
Click on Folders to display a folder view
of your files.

9 Folders View

Click a Felder name to display just the
photos within that chasen folder. Click
the All Media button at the top of the
media browser window to display all
images from all folders.

@ All Media and Sort By

If wou are viewing the content of one
folder, you can click the All Media button
to leave the selected folder and see al
photos, Mext to the All Media button is

a Sort By drop-down list where vou can

BDOM's Independent Manual Series | Valume 19
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sort according to Newest, Oldest, Name
and Batches of photos.

")) Tool Options panel

The tocls arranged on the left at the
bottom of the screen represent the

main tools for tagging and organising
vour photos. You can hide the Folders
panel, Undo steps, Rotate yvour images,
Add location data, Add an Event, use

the Instant Fix feature, open the Photo
Editor, create a slideshow or return to the
Home screen,

o Status Bar

This small bar displays information such
as the number of items in the media

browser, the date range of all media and
the View Notifications button.

() Category Tabs

At the top of the Organiser window are
five clickable tabs. Media displays either
a folger or the entire catalogue. Click
this tab to view photos where you have
identified faces. Click the Places tab to
tag an image with a place on the map.

The contents of your catalogue or a
single folder will be displayed in the main
browser window.

= Fril Mar DE1E ]n =

O Search

Ratings & & + & & & [ ]Aund Curace
= ol ol ﬂ i W Tapr @ information
I

= Keywords o
O B sature
i o
O @ Preimgraghy
WA |
= Ppople Ta L ol
L & 8
1] & Family
[ g Friends
* Places Tags L
= Events Tags + -
Enage Tags
|
o @
|.
&
Tonm Eapecrdiinlo

THE ORGANISER WORKSPACE

Click this button to open the Search pane.
You can enter a search parameter or click

aon any of the search types listed down the
aft hand sicle of the search panel.

@ Create and Share

These two buttons reveal drop-down lists
where you can create slide shows, photo
books, video collages and more, Mote
that certain creations require Adobe
Premiere Elements to be installed for
video-based tasks, The Share button lets
vou email and share your media on social
media and image sharing sites.

{7} Ratings and Auto Curate

Ratings lets you filter your search by

any star ratings your Images nave

bean given. Auto Curate automatically
chooses the best photos for you. You
can spacify how many are shortlisted, up
to 500, and the results are displayed in
the browser window

@ Panel Bin

When you click the Keyword/Info
Buttan at the lower right of the
workspace, a panel opens providing
vou with a number of different ways

to add keywords and tag photos. An
nformation pane 15 provided where
information about a selected photo can
be displayed,

@ Zoom

You can adjust this slider to see your
image thumbnails larger or smaller in the
t‘_‘-‘lrﬂ.llﬁirl:_'l&.r .lFl-lil IrljU"«"‘\"

(1) Keyword/Info

Click this button to open the Panel Bin
and choose options from the Tags or
nformation panel

Tagging and Keywords

A media organiser is only as

good as the tagging and
keywords associated with
your images. Spend
some time tagging
your images to
reap the benefits
when it comes
to searching
and retrieving
them again.
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Setting Up
Flements Organiser

Elements Organiser 2019 gives you complete control over how you
import, search, tag, organise and share your photos and videos.
Organiser scans your files and analyses your photos and can even find

faces ready for you to identify.

W Create multi-photo text Elements Qrganizer keeps track of your media through a i
Catalog.
Convert.
Most people keep all their media in one Catalog, which can
have thousands of photos and videos. You might want a
separate Catalog for a special purpose, such as business
photos and videos. Each user of the program can have their
oWwn catalog.
- B | Bl B | o
§ @ () Caralogs Accessible by the Current User ' \
{(® Custom Location LS
e RECENT FILES Q} Remave |
e T reptile-204 2906 edit., ., T3 rabbit-1B82699.jpg : - l

o When you open Elermnents, you are presented with the
Home Screen. Down in the lower right are the programs
avallable to use or to try a free trial. Click on Organiser to activate
it and follow any on-screen prompts.

lements Organizer keeps track of your media through a [ = ]
Latalog.
Convert..
fost people keep all their media in one Catalog, which can
)ave thousands of photos and videos. You might want a
eparate Catalog for a special purpose, such as business
shotos and| @ M
i catalog -
[M'r Catalog 1 B
_atalogs . =
__| Import free music into this catalog Rename |
) Catalog
Cancel DK
B Custom i |
Macintosh HD/U...s/My Catalog 1 Browse... Remove |
| COptimize !

o There is usually a default catalogue created but you have
the option to use the Catalogue Manager to create a
custom location for your catalogues. Click the Custom Location
and then Browse to the location where you would like to create
your custom catalogue,

Videns 50 you Can easily 1nd therm [ater Dased on
who you were with, where you were and what
you were doing.
Organize your medsa with the Elemen
Start Importing i

If wou are creating a new folder, vou can give it a bespoke

narme and then hit the Create button to make the folder
into which vour catalogue will be placed. Once you have done
that, vou can then give a name to your catalogue. We have called
ours ‘My Catalog 1. Click OK to creata it.
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The Craaniser workspace will open and vou will see the

main Media workspace displayed. If yvou are using it for the
first time, it will prompt vou to start importing images ready to
De organisedq.
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SETTING UP ELEMENTS ORGANISER

X L __1__8

Irnpot from TP ing folders
Chri ol tad Tekded 16wk 118 ebdia o e

2 bl selgnimd Troen § Polders

e Arldl Foidar..

-

There are also screans giving yvou a brief overview of what

cach section of the Organiser program can do. The Peocple
section can identify faces for tagging. The Places section can
geotag or let you manually add location data to your images and
Events groups yvour images by date and time.

0 Start the process by clicking the Start Importing button
and Organiser will ask you to add folders from which to
import media and photos from. You can add and subtract as
many folders as you wish. Click Add Folder to choose more, and
aven customise how much content from 2ach s imported.

W G T e e [
m < » [El= wl =- 8 Public :
Eavaritas ) Shared Polder
= Recents
=hl= Dropboa (Persanal) w
%% Dropbox (Team BOM)
(3] Macintosh HD Crop Box gopre 66 of 170 imemls) imported | Stop |
BE Pube fUsersmarkfrost/Pu..erial /dawlish 2.jpg
1 markdfrost — | 38
: Chared k
v Applications PR ey ]
T Desktop
Eﬁ Docwments
2 itloud Drive _ m
, 5 domain-AirDrop - No media available. Click 'Import' to add media
o= Add Folder.. J O Dol S e Ghaeisaie W
M Filder

o When vou click Add Folder, browse to where vour folder
of images are kept and double-click it to add it to the
impaort list. There is a small icon shaped like binoculars that when
highlighted, informs you when new files are added to that folder.
When you are ready, you can hit the Import button.

0 All the selected media vou chose will be imported. If you
have chosen a lot of images, yvou will see a progress bar
listing the items as they are imported. When complete, Organiser
will display a grid view of yvour images ready for you to start
working on.

=

L

o Click on the People section and it will start the process of
scanning your photos looking for faces so you can organise
images by people. The Places section will display images ready
for yvou to add location data; unless they already have GPS data
attached, whereboy they will be pinned to the mapg.

@ Oct 2018 - Nov 2017 / Add Event

# Add Event

& Jul 2017 - Jan 2016

10 The Events section displays all vour photos in chronological
: ordear based on date and time. You can create new avents
and stack all images of that event within it. Now that vou are
organised, let's find a little more about the workspaces on offear,
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GETTING ORGANISED

Tagging ana
Keywords

If your photo library is large and scattered across many folders, it
would help if they were tagged and had keywords added to make your
searches more streamlined and efficient. Rather than trawling through
folder after folder, why not tag them with keywords?

B Albums Bl Folders
3 —
My Folders -=
B Albums @l Folders  Sort By: |Newest -] E2 serial
& animals
as aerial lad examples
laz animals as hdr
faz events o people
ad examples A photos
s hdr
ai people T
” JUsers /markfrost/Public/BDM/Adobe
A photos P
ot places
o From the Home screen, click on the Elements Organiser o We made a folder called 'Places’ that contained a number
con to open the Organiser workspace. We worked in of images but only a few of them were relevant to our

Folder view with the Media tab clicked and all media currently
on display. We had some example images of Dartrmoor in Devon
that we wanted to tag for future reference.

5 items selected

!:H.x-,n;nr I

9 Mow that the images are selected, vou can begin to tag
them. The first and foremost requirement is to add a place
tag. In the taskbar, click on the Add Location button. This calls
up the Add a2 Location dialogue panel. Cur shots were taken at a
place called Haytor, so we entered 'Havtor' in the dialogue panel.
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particular requirement of moorland photos. The first thing we
did was to press the Cmd key and left-click each of the required
moorland photos. There were five shots in total.

5 ivems selected
Haytor

Haytor Hotel, Meadfoot Rd, Torguay, England TQL ZXD, United KL
Haytar Drive, Exeter, Exeter, EX4 2EP, United Kingdom

Haytor Road, Torbay, Torguay, TQ1 4LP, United Kingdom

Haytar Grove, Mewton Abbaot, Newton Abbot, TQ12 405, United K...

Frass enter and the dialog panel will show you possible

locations basad on the name vou enteraed. We knew ours
was in the Dartmoor National Park, so clicked on that option
and then the Apply button to add that location data to the five
mages we had selected.

Haytor, Dartmoor Mationa



-~ People Tags .
| [[] & Colleagues
[] & Family
[[] & Friends

v Places Tags L
H United Kingdom
v % England

- # Newton Abbot
O B3387
* Events Tags C

Mow if vou look over at the Places Tags section in the Tags

panel bin, you will see that location data has been added
as a tag, which may consist of several sub categories. If you click
the top category, in this case United Kingdom, only the tagged
Images will now be seen in the browser window.

Options = Clear

W Tags ﬂ Information

¥ Keywords 4
New Keyword Tag... BN

Import Keyword Tags from File...
Save Keyword Tags to File...

Collapse All Keyword Tags
Expand All Keyword Tags

v Show Large Icon

o It is added to the Other category but you can click and
drag to any of the other categories; or click the green plus
symbal in the top right corner and click on the New Category
option in the drop down menu that appears. When vou do, the
Mew Category window opens,

[:] . Nature
[ @ color
[] M@ Photography

¥ People Tags
| | #&& Colleagues

[ | & Family

The newly named cateqory is added to the Keywords list.

You can drag and drop the its Image Tag into this new
folder. If yvou turn off the Places Tags visibility icon and then click
on the new category’'s visibility icon, your images will still be
clisplayed in the browser window.

TAGGING AND KEYWORDS
Sunrise
Sunrise I Add

If wvou highhght all of the images again, yvou can add more

tags to help you identify the photos at a later date. Under
the Image Tags panel, you can add custorm keywords; in this
case, the keyword 'Sunrise’ was used. Click Add to include the

new keswword,

.
[ ' Choose Color...

Category Name

Sunlight

o In the New Category window, you can choose a colour
for yvour category icon as well as choosing the name vou
want the new category to be called, in this case 'Sunight'. If you
wish, you can even select an icon from the choices listed in the
category lcon window. Then you can click OK to proceed,

— =

- (@ Sunlight

¥ People Tags I-.
[ ] #&& Colleagues
[] & Family
[] #& Friends

¥ Places Tags T

m United Kingdom

@ As you can see, we had tagged the photos with a specific
Places Tag and also with the new Sunlight category and

Sunrise image tags. These various sets of tags

mean that if we

aver need to find a sunrise photo taken on Haytor, we can just

search for those particular criteria and thay wil

| bbe displayed.

e .
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GETTING ORGANISED

Putting Names

to Faces

Now that you've tagged a few photos, let’'s move over to the People
workspace. Your library was scanned for all faces present in the photos
and then displayed here. Now you can tag these people and literally put
names to faces to aid you in your search for friends and family.

i Folders

4
I

(<) Al People ] Hide Small Stack
R

_| Hide Small Stacks |

A Mame (3] Add Name (4) Add Mame [4) Acd Mame [4)

Mdd Mame (2] Add Masme (2) Add Mame [2)

Add Mame (F]

o Click on the People tab to open the workspace for tagging
faces. Just like the main Media view, you can view the
contents of selected folders or click the All People button for a
view of every face that has been found in wour entire catalogue
of images; this includes those in the UnNamed category.

o The view you are presented with is a thumbnail portrait
of each individual face that has been identified. Below
the thumbnail are the words Add Mame followed by a number.
The number represents how many pictures of that person have
been found.

Add Nam

Add Name {41&

& Photos & Faces

Ursual Romanovich X Add Name (3)

This action will move ‘Ursual Rot

If wou hover your cursor over any given thumbnail, it

displays two options. One shows all the complete photos
of that person and the other just shows a small thumbnail of
their face without any background context to distract from the
process of identifying them.
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To name a known person, Ursula Romanovich in this case,

you can click on Add Name and type in their name. Next to
the name is a small tick and cross icon. Click the cross to cancel
inputing the name or click the tick to assign that name to the
parson. Doing this will move them to the Named category.




Ursula Romanovich |+ | X

I. Ursula Romanovich
1 %

—

me (1)

PUTTING NAMES TO FACES

™\

Is Ursula Romanovich

e —

Don't Show Again
Assign as Profile Picture

If some photos of that person have been missed and are

still available in the UnMNamed category, yvou can click those
thumbnails and click Add Name. If the facial match is close
enough, the name will be displayed and you can simply click it
and click the tick button to add those imageas to the list.

o Sometimes a photo of a person that is very similar to
another may be added by mistake. If that is the case, vou
can right-click the offending thumbnail and choose 'Not Ursula
Romanovich' to remove them from the list.

< | All Pacbe
Man (4] [ ] b RN ] [+ LY 5] Pl (4]

Groups -+
% Colleagues | IAGdGrotp

Rename
G Family

Delete
fan Friends

o On other occasions, if you name a person and then view
their photos in the Named category, yvou may be shown
a series of additional pictures and asked if they are also of that
persen. You can also multi-select those that are not the person
vou want and click the Not This Person in the taskbar.

o As an example of grouping, here are five members of a rock
band: it would be handy to group the members for easier
searching later on. To do this, go to the small the green plus
symbol in the All People panel to open the Add Group dialog box
for you to create a new group for the members of the band.

180 Add Group |

Rock Band

Name:

None v

"y

Group:

G Family
B Friends
fin Rock Band

Ungrouped

Under Mame, vou can type the name of the group: we just

called it 'Rock band'. The Group it appears in is None since
we want to create this as a brand new Group category to appear
in tha All People panel bin. When you're ready, you can click OK
to create the new group.

The new group called 'Rock Band' will appear in the All

People panel bin. Now vou can highlight all five mambers of
the band and drag their thumbnails into the 'Rock Band’ group. If
vou click on their group felder, only their facas will be displayed
since the tag is relevant only to them.
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GETTING ORGANISED

Tagging Photos

with Location Data

Tagging places is similar to the way you worked with People. There will
be Unpinned modes and Pinned modes for those photos that have had
their locations identified. We've already touched on adding Location tags
briefly, but now we can explore the Places workspace in more detail.

M Group By Time

- Mar 2018 / Add Loc

M Click on the Places tab to view the Places workspace. For
¥ the moment, you will need to be in the UnPinned category
and view all the photos that have yvet to have any location data
added to them. If you click Group By Time, then they will be
displayed in chronological order.

2-# If yvou are using this view, then you can alter the MNumber Of

¥ Groups value displayed in the left hand panel. Moving the
slider left and right, increases the numbers of groups on view for
more detailed scrutiny or reduces the number for a broader viaw
of all the photos you are viewing.

s T

B Albums

.‘ Folders

< Al Media ] Growp By Tirme

by Falders =

aenal
animals
EWEATS
examples
hdr
people
photos

places

FEENEE

rawy
Spoit

L E L

8 We have opted to tag a specific group of shots taken at a

¥ |ocation called Hound Tor. These shots are kept in a folder
called 'photos’, so we have used the folder view to find them
We haven't worried about viewing in chronelogical order in this
instance. There are four images to tag.
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reorie L

* Pinne

Hound Tor

Hound Tor Cvose, Churston railway staten, Faignmon, TOL 75, United Kingdom
Tarona, Ontaris, Canada
Tarredn, Coakuila, Mexico

Tarrance, Califernia, United States

Buxklas!

Buckfastleii

1 fama

"B Or the right of your Places workspace is the map where

¥ you can view any pinned photos. If you know where you
are looking on the map, you can zoom directly to that place,
otherwise you can search for a location by putting 2 name in the
search pane at the top of the map.




| Place 4 Media Here? " (§ |

@

In the media view panel on the left, press the Cmd key and

multi-select the images for location tagging. Thean enter
vour search destination in the Search panel above the map. Press
enter and a list of matches will be displayed. Click the correct
one and the selected media will be placed in that location.

TAGGING PHOTOS WITH LOCATION DATA

Satellite ~ §

0 Sometimes, yvou may find that the location of the images on
the map is not that precise but it does give you the option
to drag the pin to the correct place. If yvou are having trouble

identifying the correct area, yvou can alter the map from Streets
to Satellite for a better view of the land,

o Mow vou can see the land better, yvou simply drag the pin
the right spot and click the Place 4 Media Here? green
tick to confirm placement. You can double-click the pin to view
the images contained at that location. It will also appear in the
Finned category view now as well.

8

You can also navigate directly to a place yvou know on the
map and then highlight the pictures yvou wish to place

there. Once highlighted, the pictures can then be dragged and
dropped directly onto the map at the location you navigated to.
These will also appear in the Pinned category.

Edit location information for selected media

Fhatcher Ru-'__lﬁ_

w“‘ﬁﬁ
ﬁxﬁﬁt
wo®
T'i"-aw-

If wou import any pictures that contain GPS data, they
will be automatically replaced on the map in the Places

-Iu If the placement area is too broad, vou can adit the location

infarmation by clicking on the pinnad thumbnail and
Inputting more precise location options or dragging the pin to a
new location.

workspace when the data they contain is analysed. Qur

example of some aerial photos taken on the Devon coast were
accurately placed.
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GETTING ORGANISED

Adding Events
Tags to Photos

Having talked about who was in a photo and where was it taken, it seems
only right to mention how you can search for images when you want to
know when something was taken. Now you can tag and group them by
the type of event it was and when that event happened.

B Albums il Folders
My Folders = | < All Ewvants
aa Berial
e @ October 1, 2018 /# Add Event Places
& examples
: ::.F.;, :,1.;:-’ Named Suggested
R photos :
fr :::“ Number of Groups: Min O Max
a3 sport

o We have an example folder full of various types of events
such as weddings, parties and sporting events. When

viewead in the Events workspace, they are listed by date order to
help yvou find what you are looking for. They are listed with most
recent dates and times first,

FEEn

i
rr|1|

9 Click the Number Of Groups slider and push it to the far
right Max setting. The media browser will display more

time and date options for you to focus in on. We are looking for
a particular sporting event, Autacress, which was photographed
back in 2017.
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BnEi

9 Much like the People and Places workspaces, the Events
workspace has a Suggested category for untagged events
vet to be identified and a Narmed category wheare any that are
tagged as an event will finally be displayed.

Calendar

Clear

14 15 16 17 18 19 @ May 13, 2017 / Add Event
21 22 23 24 25 2™ 27 !
2B 29 o 31 | - :

Jul Aug Sep

oct Nov Dec

# Add Event

& May 13, 2017

The avent we are looking for happenad in April

May 2017

Now you can use the Calendar panel on the far right to
open the 2017 calendar and click on either April or May. Clicking
on May 201/, reveals the photos from that motorsport event.




@ May 13, 2017 # Asd bewri
& .

;; REE
b Il
g & May 13, 3017 F &4d Bl

L. =
- e

& May 13, 2017 F Aad Teem

& May 11, 2017 # add Bam
e
1 "

% May 13, 2007 A Eeern

The photos are spread out across the duration of the entire

clay but are all there ready to be tagged. You can use the
Number Of Groups slider again to break down the view into
fewer groups or more groups of photos split across that day's
worth of shooting.

b; =&« & & & & [ ]| Auto Curate

Add New Event
Name:
Start Date: | 11/19/2018
End Date: | 11/19/2018 | B
q Group;  None -

Add Event

ADDING EVENTS TAGS TO PHOTOS

@ May 13, 2017 / Add Event

/ Add Event

& May 13, 2017

" Mav 13. 2017 / Add Event

Mow that yvou have all the photos in once place, you can

fRighlight thermn by pressing CTmd + A to select all, or by
dragging a section around all the photos with your mouse, They
will be highlighted in blue with a small tick box in their bottom
right corner.

; | Autocross Event

s

Mone

End Date: [ 5/13/2017 | =)

Start Date;

Group:

Description:

Motosport event photographed on Behalf of the
Autocross Club.|

oy

Down in the taskbar in the bottom centre of your screen

Is the Add Event button. If vou click this it will call up the
Add Event dialog box where vou can begin to add details about
the event itself such as Event Name, Start and End Date and a
Description if requirad.

o Start by giving it & name. We used 'Autocross Event’ and
kept the Start and End dates the same since it all occurred
on May 13th 20177 Since no othar Group nameas have baan
created, Group is kept as None. A short description is also added
Mow you can click OK to proceed.

f13f2ol1v

hutocross Bvent

: Description

Motosport ew
photographe
of the Autocr

You will see that all our photos now have a small calendar

icon in their top right corner to indicate thay have an
event tag called "Autocross Event’ added to them. If you ook
in the Named category now, you will see that event listed. Click
on the small information icon to see the description you typed.

LT o PN
[0 & oile
L] & phil
* Places Tags
* [] @ United Kingdom
» [1 ® Englana
# [] @ Newton Abbot
» ] % raignmon
[[] @ Eastern Esplanade
W ¢ Tavstock
=[] 9 Torbay
[] @ Daddyhole Road

Soam By | K =

< AN Msdia

* Events Tags

If wou return to the main Media view, vou will see that

the Events Tags panel now contains the Autocross Event
tag. If vou are viewing all media and click the Autocross BEvent
tag to make it visible, only the shots tagaed will appear in the
browser window.
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GETTING ORGANISED

Reviewing and
Comparing Images

Within Photoshop Elements, you are provided with a couple of options
that allow you to quickly and easily review photos in the Organiser. You
have the choice of either the Full Screen, or, Side By Side views and can
examine images at multiple levels of magnification.

- Elements Organizer File Edit Find | View Help

5 & ® Refresh
bedia Types
Import - Hidden Files
| Sort By
B Albums il Folders Sort By: | e
Dartails
E = =
Wy Foldars 2 « People Recognition
i aerial
a2 animals :h'-m
lad  EVENIS limeline
al  Examples
[a2 e
ai people
(2 places Set Date Range...
o AW
[a2 spom
;,'.. spread phatos

o In Full Screen view, you can inspect your images in detai e If yvou move your Mouse cursor over the full screen image
pefore making a selection of photos and presenting them the Control bar will reappear. If yvou look to the left of the
as an instant slide show. Click and select a thumbnail image in screen, yvou will see a couple of gray tabs. If yvou move your

the Media Browser panel and then choose View > Full Screen, cursor over these tabs, you can open the Guick Edit and Quick
Tha Media Browser will be replaced by the Full Screen view. Organiser paneals, again,

e Mow, If you move the cursor back to the centre of the Qe thing to bear in mind is that, if yvou don't see yvour Film
screen and leave it motionless for a short while, this will be Strip, you can press Cma + F on your keyboard to make it
noticed. After a brief spell of inactivity, the Control bar, the Quick visible. Clicking on the Film Strip icon in the Full Screen view's
Edit panel and the Quick Organiser panels will all disappear again Control bar will have the same effect as the keystroke option.

until yvou move the cursor to activate them.
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H O

Organize Info

Theme Film Strip Wiew

B

Settings Fix

The Film Strip positioned below the main image, is there to
- <how you all the photos in yvour Media Browser. If you select
multiple images and then enter Full Screen view, the Film Strip
will only display the photographs you have selected rather than
all vour images.

B .

Theme View

Film 5trip

B If you press the spacebar, you can view your photos in a
e Full Screen view slide show. You can also access the Contro
bar and press the Play button to commence the slide show
presentation. 1o stop the slide show, you can simply press the
spacebar or click the Pause button on the Contral bar.

]

+

fa Theme

Film Strip  View

Mext Madia

P8 On the Control bar, you can use the Previous Media and

Mext Media buttons, either side of the main Play button, to
shuffle backwards and forwards through the images displayved on
yvour filmstrip. Alternatively, you can press the left and right arrow
keys on yvour keyvhboard.

Select Transition

Classic—— —Fade In/Out— —Fan and Zoom—5 — 30 Pixelate —

-__#.."I
et

-
|

"B On the Control bar, yvou will see the button marked Theme.

¥ This gives you several Transition Options to determine how
one image faces into another, throughout the slide show. Unaer
Settings, there are a number of Presentation Options including
Background Music and Include Captions.

a N

Full Screen View Oprions

— Presentation Options

Background Music: | Sunny_Afternoons.mp3 -

Browse,..
¥ Flay Audlo Captions

Page Duration: | 2 sec -

M include Captions B show Fillmstrip

B! allow Photos to Resize ] Repeat Slide Show

¥ Mlow Videos 1o Resize

(o | [ ox

F-. I You can also set Page Duration to control how long an

= B

image is visible before it transitions to the next, in the
presentation. You can also choose to Allow Photos to Resize and
Allow Videos to Resize, For continuous playback, you can select
Fepeat Slide Show,

§ Be aware that if vou are using 30 Pixelate along with Pan
- sncd Zoom as your transitions, pressing the spacebar to
stop the slide show will not work. Instead, vou can simply press
the ESC key on your kevboard to exit out of the presentation.
Fressing ESC again will axit back to Organiser,

'..wEN.gng#E|i5ﬂigr‘§.ﬁl‘1
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GETTING ORGANISED

Comparing Photos
Side-by-side

Being able to compare your photos and media side-by-side is very useful.
One image can be kept in a fixed position and scale, on one side of your
screen, while on the other side, you can cycle through other images and
then compare them for similarity of composition or content.

- Elements Organlzer File Edii Find | View Heilp

R K Refrash
Media Types
Import - Hidden Files
. ' ; Sort By
B albums il Folders Sort By | poey
b Dartails
E =
P o L= ¥ People Recognition
- aerial
A8 animals
- Full Screen
sl EVRAOLS Timeling
[a2 examples
PO T
las peopie
=2 places Set Date Range...
&l AW
- PO
_..;, spread photos

0 Go to Full Screen view by selecting View = Full Screen g lhe view options available to you are quite straightforwarg.
{Cmd + F11); yvou will need to access your Film Strip. If it When you click the View icon, a small menu will pop up
isn't visible, vou can click Cmd + F on yvour keyboard to make it with the option to either view the images in the Side by Side
visible at the bottom of your screen. Bring up the Control bar arientation, or to view them horizontally, with one above the

and click on the View icon. other across the width of the screen.

Keyword Tags
Color, Nature, Other,
Photography
motorsport] T
T e
I this example, choose the Side by Side view option. Ary operation vou perform on the image, whether it is an
Select yvour primary image from the Film Strip and it will be edit or adding keywords, for example, will only be applied
displayed on the left as image 1. The next image in the series will to the image that is currently active. In this case, image 2 will be
be marked as image 2. Image 1 will be active by default with a the one that is affected by any changes you make to it

blue box arcund it. You need to click image 2 to make it active.
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& [ 00,

Theme Film S5trip View

If vou click image 1 to make it active again and then select

a new image from your Film Strip, the newly chosen image
will become the new image 1. If you wish, you can press the Tab
key on your keyboard to alternate between having image 1, or

Image 2 as the active imaage, at any time.

—k._l

88

[he active image can be viewed at different magnifications

by rotating the scroll wheel on yvour mouse, if you have one.
Otherwise, you can use the Cma key and either the minus (=) or
plus (+) keys o alter the magnification at which you view the
photo. The image can also be dragged arcund if required

B

Therme

Film Strip

If wou click on the View icon again, the View Options menuy

will pop up. You will see that there is a full screen option,
or you can choose the Above and Below view opltion Instead.
[his places the images one above the other, horizontally, across
the screen.

COMPARING PHOTOS SIDE-BY-SIDE

B [0 0D,

e am Film Strip
Next Media

Wiew

MNow make image 2 active, then, if vou press your right

arrow key, or the Next Media button, you can flip though
Images in your Film Strip and view them as image 2, on the right
of the screen. Image 1 will remain fixed until you opt te change it
If reguired.

rrju-l_
sananl

m Strip

g0,

View

b 0 O .

b I wvou are viewing two very similar photos and want to

¥ be able to compare them very closely, yvou can choose to
synchronise the panning and zooming of the photos so they
poth scale and move at the same time, then If one I1s moveq, the
ather will move in unison. Click the Sync icon to do this,

A @ 6

Fnle:____ Organize Info

|ip[a'y'.|’HIdE Quick Edirt . =

= =

"

——

Kl

Each image, that is currently selected, can have some

simple edits applied to it. With an image active, click an the
Fix icon in the Control bar and the Quick Edit panel will open.
You can apply a star rating, rotate the image and delete it, or
mark it for printing. Press Exit to gquit Full Screen.
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GETTING ORGANISED

Watched
Folders

Photoshop Elements uses watched folders to aid the process of keeping
your image catalogue up to date as you add or remove content over
time. You can define any number of folders as watched folders. Any time
you add or delete images to these folders, you will be alerted.

" Elements Organizer File Edit Find View Help
- Folders 1o Watch

{Users/markfrost/Dropbox Add.

fUse rs.n'marh:*rmtrl’inwu

fUsers /markfrost /Public /ADM The Complete Photy

Get Photos and Videos
hlaw
Open F!E‘-:Z:Et"lt-:.' Edited File in Editor

Manage Catalogs...
Backup Catalog...
Restore Catalog...

My Folders

a3 aerial

a2 animals Export As New File(s)...

[ad events 2| O 1 E
[ad examples S L

._ﬂ hale Save HE‘IEdd i3 1o Flles II“.E"‘ He“, Flle’s are fl;l-l..lm.‘! in wﬂtl:hed Fﬂhﬂﬂﬂ-

- Reconnect 2

il people " Watch Folders... - (2 Notify Me

T‘“ places et y tomatically Add Files to Elements Organizer

o Within Elements Organiser, you can find the Watch Folders
option under File > Watch Folders. This calls up a panel

o You can choose to have any new files that are detected,
within 2 watched folder, added automatically to your

where you can set various parameters to: govern which folders catalogue, with no input from you. You can also choose to
are watched, add new folders, remove existing ones if required nave Photoshop Elements ask how you wish to proceed, when
and even turn the function off, importing the new content.

New files have been found in your
Watched Folders.

E] Elements Catalog

o If wvou choose to be alerted before proceading, wheanever If vou use any online services and cloud-based storage
any new items are added to yvour watched folders, providers, such as Google Drive, One Drive, Dropbox
Photoshop Elements will display a message to indicate that it and iCloud, for secure storage backups and syncing to mobile
has detected new items. You can click Import to continue the devices, Elements Organiser can automatically detect their
process or Cancel to abort. relevant folders and include them as watched folders.
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ub-Folders for Mew Flles

EDM/The Complete Phot @
]

K

Remove

examples e

spread photos

| i Watched Folders

To add a new watched folder, activate the Watch Folders
dialog panel and click on the Add button. A browser
window will open, enabling you to navigate to a folder you wish
to watch, or create a new folder into which you can put content,

after setting it up as a watchead folder.

MRK

_MRK2166.jog _MRK2189.jpg

s . -

o As an example, we have used the Watch Folder function

to create a new empty folder called 'tutonals’ and closed
the program down, We then downloadead some images from a
recent photoshoot, processed them and then saved the favourite
images to the 'tutorials' folder,
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If waou go ahead and import the imageas, once they are

added to your catalogue, they will each have a thumbnail
created for them and they will be added to vour Media browser
window view. If you choose to Sort By Newest, they should
appear at the top of the Media view.

WATCHED FOLDERS

# Watch Folders and their Sub-Folders for New Files

Folders to Watch
lements Manual Vol 19/Elements Catalog Add ...

m

Remaove

If vou wish to remowve a folder from the Folders to \Watch

listing, simply highlight the required folder ana click the
Remove button to the right of the list. Remaoving a folder does
not delete its content; that remains untouched. You have only
told the program to ignore that folder,

),

New files have been found in your
Watched Folders.

1 subfolder

[] M Pictures
[:| v Dropbox
':I Elements Catalog

tutorials

o Mow, if you go back and cpen up Elements Organiser, a
screen will appear indicating that new files have been found
in the folders it has been instructed to watch. Depending on how
many folders you have set up, you can choose to import from
selected folders only, or cancel the entire import.

Import -~

<  All Media

. Folders

Sort By:

N

!} Albums

My Folders L
[az aerial
laa animals
laz events

%

|asl hdr

If wvou don't have a particular folder watched and yvou

physically delete, or mowve, an image out of its folder, the
next time you open up Elements Organiser, the image may still
appear in your Media view, but it will have a small guestion mark
in the top left corner to indicate that it is missing.
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GETTING ORGANISED

Import from a
Digital Camera

Usually, when importing images and media content into Elements

Organiser, you will be doing so from the pre-existing folders and drives

on your home computer. However, there may be times when you wish to
" import directly from a digital camera, or other mobile device.

AR . | i |
;_‘;':'.’“F*.-.; In this example, we are going to connect a digital camera to ‘é”*"‘;‘h Digital cameras can be connected to your computer via a
WY the computer and import images straight from the camera ¥ |USB cable. Most cameras offer an A/V Digital port to let
into Organiser. If you have a card reacder, or are using another vou move files off the camera in the event of not having a card
mobile device such as your phone or tablet, the process will be regder. Connect the USEB lead to your camera and the other end
the same. to your computer's USE port.
Import -~
= _ r
From Files and Folders... By: |Newest

From Camera or Card Reader...

-,

In Bulk...
Import photas and videgs
Photos "

j | From iPhoto...

las hdr
r‘ﬁi} If wou are working on a Windows PC, yvou may find that ';"‘*;J Start up Elements Organiser. If vou look in the top left
- the Auto Play dialog box appears when you connect yvour ¥ corner of the workspace, you will see the Import button
camera. Under the Pictures Cptions, there may be the choice of click on it and a dropdown menu will appear. You can choose
gither importing via Windows, or using Elements Organiser. For from several options, but the one that concerns us is the From
the purposes of this example, yvou can simply close the box. —amera or Card Reader aption.
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-] Elemants Organizer - Photo Downloader
Source

A Get Photos from:

» Canon EQOS BD Mark 111
< Rafriesh List »

Import Settings
Location: fUszersfmarkfrost/Pictures Choose...
Create Subfolder(s):  Custom Name _ E
Enter custom name here
Rename Files: Shot Date (yyyy mm dd) + Custom Name A

Enter custom name here + 18 |
Exarmnla: MR 19 04 OMIA CEF ]

o Click the From Camera or Carc REeader cption and the
Photo Downloader winaow will appear. Depending on whatl
is connected to YOUr computer, one, or more, source oplions

will appear under the Get Photos From dropdown menu. In our
example, the saource 1s a Canon 5D Mark Il digital camera.

| Canon EQS 50 Mark Il E
41 Files Selected - 1.00G2

Import Settings
Location: loElements Catalog/downloads Choose...
Create Subfolder(s): |+ None B
Custom Name '
| Today's Date (yyyy mm dd) '
Shaot Date (yyyy mm dd)
Renama Files: Shot Date [yy mm dd) ;

Shot Date (mm dd yy)
Ehot Date (mm dd]

Ehot Date (yyyy mmm dd)
Shot Date (mmm dd yyyy)

o Below the Location path is the Create Subfolder(s) option.
This lets yvou create subfolders within the specified location
path with either a custom name or a choice of Today's Date or
the Shot Date in various date formats, such as: Shot Date (yyyy
mm dd).

IMPORT FROM A DIGITAL CAMERA

Favariles Shared Faolder
& Rec New Folder
%3 Droy
13 E.'-tq .Name of new folder:
| Mag downloads animals Cataloy
£ Puly N
m mar Cancel
e —
a ﬁ.mlfﬂthﬁ' examples hdr peapl
& Desktop
ﬁ Documents
7 iCioud Drive

You can choose to keep the Import Settings at their

defaults or yvou can opt to change the location of the
downloaded files by clicking on Choose and navigating to a
preferred destination folder, or creating a new folder, into which
vour images will be stored,

SNOT DETE Yy T o0]

Shot Date [yy mm dd)

Shiot Date [mm dd yy)

Shot Date (mm dd)

Shot Date [yyyy mmm dd}

Shot Dete (mmm dd yyyy) L

Custom Name B

Shot Date [yyyy mm dd) + Custom Name

Shot Date [yy mm dd) + Custom Name

Shot Date [mm dd yy) + Custom Mame

Shot Diate (mm dd) + Custom Mame

Shot Date (yyyy mmm dd} + Custom Mame

Shat Daete (mmm dd yyyy) + Custom MName

Custom Mame + Shot Date (yyyy mim dd)

Cugtom Mame + Shot Date [yy mm dd)

Custom Mame + Shot Date (mm dd yy) |
Custom Mame + Shot Date (mm dd)

Custom Mame + Shot Date (yyyy mmm dd) edia

Custom Mame + Shot Date (mmm dd yyyy)

Same as Subfolder Name |

Delete Options:

Advanced Dialog

o Below the Create Subfolderis) option, is the Rename Files
option. You have a large choice of renaming options, such
as: Shot Date (yvyyy mm ad) + Custom Name. This lets you
rename each downloaded file with its shot date and a custom
name, plus an ascending four-digit number.

Custom Mame E

Enter cusiom name here + 1

Example: MRK_0049_0001.CR2
Preserve Current Filename in XMP

Rename Files:

' After Copying, Do Not Delete Originals
Aftar Copying, Verify and Dalete Originals
After Copying, Delete Originals

Delete Options:

From: Canon EOS 5D Mark 11l
To: /.../[Elements Catalog/downloads

—

File 3 of 41: Copying File...

[ )
MRK_0054.... Y

Finally, vou have the Delete Options to choose from. Theare

are three main choicas: After Copying Do Not Delete
Originals, After Copying Verify and Delete Originals, (which
checks the files before they are deleted) and finally, After
Copving Delete Originals.

@ Click on the Get Madia button. If a Failed to Connect dialog
box appears, you may nead to check if your camera has
gone into standboy mode. Turn your camera back on, click the
Retry button and click Get Media again, The images will then be
cdownloaded onto yvour computer,
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GETTING ORGANISED

The Advanced
Photo Downloader

Downloading images from your digital camera, using the Photo
Downloader, can be as simple as you require. If, however, you do need
some more advanced options for naming, tagging and organising, then
you can delve deeper into the advanced settings provided.

Custam Mama +1

“En'rﬁus'r-:':r?nam harel | S
Exampla: MRE_O0048_0005.CR2
Preserve Current Filename in XMP

.I'l.l"l.-er Copying, Do kot Delﬂe ﬂrlglnals

|23

Delete Dptians:

Cancal Gat Media

Agvanced Diakog .

o Open Elements Organiser, click on the Import button at
the top left of the screen and choose the From Cameras or
The Photo Downloader panel
will open and your camera will be identified as an image source.
nd click on Advanced Dialog.

Card Reader option, once again.

| eave the settings at their defaulf a

Save Options |ﬂ
Location:
LSdownioads/]3 sublolders)

Create Subfolder(s):
Custom Groups (Advanced) H

Choose..,

0151204 :
&_ ,————————— 3

HlEss groups ‘
Shat Dabe [yyyy mm dd) H

Rename Files:
Custom Mame H

|21 127042016 0825 _ FlEr Sushorn ndme ber * 5
®  MRE_DOM0.CRZ Examgle: MRK_D00DB_DODS,CR2
"~ Presarve Current Flenams in XMP

e Choose Custom Groups (Advanced) in the Save QOptions
section, under Create Subfolder(s). This divides up the
images into groups based on their shot date and capture time.
There is a slider below the Create Subfolder(s) menu that lets
vou control how the groups are subdivided,
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o The Advanced Dialog panel displays a thumbnail preview
of each of the files on your camera along with its shot date
and filename. There are a number of options for setting locations
and subfolders, as with the standard dialog box, plus a number
of advanced options.

K -
Gr¢Less groups |
Shot Date (yyyy mm dd) E
i
r'f R
o - & 15
Group Name: More groups |

I

Shot Date (yyyy mm dd)

Using our example, if vou set the slider to a lower groups

setting of 3, the shots are divided up into three groups,
which is handy since there are three different sets of images,
taken some time apart. Change that setting to 15 and, naturally,
the number of subdivisions increases to 15,
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You can experiment with the numbers of groups vou generate

by rmoving the slider back and forth, then reviewing the effect
by scrolling down throuah your list of thumbnail images. Keep an
eyve on the small box to the nght of the shider, as it will update you
as to how many groups are being created.

151204 + Beach] |
= e —
— Click here to create a group name
i W v
Group Name:

Shot Date (yy

Rename Files:
Same as Subfo

15 12 04 Custom

Example: 1512 (
Preserve Curr

12/04/2015 08:25
MRK_0010.CR2

THE ADVANCED PHOTO DOWNLOADER

f..HmlmdsﬂB wacrldefﬂ' ' Choose...
Create Subfolder(s):

Custom Groups(Advanced) ﬁ

04 + Custom NMama

y 3

Group Name:
Shot Date {yy mm dd] + Custom Name k. H

Rename Files: :
Do not rename files ’H,

j04/2015 08:26 +
RE_O010.CR2 Example: MRK_D006.CR2
Preserve Current Filename in XMP

== Advanced Options

0 When you have settled on how many groups of photos vou
wdant to create, you can specify a set of custom names for
the subfolders that will hold each group of photos. Under Group
MName you can choose an cption such as: Shot Date (yy mm dd)
+ Custom Name.

Exampie: 15 12 U4 Beacn_UUUT.CHZ
Preserve Current Filename in XMP

— Advanced Options

¢ Automatically Fix Red Eyes
‘Automatically Suggest Photo Stacks
Automatically Stack Raw and JPEG

Import into Album Settings...

After Copying, Do Not Delete Originals B

o In the thurmbnail view, click on each Custom Name field and
give it @ unigue name to identify that folder. In our example,
folder one is called ‘Beach’, folder two is called 'Party’ and folder
three is named 'River’. For clarity, we have also chosen the
Rename Files option of Same as Subfolder Name.

0 In the Advanced Options section, you can check, or
uncheck, the four options available. If vou have a lot of
portrait photos taken at a party, you can check the Automatically
Fix Red Eves function and each photo will be checked for Red
Eyes and, if necessary, fixed.

Import into Album Settings...

After Copying, Do Not Delete Originals E

= Apply Metadata
Template to Use: _
Basic Metadata ﬁ

Creator:
MF

Import -~

Sort By:

Newest

g Albums . Folders

My Folders >

“I
o

t

15 12 04 Beach k
17 07 13 Party
19 01 13 River
aerial

]
-

BB

.

You can make yvour Advanced Options choices and then, at

the bhottom, you can choose: After Copying Do Not Delete
Originals, After Copying Verify and Delete Originals, or, After
Copying Delete Qriginals. We would recommend that you don't
delete yvour ariginals, just to be safe.

You can also apply Basic Metadata to vour image, as well

as Creator and Copyright information. When you are happy,
wou can click the Get Media button and import vour images.
Back in your Media workspace, you should see three new folders
with a date and a custom name to identify them.
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GETTING ORGANISED

Search by Metadata,
Similarity & Objects

When you take a photo, metadata is added to your image to identify: the
camera settings used, the lens used and various other parameters, then
Elements Organiser adds some more. You can use this metadata to find
the images you want and use image analysis to search by visual similarity.

- Elements Organdzer Flle Edit @ Fnd View Help
NE By Details [Metadata)...
By Media Type

By Histary

Import -
By Caption or Mots

B Albums il Folders By Filename...
All Missing Files
F — x
My Foldars x) All Viergion Satg
[a2 15 12 04 Beach Al Stacks
[a2 15 12 D4 Custom Name - =
By Visual Ssarchas
Nl A0 L3 e By Saved Searches
[ad 1901 13 River items with Unknown Date or Time 4+ 3EX
ad/ 2erial A | MO
s : Intagged Items g {m
5 animal i
laz| &ni i Tems nat in any Album
|=2 ewents
[a examples
[a2 hdr
[a3 people
[ i

o Open Elements COrganiser and keep it in the Media view. In
the file menu, go to Find = By Details {Metadata). Click this
menu option to opan the search criteria panel, wheara you can
enter search parameters to locate matching shots,

an Find by Detals (Meradata)

Sgarch for all files that match the criteria entered below and save them as Sawed Search, Saved Searches are
albums that aunarmatically collect files that match the criteria defimed below. Use the Add bumon oo enter
additional criteria, and the Minus bufton o nemowe criferia.

—Search Criteria

Search far files which match: @ Any one of the fallowing search criveria]QR]

E Al of the following search criteriaAND]

Camsira Maki 'r| | Enatains ": nikan I

The manufacturer of the camera used 1o lake this pholo

-|:|£|nll thizs Search Crigeria as Saved Search

Mg

To the right of the search strings, is a small plus (+) symbaol
n a box. If you click it, you can add moare search strings
to the Search Criteria for even more targeted searching. In
our example, we chose Camera Make as the first search itemn,
Contains as the second criteria and Nikon as the third.
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—Search Criteria
Search for files which match: @ Any one of the following search

(O All of the following search crite

Is 'r|

Photo Project Name
Albums

Keyword Tags
lRating
Camera Make
Camera Model m
Capture Date

i Media's filename and/or file e;

|Saved Search

@ You have three search strings. The first has options such

as: Filename, Camera Model, Capture Date and much more
1@ second and third search strings finesse the search parameter
Jsing words that your files may, or may not, contain and whether
it starts or ends with a specific word.,

fiod by Dechds My,

Search for ail files than march the criceria eppered below and save them as Saved Seanch. Saved Searches are
albums that automatically collect files that match the criteria defined below. Use the Add button to enter

aoditional criveria, and the Minus Bullon 10 remowve criteria.

—S&arch Criteria
Search for files which match: & any one of the fallowing search criteria[DR]
(1 adi of the following search criterialanD]

| and |24

mm IEI
X

[Fuca! Lergtn = | |15 bepween - | |16

The numaric value of the focal length of the camera lens In mm

-|_| Save this Search Crigeria as Saved Search

Warme:

When you click on the Search button in the bottom right

of the panel, it will display all the images shot on a Nikon
camera, contained within your catalog. We also tried searching
oy focal length of lens used (demm - 24mm), to find all our wide-
anale photographs. Preferrea searches can alsc be saved.




Find View Help

By Details (Metadata)...
By Media Type
By History

By Caption or Note...
By Filename...

All Missing Files

All Version Sets

All Stacks

By Visual Searches

By Saved Searches
Items with Unknown Date ar Time

~ Visually similar photos and videos
Objects appearing in photos
{raX Duplicate photos

Untagged Items
ltems not in any Album

Another method of searching 1s by visual similarity. You can
search within preferred folders, or the All Media Ur:_mhu
window. Go to file menu and choose Find > By Visual Searches
= Visually Similar Photos and Videos, A small Find: panel, with a
plus (+) symbol, appears at the top of the meadia view window.

SEARCH BY METADATA, SIMILARITY & OBJECTS

<  All Media

. Folders

Sort By: |Name -

04 Beach
04 Custom Name
13 Party
13 River

Color O~ Shape X 9

From the media browser window, click on an image vou

would like to use as the basis for finding visually similar
photos. Drag that image up to the Find: window and Elements
Organiser will use visual analysis algorithms to search and display
sirnilar iImages.

o If vou look at the top nght of the media browser window,
voul will see a slider that can be moved from Color to
Shape. You can use this slider to refine the visual search and
display better Color matches, or move It the other way and It will
display images ’r_I“a’r better match the Shape of your original,

Find View Help
By Detalls (Metadata)...
By Media Type
By History
By Caption or Mote...
By Filename...
All Missing Files
All Version Sets
All Stacks

By Visual Searches IS
By Saved Searches ' Objects appearing in photos “

Items with Unknown Date or Time {38X Duplicate photos

2%Q w

Visually similar photos and videos

Untagged ltems

Items not in amy Album

e

Another method you can use s to search for a specific

object. Back in yvour media browser window, go to File =
By Visual Searches > Objects Appearing in Photos, Now when
you drag an image onto the Find: panel, you will be prompted to
select a specific area from your image.

0 You can experiment with the position of the slider to see
how they match. Notice that each image displayed is
listed in descending order of visual similarity to your orniginal
photo. For further refinement, yvou can add ancther photo to
the Find: panel.

We chose a portrait and highlighted just the face. When yvou
' click an the Search Object button, any image that contains
a similar shape or colour, will be displayed. You can use the Color/
Shape slider again to change the bias towards your preferred
match. As before, images are listed in descaending order,
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GETTING ORGANISED

UsiNng

Instant Fix

Not all photos are perfect when taken on a digital camera. Some of them
may be underexposed and too dark, others may be overexposed and too
bright. Part of the process of getting your photo library organised and
looking its best, is to also make image adjustments to your photos.

"B ou can add image adjustment as part of your cataloguing

@ and keywording routine, to not only get your image
organised, but also looking its best. Elements Organiser has an
Instant Fix option that lets vou make some basic, but essential,
fixes to your images,

. g

[ e ﬁ 5 B

o L Before @ ) After
Undo Redo Flip Resat

£ tems selected

iﬂ The Instant Fix window 15 a fairly easy workspace to

- Lnderstand. You have buttons to Undo or Redo actions,

a Before and After toggle switch to compare the edits you've
made so far and a Resat button to revert your photo back to its
original state, iIf you need to start again.
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V' |Quickly fix common problems with your photos
Instant Fix Editor - Slideshow -

Home Screen

R
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B In the main Media Browser window, select one or maore

» 1mages that are in need of some adjustments. In most
cases, they will be images that are too dark or too bright. With
them highlighted, go to the taskbar at the bottom of the screen
and click on the Instant Fix icon.

Instant Fix

View: ac
L3

Show All Photos|

It vou have selected more than one photo to work on in the
e nstant Fix window, at the top middie of the screen are two
View options. One is to Show One Photo and the other is to Show
All Photos so yvou can choose which image to work on. If required,

the Editor button will open the image in the Fhoto Editor.




USING INSTANT FIX

Ehects _ Effects

= 0

f‘: Running down the right side of the Instant Fix window, are -,'E“"}";f"- Other panels, such as Crop, display a number of options
" tools to adjust your photos. From top to bottom, they are: ¥ ou can click to apply that particular adjustment. The
Crop, Red Eve, Effects, Smart Fix, Light, Color and Clarity. Each Effects panel has a list of colour effects yvou can apply to your
one has a fly-out panel; some with a simple vertical shider that image and Red Eye will simply scan your photo for any eyes
lets vou increase or decrease a particular effect. affected by a direct flash from a camera.

P

A » B Srart Fix is another option that has no direct input from ol o get a little more hands-on, the Light, Color and Clarity
- vwou, When vou select it as an option, it will analyse your - adjustments are probably the best route for a superior
photo and make a series of changes based on what it thinks is looking photo. Clicking on Light gives yvou a vertical slider to
pest for that particular image. It 15 gquick, but it may not give youl increase or decrease the brightness of the image. To apply

the effect you are after simply mowve the slider to the preferred brightness,

I o e o e
;| @ o
ke S e P e =
. y & -
9 o
9 Q-
i
, i %

[ — = -

e
E

£T, B Once you are happy with the photo, to apply the changes
- [he image more saturated, with colours that are mora vivid, - Click the Save button at the bottom right of the screen.
Moving it downwards will de-saturate the image until it becomes Then, if vou click Done, yvou will leave the Instant Fix window

B Mext comes the Color slider. Moving this upwards makes :

=

black and white, The last adjustment is Clarity, which will increase Your image will have a small icon in the top right corner called
or decrease the contrast in all the migddle tone areas of the photo Version Set, indicating an criginal and an edited version exist.
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We hope that by now you feel like you've had a good
introduction to what Adobe Photoshop Elements is all about.
There's a lot more to come on the following pages but before
we dive in further, we thought it would be great to show you a
series of quick tutorials exploring the vast range of techniques
and tools available. There's everything, from making a
panorama from multiple images, to putting pictures inside
text. Take a look and enjoy the Elements experience.
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sur photo by going to File > Open

ige .ihg.tﬂ where your primary

ot and either double-click the image
d press the Open button.

L L T T T ]

Computer or tha Elemens Organi

C hemesi Péinin
| ad
O DR Oegaand 2
Trp marihe s
< BB
L -4
=3 L
N S
- :J_L_Eit in case, there is a small selection
. ¢ that you can try straight away, with two
- female and two male sets of sample eyes, on
your photo.
Computer Organi:
" Click to Apply:

Py

iy
"h

% When you have found a likely candidate,
S double-click it to load it as an eye source
and then click on its thumbnail to apply it to
your main photo. Click OK when done.

le Edit Image  Enhance Layer Select
At Smart Fix
Auto Smart Tone. .
At Lenals
Aumo Conirast
futo Haze Removal

fuma Colar Corraction

Fittar  Veew
CEE M
T
TrEL

TOMNL
EA
i 4]

Window Help

o Shake Reduction
Ao Sharpen
Aumo Red Eye Flx

Adpust Color

Adjuest Lighting

Adfust Srnart Fhe ..

Corveri to Black and White...
Haze Rermoval., .

Adjust Sharpness, .
Aljust Facial Features
Shake Reduction...
Lnsharp Mask...

?: Go to Enhance > Open Closed Eyes and
S you will see the Open Closed Eyes dialog
bhox. Here you can choose your Eye Source to

cpen your subjects eyes with.

Eye Source

Open an Eye Source photo from your
Computer or the Elements Onganizer

Choose fram

Computer Organizer

ul-1286709
Lipg Try sample eyes:
' |
L | (a 'E‘ I

Ll A
ind sonia y— a2, o
.EI..III'H u

,{} For best results, find a photo that roughly
W matches the lighting and colours of your
original photo. You can select Choose from =
Computer and locate a suitable image.

Epw Sovarca

Cigen oz B Saeren pharia F
Correitat of U Eberwsti C

T fondy

£ The new eyes you found will be mapped
S over your existing image and blended as
seamlessly as possible. If you like the result, you
can save it under a new name.
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The Elements Experience 2

Partial Sketch

Guided edits are a simple, quick and

fun way to add edits to your photos.
Have you ever fancied yourself as a
great sketch artist? Well, with the Partial
Sketch guided edit, you can instantly
turn any of your favourite photos into an
artistic rendering with just a few clicks.
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PARTIAL SKETCH

PARTIAL SKETCH

Turn part of a favorite phato into an artistic
skisbch,

LS| W
S Subtract

Brush Size: %

Open the Elements Photo Editor, go to e You have four pencil sketch effects to
File > Open and choose a favourite photo; choose from. Click one to activate the
then go to the Guided workspace. The Partial sketch brush. Select Add and use the slider to

Sketch effect is under Fun Edits. control its size.

2. (Optional) Click the Detail Brush button
to precisely paint the effect on or off.

¥ Detail Brush

‘ & Subtract

®
S )

o Paint across your image to reveal areas If you want to, you can use the Detail
you want to be converted to a sketch Brush to more precisely paint the sketch
effect. You can always use the Subtract brush, effect on or off your photo, controlling the

to remove any sketch areas you don't want. brush size and opacity:.

g T

e -

R

- ok
e iy
o

-
=

Brighine=ss)Conmrast

W Leam mone about: BhghtressiTontrast £, |
cmllri
Brightrass: i L
[ Presizw

Cortiaat: @

With the image still active, you can
actually go to the Expert workspace and

e An optional effect is to soften any hard

edges or flip the effect. If yvou're happy,

you can select Next and Save your image. continue to work on your photo adding more
contrast to the sketch layer.
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REPLACE BACKGROUND /7

i
""-\.i-"r

F,
T

REPLACE BACKGROUND
Change the background of your photo.

1 In the Guided workspace, you will find
the Replace Background edit under the
Special Edits category. Put the photo you want
to work on in the Photo Bin.

L = tl\l-ili LR B =T T s =t =y B =] R ] Et‘

1. Use one of the Selection Tools to choose
the primary subject of your photo.

4 3

/

Auto Quick
5 4 | £

Brush Refine

=

3 Use the tool options to subtract areas
that stray outside what is required. Then
yvou can use the Refine tool to improve the
cuality of the selection.

5. (Optional) Use Auto Match Color Tone to

[ Now you can make further refinements
to the outline of your subject if you want.
A soft brush can be used to feather the join
between the foreground and background too.

Mran oreace Hua masin ooldoact fa moabko

2 Choose from the available tools to select
wvour subject. The Quick Selection tool
should worlk well on our subject. Drag inside
the edge of subject to select them.

2. Choose a new background

SlE (SRl DS AT TR e

TN R riginnw

None Color

a4 MNow you can import a photo that will be
the new background. It will be placed
behind your main subject. Both subject and
background can be moved if required.

6 Click Auto Match Colour Tone to make
the colours of your subject match the
background more closely. NMow you can save
the image as a PSD or jpeqg.
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PHEla B Tod Oolan:  Unde Heda Wil Coganidi SRt B

| n the Guided workspace, you will

' 'r 1d Photomerge Panorama under the
Photormerge category. Place the sequence of
pal Joramic photos you want in the Photo Bin.

CA i il

Settings

Blend Images Together
¥ Vignette Removal
__| Geometric Distortion Correction
Content Aware Fill Transparent Areas

Make sure the Blend Images Together
B and Vignette Removal boxes are ticked.
- If you want-to fill transparent areas then

- - "-:.Jmns.a Cpntent,&,ﬂarg F.|I1 Ir.anap.arﬂn‘e Ar _

What would you like to do next?

Save:
Save Sawve As
Continue Editing:
In Quick In mt-)
N
Share:

Once Expert mode has stitched the

images and filled any transparent areas,
it returns you to the Guided page to save it or
continue working on it in Expert mode.

Auto Panorama

S Z
o L

Cylindrical

e Make sure all your photos are selected
and choose the type of setting you want.
In nearly all cases, the Auto Pancrama settings
is fine for standard photos.

Adobe Photoshop Elements

|
=
' '-"+.-|.-'- R EREREEEREREEREEERER SR E R R RN R

Mow you can click the Create Panorama
button and the stitching process will
begin. Note that Expert mode is used to stitch
YOuUr images.

In Expert mode you can flatten the image,
make adjustments to the image and crop
it if required. Then you can save the result as a
PSD or other image format.




86 BOM'sindependent Manual Series | Volume 19




.
i:r‘_::\x N THE .J:'EJ.T!" After (Roll over to see Before.)

1. Click the Create Meme Template button
to get started.

= - ‘

=

A

IN ASOUARE

2. Click the Type Tool button to modify
your top and bottom text.

Turn photos and text into fun memes for

al .i ; .
e Use the tool options below to adjust the

style of your text.

In the Guided workspace, the Meme We have a funny picture of a monkey
Maker 1s under the Fun Edits category. sticking his tongue out. The first thing to
Make sure you have a suitably werthy image do is to click the Create Meme Template button
open and ready to go. to add the basic frame and text.
JUUJ'C\..IH
Zoom: [}
Hip: D(J .&
Impact Regular - Color: | Fit photo to canvas
Requiar Size: | 36.4 pt j
: ; 4. (Optional) Choose a new border.
Leading: | (Auto) | = | Tracking: © | |
é :E{‘F‘f I-.E_i.'I
3 Bin - Tool Options- Undo Redo Rotate Organiz \ k /
You can type new text using the Type Then you can zoom your photo if required
Tool and choose any font from the Tool and flip it horizentally or vertically. Then
Options panel in the lower left of the screen. yvou can choose to add a new border from the
options available.
L T NINTIIFL S FITNTRIY
J X Effects

In Quick In Expert

_;-;-«.h 3 a Share:
Flickr
F - k| ' . *
- -" - I Twitter
1 i

L " 4 : _
You can also add more effects to the Finally, when your meme is ready, you can
resulting image. You can choose from save it, continue to work on it in Quick or
a pop art, black and white and several other Expert mode and Share it with the world on
options. Click on the effect you want to add. Flickr and Twitter.
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Create visual text with a different photo inside
each letter.

The Multi-photo Text guide is in the

Fun Edits section. With your chosen
background photo open, you're ready to then
click on the Multi-photo Text icon.

o o 3
= Click hee Braddphote. = Click hese m add ohoto
.._I

When you click the Create Frames

button, each letter is converted to a
frame ready for you to click and then select a
photo to appear in it.

Clear Color

White Black

6. (Optional) Choose the intensity of your
text's bevel, drop shadow, and stroke.

. You can add a new background if you
: want by clicking the options available: or
you can add outlines and drop shadows to the
text to make it stand out more.

[} Kohinoor Bangla Bold Sample
{) Kohinoor Devanagari Light Samipla
{} ¥ohinoor Devanagari Regular Sample
() Kohinoor Devanagari Medium Sample
{) Kohinoor Devanagari Semibold Sample
{} Kohinoor Devanagari Bold Sample
{} Kohinoor Telugu Light Sample
) Kohinoor Telugu Regular sample
{} Kchinoor Telugu Medium Sample
| 1
Impact Regular Il'_'&! color: [T
Regular - SEes 100 pt |
Leading: (Auto) |~ | Tracking: O -
b

B o = .. e 1~ (BB
i [ 5 . )- Ea

Bin - Tool Options’  Undo Rado Rotate Organizer Home S

Use the Type Tool first to add your text,

alter its style and size using the Tool
Option panel. You can also specify how it fits
your photo.

=1

S N (¢ e

Choose from your computer or your

Pheto Bin and place one image inside
each letter. Double-click each frame to adjust
the image size and position.

Save it there and then or open it in Expert
mode to work on it further. We made the
rabbit larger and more visible and then saved it.
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B&W COLOUR POP

Highlight a single Color in your photo to make
it pop.

. The B&W Color Pop edit is found in the . You can click on one of four presets or of
Black & White section. Open a photo that vou prefer, click on the Select Custom Color
you want to add the effect to and then click on button and pick the most dominant colour you
the B&W Color Pop icon to proceed. want to remain untouched in your photo.

effect is applied.

¥ select Custom Color .
’ H“’ Refine Effect

Use the slider to include more tones of . P
selected color. Subtract

Fuzziness .

2. (Optional) Use the Refine Effect button
to add or remove where in your image the
effect is applied.

. Then, if you increase the Fuzziness You can then use the Refine Effect
value, more colours similar to the one buttons to bring back more areas to
chosen will become visible again while the rest colour using the Add tool, or remove them
remains in pblack and white, using the Subtract tool.

‘ 7 Add \ w7 Subtract

Size :

Opacity :

3. (Optional) Click on 'Increase Saturation’
to boost the color.

. The Size and Opacity sliders dictate size FPaint over areas that you want to be
of the brush and how opague the effect of coloured again, using a smaller brush for
adding colour or subtracting it appears. We're finer detailed areas. Finally, you can then click
bringing colour back at full strength. Increase Saturation for a more vivid image.
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5

THE ELEMENTS EXPERIENCE

The Elements Experience 8

Zoom Burst Effect

Sometimes you want to add motion to an
image that is otherwise quite static-looking.
Elements has a few Guided edits that can
add a motion effect to your photos to give
them a little extra punch. The Zoom Burst
Effect is a digital version of an ages old
photographic trick where the photographer
quickly zooms the lens as they take a

shot to create streaks within the photo;
emulating the feeling of speed and action.
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Add some motion and action to your photo
with this classic effect.

»“a’i—“ The Zoom Burst Effect edit is found in the
%" Fun Edits section. Open a photo that you
want to add the effect to and then click on the
Zoom Burst image to proceed.

L= Use the crop tool to drag a crop box
= around your main subject. Our example
is of a motorcycle to which we want to add
some motion to create a bit more drama.

i
Z0OM BURST EFFECT /% )

After (Roll over to see Before.)

1. Use the Crop Tool to crop your image so
that the primary subject is in the center.

,42 The_i first step_is _tc:- crop your image so the
= main subject is in the centre of the shot.
The zoom effect will start from the centre so it

makes sense to position the image centrally too.

2. Click the Add Zoom Burst button to
apply the effect to your image. Press
multiple times to increase the effect.

3. Click the Add Focus Area button and
then click and drag on your iImage to
specify the area of focus. Repeat as
needed to increase the area of focus.

a \ You can then click the Add Zoom Burst
5 button and the effect will be added to the
shot. It mimics a photographic effect where the
lens is quickly zoomed as the photo is taken.

S \\ '

|

5”‘ At the moment, the entire image has the
0 effect added to it, however, you can use
the Add Focus Area tool to remove some of the
effect in a chosen area.

, i
i S

#

| —

-
e

F

&  ‘We used the Add Focus Area tool to
0 bring the rider back into focus to give
the shot a point of interest. We also clicked the
Apply Vignette button to darken the corners.

wurw bdmoublicetions.com
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1

5
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Shared Folder

barons_368.jpg barons_760. dog.jpg

remove 2.iba remove 3.ipa

In the Guided edit mode, open your photo
by going to File > Open and navigating

to your photos. Select the one you want to use
and press the Open button.

After (Roll over to see Before.)

1. Click on any of the three Black and
White presets provided below :

2. Tonality is the range of black & white
tones produced by the shadows & light in
an image. Adjusting Tonality gives your

Click the Old Fashioned Photo preview
under the Fun Edits category and begin
the process by choosing from the three Black
and White pre-sets listed.

3. Add texture to enhance the Old
Photograph effect, click ‘add texture' to

add, repeat to intensify.

4. Colorize the image using the Hue,
Saturation & Lightness. Click on the button
to access the sliders.

:n- Add Hue/Saturation

Old photographs are characterised by
their graininess. The Add Texture button
allows you to add a certain amount of grainy
texture to help with that old photo feeling.

OLD FASHIONED PHOTO A

show Open Files

Photo Bin - Toeol Options:  Undo Redo

We have chosen an example of two
rockabilly musicians who have a very
retro look and, given their location, this should
canvert well into a shot with a vintage feel.

- = ]

Newspaper Urban Vivid

2. Tonality is the range of black & white
tones produced by the shadows & light in
an image. Adjusting Tonality gives your
photo a more dynamic look.

o

3. Add texture to enhance the Old
Photograph effect, click 'add texture' to
add, repeat to intensify.

o Mext, you have the option to click the
Adjust Tone button. Adjusting the tonality
of the photo makes it slightly more contrasting.
It can be quite subtle, but worth a look.

v

The final step is to click the Hue/Saturation
button. You can use the Hue, Saturation
and Lightness sliders to add a tint to your photo.
We've opted for a classic sepia look.

wurw bdmoublicetions.com
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Depth Of Field Al ?

--. Simple
] ' Add depth in a single step

1. Click Add blur button to give the image
a default blur.

1 %u have two options to create your © ) The second option is the Custom approach,
f'_ﬂﬁfjg;;t. The first is the Simple option where which involves making a more detailed
you blur the image and then click and drag a selection of the subject that you wish to remain
gradient that defines an area of focus. in focus, whilst blurring the rest of the photo.

= =

31#‘1ﬂ'-.-1-..-""'

You start the Custom process by using 7% You can use different brush sizes and if

a Quick Selection Tool and dragging it W the selection goes wide, you can switch
around the outer edge of the subject you wish to Subtract selection to remove areas that have
to remain in sharp focus. strayed outside your subject's outline.

2. Add Blur to the image, using the button
below; to create depth.

Use the slider to vary the blur inten: 2°

Blur : @

ﬁiﬁ.ﬁ e

Use the Subtract tool and with a small 1 Once your selection is ready, you can click
brush size, carefully remove any parts W the Add Blur button. Below the button is
of the selection that have jumped outside the a Blur slider, which you can use to increase the

outline of your intended subject. amount of background blur,




AV
/

Your Guide
to Image

Editing

The great thing about Adobe Photoshop Elements is that it
can cater for all skill levels when it comes to image editing,
digital manipulation and creating new works of art. Whether
you are a complete novice who is starting out and wanting

to learn the ropes or an experienced digital artist who needs
more advanced tools to complete their project, Photoshop
Elements has all the power and sophistication you need to get
the most out of your photos.
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YOUR GUIDE TO IMAGE EDITING

A Guide to

Using Layers

Layers are one of the fundamental aspects you can employ when it
comes to non-destructive image editing.

very core of image editing since its

introduction in the early '"90s. As
yvou might imagine, layers are exactly
what they sound like. You can have a
number of separate elements, each
on its own layer, that are stacked one
on top of the other. When all viewed
together, they create the final image.

The advantage of using layers is clear.

It means you can chanae an element
on one layer only and not have an
impact on the rest of the image. It also
means that you can take an image
and duplicate it on another layer and
perform any edits you want on that one
in the knowledge that the base image

The use of layers has become the

8 Awgbw Fhoiostop Eeeeis 3018 Bdw T

will remain untouched in case it doesn't
turn out quite as you had hoped. Within
Elements, there are four main types of
layer. There is the basic pixel layer which
contains the main photo elements of the
project. There are text layers where you
can type text and change the size and
colour. Then there are fill/adjustment
layers that are designed to affect the
layer below it such as changing the
saturation or oriahtness of the layear
below, or just adding a colour to that
laer. Finally there are vector layers that
contain scalable graphical elements such
as shapes and work paths. Each layer
type can also have a mask added to it so
only part of that layer can be seen,

o Create New Layer

You can click the Create New Laver
button at the top of the layer panel, use
the key broad shortcut or go to the file
menu and choose Layer > New > Layer
to add a new layer to the stack. You will
be prompted to name the new layer. You
can rename it at any time,

e Create New Group

Sometimes it may be necessary to take
a number of layers and group them

to make things more manageable, as
the number of layers increases in your
document, You can highlight each layver

b |

£ g3y @ HA Ly AT | g ey O Ly €, RO
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vou want and then press the Create

MNew Group button to group them.
Alternatively, you can go to the file menu
and select Layer > New > Group

o Fill or Adjustment Layer

Fills and Adjustments allows you to add
colours, gradients and patterns to a layer.
They also allow you to add adjustments
such as Brightness and Contrast, Hue and
Saturation and Levels, Adjustment layers
affect the layers directly beneath them in
the stack or they can be clipped to the
one layer airectly below them only.

o Add Layer Mask

Each layer vou use in a document can
have 2 layer mask added to it. The mask
1= designed to let you hide or revea

specific parts of that layer only. Areas

of the mask in white let the layer remain
visible, while any areas of the mask in
black hide that part of the layer. The
rule of thumb is: white reveals pixels and
black conceals them.

9 Lock all Pixels

Clicking this butten locks the layer
completely and no further edits can be
made to it. You will also be unable to
reposition the image on a locked layer,

o Lock Transparent Pixels

If wou click this button, any area of a
layer that has no image pixels in it is
considered transparent. An area that is
transparent is then locked and no edits
can be made so it remains transparent.

% Normal

) &

tQ T

USING LAYERS

Shape 2 @

<@
=

Layer 1

13,

Layer 0 i

A GUIDE TO USING LAYERS

o Delete Layer

The trashcan shaped button lets you
delete any selected layers if you wish to
remove themn from the layer stack.

o Panel Options

There are a number of menu options
avallable here such as Rename Layer,
Duplicate Layer, Delete Laver, Link
Lavers, Merge Visible and Merge Down,

o Blend Modes

Blend Modes determine how the image
colours on the layer interact with the
layer below it. It can be changed for
every layver individually or as part of a
group for cartain visual effects,

@ Visibility

The small eye icon on the left of each
laver lets yvou turn that laver off so it is
not visible. Any effects associated with
that layer are also rendered invisible until
the eye icon is clicked once more.

0 Link/Unlink Layers

This lets you link a number of layers
50 that any transformations and move
commands you make are all applied to
the linked layers at the same time.

@ Background

The Backaround layer is the default
bottom layer. Whether it is an image
vou have opened or a new document,
the Backaround layer s always partially
locked until vou choose to unlock it.

@ Standard Layer

A typical layer with pixel information
displaved on it

@ Adjustment Layer

An adjustment layer is designed to affect
the layer below it. In this example, we
have a Levels adjustment that alters the
brightness and contrast of all the layers
stacked below it.

@ Vector Layer

A vector layver contains scalable data
such as shapes in the case of our
example. A small icon in the lower right
corner of the thumbnail indicates it 1s a
scalable graphic.

@ Text Layer

The thumbnail of a Text layer displays a
T to indicate the layer contains scalable
text, The layer name also reflects
whatever text is on that layer.
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YOUR GUIDE TO IMAGE EDITING

Q)

Methods for
Adjusting an Image

When it comes to methods for adjusting your images in Elements, you
are spoilt for choice. There are a number of methods to get an image
looking great. We'll show you how each one works, with some examples,
to help you choose which method suits you best.

Quick Mode

Spot Healing Brush Tool (J)

o We start in the Quick mode workspace with a sunrise o To remove such a blemish, you can go to the toolbar and
mage of a pier that is in need of some work to make it choose the Spot Healing Brush Tool (). When you choose
look its best. The first thing to do is remove that large black spot this tool, the Tool Option panel displays Spot Healing Brush

in the top right corner: probably a bit of mud stuck to the lens, options. You can choose Spot Healing Brush or Healing Brush to
currenthy spoiling the shot. remove the spot,

2]

=
=]

L
e R R

El |

Photo Bin  Tool Dp’r.inns: Undo Redo Hntm Crganizer Hum& Screen Pheoto Bin *Tool :I.‘|I|::|-’r.inn|'|uE Undo Redo Rotate Organizer Home Screen
o The main difference between the two brusheas is that the o The Healing Brush Tool asks you to select an area to be
Spot Healing Brush lets yvou paint directly over the blermish the clone source by clicking on a clean part of the image
and then works out what to fill it with by analysing the area next to the blemish. This chosen area will then be cloned over
around it, Proximity Match and Content Aware are the best the blemish when you paint over it, The cloned source will be
options here for this kind of blemish. Dlended in to be as seamless as possible,
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“r’n:lu can alter the brush size by using the Size slider In
the Tool Options panel or by pressing the left and right
bracket keys. Pressing [ will reduce the size of the brush and
pressing ] will increase the brush size. This lets yvou clone with
greater accuracy and detail if vou need it

o This calls up the Adjustments panel, You can choose
Smart Fix and select from a number of options that make
subtle changes to the image and recover detail in the highlights
and shadows. Hover over each one to see a CIFEN | e of the
effect applied to your photo. Click the one you want to apply.

o The Lighting oanel is the key to really controlling the
prigntness of your Highlights, Midtones and Shadows,

each of which has its own tab for vou to access. Choose from
the options provided or use the sliders for more subtle control
of each of the tonal options.

METHODS FOR ADJUSTING AN IMAGE

= T
H i

Adjustments Effe

o Mow that the blemish is gone, we can look at making

the image more vibrant and appealing. Layers are not
available in Quick mode, s0 it comes down to choosing the
right method for the best overall effect. The easiest way to see
the effect yvou can have on the image is to choose Adjustments
from the taskbar.

o Mext, you can go to the Exposure adjustment and
choose to make the image brighter or darker. Again you
can hover over a number of options and see a preview of the
effect or use the slider to make more subtle adjustments to the
brightness of the image.

@ The vividness of vour image can be controlled in the
Colour panel. Increase the Saturation globally or use
Vibrance to increase the most subdued colours first. Hue lets
you shift the entire colour palette for a surreal colour effect if
You require it
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0 Balance lets yvou shift the colour temperature from cola
ta warm and Tint allows you to add either an increasingly
green colour cast or a magenta cast to help offset any colour
Inconsistency in your original image.

Quick Mode Auto Modes

Select  Filter View
Auto Smart Fix M
Auto Smart Tone... KT
Auto Levels 3L

iit Image

Enhance Layer Window Help

Auto Contrast L
Auto Haze Removal AR A
Auto Color Correction 1+3EB
Auto Shake Reduction

Auto Sharpen

Auto Red Eve Fix

Adjust Color

Adjust Lighting

Adjust Smart Fix... {r 3€ M
Convert to Black and White... B
Haze Removal... s

o IUnder the Enhance manu are a number of Auto features to
Improve your image. These are quite broad in thair effect
and do lack a certain finesse, so You have ho real control over the
outcome. T you want some more input in the effect there are a
couple with a bit more control worth looking at.

o If wvou go to Enhance > Adjust Colour = Adjust Colour
Curves, you can adjust the Highlights, Midtones and
Shadows of your image. There are a number of preset styles you
can choose from to enhance the colour in your image as well as
the option to manually adjust the tone sliders,
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@ Finally, vou can go to the Sharpen panel and apply levels of
sharpness to your image; but beware of overdoing it anad
creating artefacts and halos as the contrast increases and bright
unwanted highlights appear around areas of high contrast in your
photo. If vou are happy, vou can save the result.

o If vou go to Enhance = Auto Smart Tone (Shift + Cmd + T)
an interactive panel appears, where you can drag a cursor
around a grid. Each corner of the grid shows a possible outcome
that can be achieved by moving the cursor further in that
direction. Move it arcund until yvou get the result vou want,

o Another option, but one that needs a light touch, is the
Haze Removal tool Go to Enhance > Haze Removal (Shift +
Cmd + Z). This can be quite a strong effect but there are sliders
to adjust the strength of the Haze reduction applied and also the
sensitivity of the haze detection.




METHODS FOR ADJUSTING AN IMAGE

Guided Mode

Show Open Files v

@ 5

Photo Bin : Tool Options:  Undo

9 C D=

Redo  Rotate Organize

Adjust the brightness, contrast, and tonal
range of your photo.

Guided Mode is an alternative if you are happy to have less

advanced adjustment options available but with more step-
by-step guidance to help you on your way to creating the final
image. Make sure you have an image open in the Photo Bin reacy
to work on

Levels g

1. Click Create Levels Adjustment to open

the Levels dialog bax & Learn more about: Levels

Create Levels Adjustment
3

Channet: | RCB =

Ingut Leveds:

2. To ensure that your Image uses the full
range of tonal values, drag the black slider
to the right S0 that & is just below the left

miost point of the graph. Then drag the e
wifilte slicer to the kefl 5o thal ® is just
below the rght maost point of the graph, [+

]

Dutput Levels:

—

0

9 You will be asked to create a Levels adjustment and a
dialog panel will appear. Click QK. Since the image has a
lot of underexposed dark areas in the foreground, sliding the
Midtone slider to the left will brighten the photo in those darker
areas. You can then click Next and then Done for this part.

o The great thing with Guided edits is that you don't have to
apply just one edit. We are going to apply several to get
the end result we are after, Start with Levels tao get the overall
brightness of the image dialled in first. Levels can be found in the
Basic category.

Show Open Files

ENHANCE COLOR

Fine-tune and enhance the colors in
"l Iﬂm“-

Photo Bin : Tool Options:  Ung

o Mow, If vou look In the Photo Bin, back at the main Guided
Hame screen, the phota will have a small icon in its top
right corner that indicates it has edits applied. Then, you can go
to the Colour category and choose Enhance Colours to add more
vividness to the photo.

Create =
Enhance Colars Y]

sShare «

Click Auto to balance the colors and
oortrast i e photo.

Emm

Use th sliders below 0 fine tune the
adjustment.

Hue : o r—
Saturation ; —E_
Lightness :  emm—""

You can use the three sliders of Hue, Saturation and
Lightness to make the image much more saturated and
bring out the colours in the sea, sky and foreground. A boost of
Saturation to 45 and Lightness to -2 is encugh to bring more life
INto the photo. You can lick Next and Done once more.

5,

Create -
Lighten and Darken

Share =

ta i 7

Click Auta to apply a general fix to the
Photo's exposure.

mmm

Drag these shiders to manually balance the
shadows and bright spots.

{

i

o Firally, back in the Basics category, click Lighten and Darken
and use the three Shadows, Highlights and Midtones sliders
to make final tweaks to the image. The Highlights have been
reduced to bring more detail back into the brightest areas. At this
paint yvou can click Mext and then save your image.
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YOUR GUIDE TO IMAGE EDITING

Using the Photo
Faitor Expert Mode

Don’'t be put off by the title of Expert. In this case, you get more tools to
play with and you can actually be more involved in the editing process.
You can switch out to another mode, but to truly unlock the power of the
program, you will want to try out some image editing in this mode.

Q)

This tutorial
content is
available for
download

oom m § - o.

o We have opened another image that needs some fixing. It
Is @ sunrise on the moors that 1= a little underexposed andg

o First, the colour balance needs to be adjusted. The image
Is a little too magenta and warm, particularly if yvou look

neads some work to bring out the foreground, while keeping the
sky relatively untouched, since that Is guite well exposed. This is
where the use of layers and masks will help us out.

act  Filter View Window Help

Filter Gallery...

Correct Camera Distortion...

Adjustments
Artistic
Biur
Brush Strokes
Distort Blur More

MNoise Gaussian Blur...
Divalate |

Blur

arne FRliir

o Press Cmd + J to copy the Background layer. Name the
new laver remove cast’. Then go to Filter = Blur > Average.
This will blur the duplicate of the scene and average out the
colours it contains into one colour, In this case, it turns a muddy
brown colour,
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at the colour of the grass. This can be altered by using a really
simple trick that can be really effective and requires the use of
layers to do it.

Opacity: |_‘1m}%_ _H : l

4

colour to a pale green hue instead. This colour, derived from
the colour average of the original scene can be used to create a
colour correction filter,

.':" ——
Set the blending mode for the layer

remove cast

Make sure this laver is active then go to Filter =
Adjustments > Invert (Crmd + D) to invert the muddy brown




USING THE PHOTO EDITOR EXPERT MODE

DLTEETT - B "

lor Dodge Create ~ Share -
1]

Linear Dodge (Add) — =
Lighter Color YJdeoa&s
Overlay  ~

Soft Light ¥
Hard Light
Vivid Light

remove cast

o =0 to the Blend Mode button and from the dropdown o Altering colour can be guite subjective and If yvou fesl
menu that appears, choose Overlay as the blend mode for that the correction s too much, you can always go Lo
the 'remove cast' layer. This will blend the colour of that layer into the Opacity slider and adjust to albout 80% to lessen its effect
the photo of the moors below it. You should see that the snow slightly if you wish. Now you can continue editing the image.
now looks a lot cleaner and whiter than it dig.

wITENE T R

MODIFY

o %
x N

COLOR
2

|
@ 0 . remaove cast
o o

Set foreground color

o Mow to make the image punchier, click the Create New o Choose the Brush Tool (B) from the toolbar, then set the
Fill or Adjustment Layer button and choose Levels. Make foreground celour to black. You can press D to default
sure 'Levels 1" is at the top of the layer stack. Adjust the Midtone the colours so black is the foreground colour and white the
slider so the sky is a bit darker. This will obviously make the entire bhackground colour, Pressing X will swap those foreground and
image too dark but you can fix that next. background colours over if you require.

Create ~ Sl

J@. O a

Levels 1

3 = = |Layer mask thumbnail
L size: = e Click to o '
O W D
) IR e
Rotate  Layout Organizer Home Scre "
When vou choose the Brush Tool, the Too! Options pane| @ You can now use that soft black brush to paint on any areas
will display parameters for the brushes. We need a large of the mask where you do not want the adjustment to be
soft brush which can be chosen from the Brush Presets menu. visible, In this case, we only wanted the sky to be adjusted so0 we
Click on the Soft Round 200 pixels brush to make it active. Make painted cver the racks and foreground.

sure the Levels 1 layver mask is active by clicking it.
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Levels 1

e
g . remove cast

Whean you paint over those areas, vou are hiding the

adjustrment so they become their original brightness again.
In fact, it would be nice to make the foreground rocks and snow
brighter, so let's get another Levels Adjustment and add it to the
laver stack. This will be 'Leveals 2.

@ Just as you did with the ‘Levels 1" layer mask, paint with
vour soft black brush on the 'Levels 2' layer mask over the
sky area and hornzon. You are now concealing areas of the 'Levels
2" adjustment so the sky goes back to being darker again

Normal - Opacity: |100%

%# :- Levels 2

@ There is no reason you can't add the same amaunt of blur
to the 'Levels 1' layer mask as well. The softening of the two
masks means there are no obvious joins bhetraying the fact that
various adjustments have been made. Thanks to the use of layers
this has all cean non-destructive editing.
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@ Fush the Highlights and Midtones sliders of the 'levels 2
adjustment to the left; as you do this, you will see the entire
image become lighter, Concentrate on the foreground rocks and
snow and adjust the sliders until they look nice and bright, The
sky might be too bright but not to worry.

A

™

® If you want, to blend the masks better, you can keep

the 'Lewvels 2' layer mask active and go to Filter > Blur >
Guassian Blur and choose a blur of about 125 pixels to help blend
the two adjustments you've made seem more seamless.

Er:'ﬂ R

e g == -
bi | o ——— - =
L " | T

=S S,

@ MNow that yvou have both the Levels Adjustments in place,
vou can ravisit them at any time and tweak the sattings to
your heart's content. You can even go back into the layer masks
for each and wse your brush tools to refine those masks you
applied in the first place.




0 The image has now bean colour balanced and two sets of
adjustments have brought some sparkle to the snow in the
foreground and kept the sky dramatic in the background while
the rocks now have some nice detail showing in them as well.

Hue/ Saturation ==

Channal; | Master -
Hipg: = —D-l——- o

Baturation: _————(R— +38

Lightnass; e o
[_] Colorize

@ How much Saturation you add is a matter of personal taste
but to capture the glorious colours of that sunrise, it's been
pushed to +326. You will notice however that the grass could do
with a little push to make it more vibrant.

Create ~ Share -
¥ 3
Opacity: | 100% | =]

Gradiant Mag...
& g Phato Filber....

el 1

Irvart

Thrashald..,

”-m ™

@ £ E Biackgrownd Elmmt

@ Mow let's turn up the vividness of the image. Click on the
Create New Fill or Adjustment Layer button and choose
Hue/Saturation from the list that appears. A 'Hue/Saturation 1
layer will be added to your existing layer stack. Make sure it is the
topmost laver.

Hue/Satud  Master x2 =
Reds w3
Channe

Greans b |
Cyans N6 — 23

| Bives 7 |
Saturatio .30
Magentas 8 x
Lightness: 1]
7 Colorize

| ==

& AL

@ Click the Channel button and you will see how you can
affect the saturation of the component colours. Select
Yellows and dial up the saturation and push the Hue slider to
about +23 to really bring out the vibrant green of the grass.

Create -

e da g f -=

Opacity: |100%

Hue/Saturation 1

@ At this point, you may want to perform more edits to the
image. It is always good housaekeeping to create a snapshot
of the work done thus far. To do this, press Shift + Alt + Cmd + E,
This creates a new layer which is a merged version of all visible
layers. Mame this layer ‘'merged”.

@ You can now perform edits directly to the pixel data of the
'‘merged’ layer, safe in the knowledge that it anything goes
wrong, you still have all the original work on the layers below
which you can use to create another merged version. You can
also save yvour document as a P5D file when completa.
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YOUR GUIDE TO IMAGE EDITING

Rectangular Marquee

o This tocl lets you make selections of square or rectangular
areas of your image. In addition to making the selection,
vou can add to it, subtract from it and intersect with it. You can
make selections of a fixed size, fixed ratio or normal aspects. You
can also feather and refine the edge.

9 The Lasso tool can be used to make area selections from
your image or active layer. The shapes yvou select with the
Lazso tool can be completely irregular and hand drawn. When
vou join the lasso back up to the point where you started, the
selection s closed.
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Working with
Selection Tools

Some aspects of image editing will require you to select certain areas of
a photo so you can either place it on another layer or edit it in isolation
from the rest of the image. With Elements, you have a number of options
for being able to achieve this and we cover them next.

QY

This tutorial
content is
available for
download

Elliptical Marquee

o [he Elliptical Marquee tool behaves in the same way as the
Rectangular Marguee tool and has the same tool options
available. You can make circular and elliptical selections of any
size or proportion. If vou hold the Alt key, you can centre vour
ellipse over the cursor position.

o This tool uses edage detection to adhere to the edge of the
subject you are attempting to selact in the image. You can
alter its parameters for more accurate detection in order to make
it snap to the edge of your subject, Areas of high contrast work
best with this tool.




WORKING WITH SELECTION TOOLS

Polygonal Lasso Quick Selection

9 The Polygonal Lasso allows you to draw point-to-point o The Quick Selaction tool lets vou paint a selection as if it
straight lines around your subject. This is good for were a brush. It uses edge detection to attempt to match
geometric and straight-edged subjects where a perfectly straight your selection to the nearest edae in the image. You can alter
line is required. Like the Lasso Tool, when you join back up with brush size and settings and it works best on high contrast
yvaur start point, the selection is closed. subriects that are in sharp focus.

Magic Wand

o 'he Selection Brush is more of a freeform brush that lets o This tool is useful for the selection of image areas that

v choose a brush type of certain size and hardness are the same colour ang brightness. You can adjust its

and paint a selection arouna your chosan subject. You can also sensitivity, refine its edge and also choose whether it will glabally
choose to make it a mask instead. You can add or subtract from select all areas of a chosen colour or just its nearest neighbours.

vour selections in the usual fashion.

Refine Selection Brush Auto Selection

o The Refine Selaection Brush lats vou make targseted @ This works in a similar way to Quick Selection except that

aqjustments to an existing active selection. In additional to vou use Rectangular and Elliptical Marguees and the Lasso

adding or subtracting from the selection you can actually push the and Polygonal shapes to enclose an area for edge detection to

selection edge and smooth it by applying the refinement brush, work within, It works best with well-defined shapes that have
good contrast.




YOUR GUIDE TO IMAGE EDITING

Q)

Cloning, Healing &
and Enhancing

Even with modern digital cameras, a lot of photos may have
imperfections in them; for instance with dust contamination. This will
be displayed as a black smudge on the final photo. Removing these
blemishes is quite easy. The technology can also do much more.

Eye Tool

L M E

a B R

i | e gl

o FRed-eyve is caused by light from the flash of a camera o Click the Eye Tocl (¥ and simply click yvour cursor over the
reflecting off the blood vessels at the back of the eye when offending redness in the eyes of yvour subject. The tool will
the pupil is wide apen. It yvou happen to find a favourite photo remove the redness and yvou can alter Pupil Radius and Darken
where your subject has red-eve, then it is a simple process to values to make sure the red has been completely removed. It can
remove Jt. also be set for Pet Eye as well.

Closed Eye Correction

an g
Click to Apply: E = G
Camors Crganinar P
Gk 0 ey
- A
Y S
ad B |
4% AW
.-
i
"
o Another great function available in the cptions panel is the o Eveas that closely resemble vour subject will work best or if
function to open closed eyes. Click the Open Closed Eves vou have another image where the eyes are open, you can
button to activate the dialog. The image will scan for closed eyes load that and the program will automatically apply those cpen

and circle possible candidates, Choose the one you want. You eyes to your current image.
can then choose a set of open eyes to merge into the shot,
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CLONING, HEALING AND ENHANCING

Spot Healing Brush Tool

The Spot Healing Brush is great at removing dust spots
from photos and is also great for removing spots from
humans too. If you have a portrait and the subject has some
unwanted blemishes, yvou can use the Spot Healing Brush to click
on the spot and it will use nearby pixels to fill the area.

i

S —
Fs
e :
_100% | Doc: 11.4MALAM }_
Healing Brush
3 u""l . Size: m(Ommms 30px | SoUrCe:  Sampled
Brush Settings... Mode: MNormal
30 i
E Alignad Clona Owverla

o The Healing Brush is an clder version of the Spot Healing
Brush, It requires you to specify a sample point of a similar
clean texture which is then cloned over vour chosen area much
like a Clone stamp when vou click on the target blemish or
wrinkle you wish to remove.

o You can choose between Proxirmity match, Create Texture
and Content Aware. For most of your subjects, you may
find that you are switching between Proximity Match and
Content Aware, You can adjust the brush size for smaller spots.
With care, most blemishes and wrinkles can be removed easily.

When it comes to Healing Brush technigues, you will find
that subtlety is the key. Spot Healing 1s not perfect and may
require several attempts to get it right. Avoiding too many repeat
patterns is important to avoid creating a texture that doesn't look
like it has been cloned.

Smart Brush

o The Smart Brush uses edge-detection to allow vou to brush
areas of your photo and apply different effects to those
areas. When vou select the Srmart Brush Tool (F} the options
panel has an effects picker to let you choose which effect you
want to apply to yvour photo.

o Choose an effect such as a pencil sketch effect and begin
to drag your brush over the image, wheare yvou want the
effect to be seen. You can change brush size and settings such as
hardness and roundness and subtract from the current selection,
Choose the Detail Smart Brush for more refined selections.
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YOUR GUIDE TO IMAGE EDITING

Clone Stamp Tool

= =

L
e m

o After the Healing Brush Tool, the Clone Stamp Tool (S)
will seermn guite familiar. It copies pixels from one area onto
anather to remove things from vour photos. Despite recent
advances with the Content Aware ana Spot Healing Tools, it
remains one of the best ways to remove things from a photo

[LILY,

By -

Mode: | Mormal

= B Cions Ovariey |

Select the Clone Stamp Tool (5). In the options panel, you

will have a number of paramaters to choose from such as
Size, Opacity and Blend Mode. The Aligned button, when ticked,
links to and moves your source point as you move your cursor.
Unticked, it uses the same source point each time.

o Herz i1s a wildlife photo from which we want to remove the
distracting blades of grass that are sticking up to the right
of the rabbit. This is a good example of how cloning can guickly
remove elemeants from your photos with minimal effort.

Press the Alt key and select an area right next to the tip

o of the grass as the source of your cloned pixels. Now vou
can clone that area over the blades of grass. If the colours don't
match, you can reselect an area that more closely matches and
cdoesn't stand out as cloned.

e Work vou way down the grass stem, you can change the
size of the brush at any point by pressing the left and right
bracket keys on your keyboard. Take your time and don't be
afraid to keep selecting new clone scurce points so the colours
match the background when yvou clone out moare of the grass.
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0 Cine thing that really gives cloning away is a repeating

pattern. If you see a pattern building up, you can press

undo (Cmd + 2 to step backward through your last performed
actions and change your clone source again to avoid the
repetition of that pattern.




CLONING, HEALING AND ENHANCING

o In the options panel, yvou also have the Pattarn Stamp o You can change the Pattern Stamp's Size and Opacity as
avallable. As the name suggests, vou can use this tool to well as the Blend Maode. Choosing Soft Light, for instance,
apply a preset pattern to your image. Click on the pattern picker allows a softer blend of the pattern into the image. Click

and choose the pattern you want to apply to your photo, Impressionist to turn the patterns into paint dabs for a more

artistic effect.

Blur, Sharpen and Smudge

m ~ . [] Sample All Layers 0% 1M

Mode:

Normal v |

[] sampl
[ Protec

- Undo Redo Rotate Layout Organizer Home Scre

o The Blur Tool (R) 1s a fairly self-explanatory toc! for adding e The Sharpen Tocl (R) uses a brush tool to apply sharpening
Blur to specific areas of a photo. You can choose a brush to yvour image. Like the Blur Tool, it is a more targeted

tvpe and alter its Size and Strength values for a subtle or intense method of adding sharpness to a photo. Choose vour brush type
blurring of your subject. and alter the Size and Strength values to get the desired effect.

o Approach sharpening with caution since it is very easy to o The Smudge Tool (R) can be used to smear the pixels of
overdo it and ruin an image with over sharpening. Make yaur photo across the screen for a creative effect. Just
sure the Protect Detail button is ticked and begin to apply the like Sharpen and Blur, vou can alter the brush type and set the
sharpening effect, Size and Strength of the effect. The Finger Painting button adds

colour to the smudged pixels.
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Desaturate -

Sponge :
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Rotate Layout Organizer Home Screen

o The Sponge Tool (O) has two Mode settings of Saturate
and Desaturate. You can control the Size settings as well as
the Flow of the effect yvou are adding to yvour image. You can also
set the type of brush you want to use to apply the effect.

e

i s |

- m =
g L

o Chck and drag the Sponge Tool over the areas vou
selectively wish to Saturate or Desaturate, Continue to
prush the areas to increase the amount of the effect yvou are
applying. In this example, brushing using the Desaturate option
eventually turns the affected areas to arey.
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o It's a simple tool for adding targeted saturation or
desaturation to the photo. It is recommended to set the
—low of these brushes to about 10%. Then gradually build up the
application of colour saturation, the removal of colour entirely Or
just lessen the vibrance of areas in the photo

[he Dodge and Burn Tools are named after the

o technigues that were criginally used in traditional film

procassing darkrooms. Dodging refers to selectively making
areas lighter in an image and Burning is the opposite effect of

Maring IMmagaes Garkear,
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e The Dodae Tool can be usad to lighten images. Use the o You can selectively brighten areas of the image that you
Range button to determine if you are affecting just th want to make lighter. These tools work better for images
Highlights, Midtones or Shadows in your photo for greater that start with lower amounts of contrast to begin with. High
control of the final result. Again, using very low Exposure settings contrast images will have less need for these kinds of adjustments.
around 10% Is recommendead.

Gl Tk L

1M/A5.1M

Midtones v [ Size: e—— — 200 px
L_- — '_[:J o= .
"D et ]D-l HEE m

Redo Rotate Layout Organizer Home Screen i
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o he Burn Tool will selective y make narts af your nhoto o M oy YOU Can Drusn over areas that WOL want o oe darker
darker. You can darken the Highlights, Midtones and and create more contrast. Since this particular method is
Shadows by clicking the Range button again and adjusting a destructive one, in that you are altering pixels, duplicating the
the Size and Exposure settings of the brush. Subtlety is key to Dase layer ang working on a copy 1s a good way to avoid losing
making it work, so Exposure settings of 10% are a good start the original.
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YOUR GUIDE TO IMAGE EDITING

Q)

Draw, Fill,
Shapes and Text

The Draw section of the toolbar contains various elements to let you
paint, draw, erase and sample colours in your images. There are also a
number of text options available for adding text effects to your photos
and making masks in the shape of any text that you type.

Brush Tool

L

|
Y

-

T wTrr

Flé*:c”)--j

ool Dpﬂum: Undo Redo Rotate Layout Organizer Home Screan

o The Brush Tool (B) s one of the most often used tools o When you click on the Brush Tool, the options available are
in tha photo editor's arsenal. Whether vou are painting quite varied. You can control brushes with yvour mouse or if
directly over a photo, or adding brush strokes to a layer, the yvou use a tablet, you can control it as if it were an airbrush with
Erush Tool is designed to behave like its real world counterpart pressure sensitive effects for maore artistic flair,

but with more powerful features built in.

h#n

| Tebiet Saings.,

o Yau can choose any number of brush types from the brush o You can choose the colours vou brush with and also use

picker and alter the Size and Cpacity values. You can also the Brush Sethings shiders to change how much the colours

load new brushes that can be purchased and downloaded from a fade and alter with each brush stroke. You can also tell the brush

large number of vendors specialising in photo editing tools how much Scatter or Spacing to use with each brush stroke you
apply. Tablet settings are also availakla
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DRAW, FILL, SHAPES AND TEXT

= 4

Aotate  Layout Organizer Home Screen

s D C

Mext to the standard brush is the Impressionist Brush Tool

o When yvou paint with this brush, the image beneath the
(B). Using its various Brush Settings yvou can turn yaur

cursar is turned into a series of loose curls, swirls and

photo into a painting much in the style of the old impressionist daubs. The larger the brush size you use, the more abstract the
painters whose works were rendered as a series of dots, strokes image becomes. Using a brush that is too large will render the
and swirls. photo unracognisabla,
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Color Replacement Toal (B) Sty
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ool Options . Undo ~ Redo  Rotate  Layout Organizer Home Screen i

o The next brush is the Colour Replacement Tool (B). Select a Cur example picture is of an owl set against a green
foreground colour in the toolbar to use as the replacement background. The colour of the background can be replaced

colour. Once again, you have a number of tool options available fairly easily since the owl itself contains no strong green colours

including Size, Tolerance and Limits, that match the background too closely.
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o The Colour Replacement Tool works by continuously @ I the case of the owl image, dragaing the Colour
sampling the colour directly under the cursor position. The Replacement Tool over the green areas next to the owl
colour beneath the cursor will then be replaced with whatever replaces that colour; but the owl remains untouched since it is not
vou have chosen as the foreground colour. You can select the the same colour as the colour beneath the crosshair of the toal,

EBlend Mode usaed to effect how the replacement colour 1s applied.
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Eraser Tool
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o Much like its real world counterpart, the Eraser Tool (E)
removes pixels from your image. Whatever colour you have
chosen as the background will be used to erase pixel data from
the photo as if it were a solid coloured brush. You can also set
the Size and Opacity of the eraser.

Brush Settings... |

=l 5 ¢ H = A

o If the photo is on a layer, then erasing pixels will revea
transparent areas instead. Again, if you alter the Size and
Dpacity of the Eraser Tool, those transparent areas can either
Be fully transparent or partially transparent, depending on brush
opacity settings.

% 5
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e The Background Eraser Tool (E) i1s a useful one for targeted
remaoval of certain parts of an image. It behaves a little like
the Colour Replacement Tool but in this case, any plixel colour
beneath the cursor is erased, leaving the area transparaent when
It's on a layer.

e In our example, the blue can be removed sky from the
photo by placing the cursor over the blue areas to be
removed. As yvou click and drag the mouse, any blue that falls
under the cursor position will be removed, but the white clouds
remain untouched since they are not blue.
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o You can alter the Size and Tolerance of the brush, as well as
the softness and spacing of the brush you use. Tolerance

is key to setting the sensitivity of the brush to changes in colour,
High Tolerance will mean more varied colours are removed under
the cursor position.

G The Magic Eraser {(E) is a mare global erasing tool. Set yvour
Tolerance higher for more colours to be included or lower
to pick out less shades of the target colour at the cursor position
When you click on the blue sky, large swathes of that colour will
be removed with each click of the mouse,




Paint Bucket Tool

o The Paint Bucket Tool (K) allows you to fill areas with solid o You can fill and entire layer, or it can be used to fill specific
colours. You can set Opacity, Tolerance and Blend Mode, areas based on what edges it encounters. Our example
High or low Tolerance settings mean it will use edge detection to has a cartoon character on a white background. His outline is
decide which areas can be filled or ignored. quite well-defined so clicking with the paint bucket means the

hackground can easily be filled with a colour,

o You will notice there i1s an option for Contiguous fill, If it is o In addition to the Paint Bucket, vou also have the Pattern
ticked, only the nearest neighbouring colours will be filled. If Fill option. Once again you have Tolerance settings and
the Contiguous button is unchecked, then all matching colours in Opacity values to alter. Choose a pattern and use that to fill an

the image will be filled, no matter where they are in the photo. entire layer or in the case of our cartoon, the blank backaround
can be filled with texture.

Gradient Tool

‘ iy |

o The Gradient Tool (&) lets you fill areas of your image or o You can pick the kind of gradient yvou want to use by
antire layers with colours that fade from one to another or clicking on the Gradient Picker and choosing a preset from
can fade from one colour to transparent. The Gradient Tool does the list. They range from Foreground to Transparent to multiple
not use edge detection. If you need a fillad shape, it needs to be colour gradients all at the click of a button,

defined by a selection.
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Gradiart Editar |
Pragel: Default -

Al d AR TR

o If vou want to make vour own gradient, vou can click on o Qur example of a camera on a white background could
the Gradient Editor and add what are known as Colour use some colour. The background has an active selection
Stops to a basic gradient, change their colour and define if they around it to enclose the gradient when it is added. You can click
are solid or transparent. Any custom madge gradients can e and drag your cursor to draw out a start point and an end point
saved as a preset. for the gradient to follow.

R
sparency  [V] Dither :
. - = :
P o ) 3 )] |
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o When you let go of vour mouse, the current gradient will o If required, vou can change the type of gradient you are
be applied and fills the active selection around the camera. using frrom its default. You can also use Radial gradients,
The default Gradient Type is linear, meaning that the gradient Angle, Reflected and Diamond gradients. They can all have their
travels in a straight path from start colour to end colour. Blend Mode altered as well as Opacity. They can be reversed and

Transparency and Dither turned off.

Colour Picker
]

50% |
. Sample: (@ All Layers
axsfflsxs|
. 3 ( Current Layer
Average (3x3)

| O C O E 1

in “Tool Options°  Undo Redo  Rotate Layout Organizer Home

o The Colour Picker () does as the name suggests. When vou
choase this tool, it gives you a small eyedropper cursor that
when clicked on a photo, picks the colour beneath the cursor colour it samples can be across all layers or a single layer.
position and makes it the active foreground colour.

o You can choose whether it samples a single pixel ora 3 x
A average or a 5 x 5 pixel area to create an average. The
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o Choose from a number of predefined shapes and acd them e Cnce you have chosen your settings, yvou can draw out
as vector shapes on a new layver. Choose their colour and the shape on your photo. You can click and drag from the

Layer Style from the Style picker, You can also choose whether corner outwards or choose From Centre to draw the shape out
they are of fixed size or unconstrained and if yvou add to a shape from the cursor position. The shape will fill with your chosen
or subtract from it. colour when you let the mouse button go.

Horizontal Type Tool

Rockwell Extra Bold Regular - 'Eﬁl:JEl
Hasnular | Size: 00pt |~
Leading: (Auto) | ~ | Tracking: 0 x

BN Bl &

| :=p

o The Horizontal Type Tool (T} gives you a multitude of text o You also have vertical text options, text for masking and
options. Choose your font, its colour and size, You can then the ability to fit typed text to a shape or path. Our example

tvpe on your document and a new text laver will be added above shows a butterfly's outline with sample text following the outline

yvour photo, The text can be manipulated and bent into a curve or of that shape.

other shapes for creative effects.

Pencil Tool
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Mode:  Normal -
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o The Pencil Tool (N is designed to act like a real world pencil o You are then free to use yvour mouse or tablet, to sketch and
and is a hard-edged tool that has a number of preset pencil draw with your pencil as you see fit. You can draw directly

tip shapes to draw with. You can choose the Size, Opacity and over your existing image or create a new layer and draw on that
Blend Made for your pencil strokes along with its colour, 50 as to preserve your original image.
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and Recompose

The Modify section of the toolbar contains a set of tools that give you the

&
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ability to crop in a number of ways and to scale your images but protect
certain parts from being affected during the scale. You can also move the
subject of your photo from one part of the scene to another.

Crop Tool

. Crop

Suggestions
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o The Crop Tool (2) is the most common method of cutting
areas of your photo off in order to change the composition
and proportions. When you click the tool, the options panel wil
display some suggestions for you as to how it thinks the image
can be cropped. You can use those or make yvour own crop.

- il A

o You can use set proportions to crop or you can go it alone
with no restrictions and make your own crop. Simply click

and drag your mouse across the area of the scene that you want
to be cropped and a gridded box will show vou the current crop.
You can click the green commit arrow to proceed.
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o Within the crop tool aptions vou also have the Cockie
Cutter Tool {C), which lats you cut out iImages using a
number of preset shapes. You can choose from all the available
shapes such as butterflies, snowflakes, graphic symbols and
much more.
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o With wour shape chosen, vou can drag it over your image
and scale it to cover the area of the photo you want to
crop. If you tick the From Centre button in the optional panel, the
shape will be drawn cutward from your cursor position, You have
the option to feather the crop iIf vou want.




e If you hold the Shift key as you drag, you can keep the
shape's proportions locked. When vou let go of the mouse,
the image will be cropped in your chosen shape. You then have
options available that let yvou Rotate, Scale and Skew the shape
until you have it how you want it

MODIFY, CROP AND RECOMPOSE

o The Perspective Crop Tool (C) lets yvou draw a crop box
around a specific part of yvour photo that is distorted and
gives you a chance to crop and remove the distartion at the
same time. You start by drawing a crop box around the area you
want 1o crop.

You can then begin to manipulate the crop box to match
the perspective of the object vou are cropping. Use the

control points around the crop box to drag the box cut to match

the subject. In our example, the road sign gives us some helpful
straight lines to match the perspective.

o When you click on the green commit button shaped like a
tick, the Perspective Crop Tool will crop and stretch out the
image, removing the distortion. It may take a couple of attempts
but it can help you rescue some tricky, distorted images.

Recompose Tool
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o The Recompose Tool (W) uses content aware scaling
technology to let you scale images to a differant
proportion, but only scale areas with no detail. You can also
select areas to remain untouched by the scaling process for a
much better final result,

o Here s an example of a rally car with a lot of empty space
to the right. It could be cropped but this image provides
a good excuse to try the Recompose Tool. The options panel
displays a number of tools to help you with the scaling process.

weavbdmoublications.com 125




YOUR GUIDE TO IMAGE EDITING

-_,_-.—.

uql. = e g
-'.r"‘m""'-f- T

o You can use the Mark For Protection brush to highlight
areas that vou want kept intact and untouched during
the scaling process. Similarly, you can also make areas that you
want removed. You can adjust brush Size and Threshold and
any scaling restrictions you wish to apply.

o You can begin to drag the control paint inwards and as
you do, all the areas that are unprotected will concertina
together and the program will attempt to blend that pixel data
together. The areas that are selected to be protected will not be
crushad together

Content Aware Move Tool

w
T et

o the Contant Aware Move Tool (Q) uses similar technology
to the Recompose Tool but in this case it lets you move
an object in your photo and place it elsewhere in the shot and
lends it back in and fills the original gap left by the subject.
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Once you have marked out your image and have either
selected areas to protect and areas to remove, you can
click and drag on the control points around the perimeter of the
image. In this case, we are going to drag the right middle control
point inwards.

o The control point can be dragged all the way across the

image. All the dirt and dust on the right of the image has
peen merged into the space that remains now the image 15 half
the width it was originally, but the car is unchanged.

o The options panel gives yvou some simple toal parameters,
You will need to draw a selection around the object in

the photo you wish to move. You can add or subtract from the
selection yvou've made by using the New, Add, Subtract and
Intersect options provided.




MODIFY, CROP AND RECOMPOSE

With the tool active, vou can draw around the subject o

Enclose your subject in a selection and then drag it to its
that is going to be moved. Be aware that areas with

new location. The Healing sliger controls how aggressively

complex content can be a challenge and the area you move it tries to blend the image into the new location and also fill the
vour subject to needs to be of a similar texture and colour for it gap it leaves behind. The Mode can be altered from Mowve to
to work properly. Extend to stretch your selection if required.
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e The Content Aware Move Tool will Blend the image o We tried the sailboat image and also a simple object on

together. It can be a hit and miss process and may reguire grass. The grass image yielded better results after a few

the settings to be tweaked. You can also try selecting more of atternpts but it still needed some cleaning up with the Clone

the area around vour subject for more blend data to be used. Stamp Tool to remove some obvious artefacts and blend in some
untouched grass.

Straighten Tool

|I the edges after straightening the image
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Bin ‘Tool Options” Undo  Redo  Rotate  Layout Organizer Home Screen

o The Straighten Tool (F) will easily take care of wonky
landscape photos and get them level again. You have a

o Simply click and draw along a slanted horizon line that
reads to be level. Whean you let go of the button the

number of options as to how the image is handled once norizon will be levelled. There is an option to Autofill Edges.
straightenad. The canvas can grow as reguired when rotated, When the image is rotated, any blank areas will be filled with
stay the same size or be cropped o remove the background. nearoy similar textures,
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Panels and
the Panel Bin

The Editor workspace environment is a fairly intuitive space with which to
interact. It has a comprehensive set of tools and menus. Chief among these
is the Panel Bin and the various Panels that provide access to information,

history, navigation, effects and tools.

‘ Create ~

Share ~
2

Artistic -

'YW

Colored P... Cutout Dry Brush
L l ¢ .
Film Grain Freaco Meon Glow

fx | 9

Effects  Filters  Styles

o In the Editor workspace, the Panel Bin is found to the right
of the main Edit pane and contains listings of effects and
filtars. By default, the Elements Photo Editor starts up Quick
mode and the Panel Bin contents are displayed, one set of
examples at a time.

e Below the Panel Bin, in the Taskbar, are the various
buttons that let yvou access and switch between: the
Layers panel, Effects, Filters, Styles and Graphics. Under Filters
for instance, the Panel Bin displays the Artistic filter options in
its first category.

g + O

Styles Graphics More

Actions
Adjustments
Color Swatches
Favorites
Histogram .
History
Infu Source: iEntIm Image
= Navigator L o= —
E Std Dev: 28.33 Count: 2
Custom Workspace - Median: 187 Percentile: 1
Pixels: 273750 Cache Level: 4
]

o To the far right of the Taskbar is the More button. If vou
click it (not the small triangle next to it), you can opean up
the rest of the Editor panels. These additional panels open in a
tabbed group that floats on top of the Editor workspace. The
Info panel is uppermaost amongst the tabs.
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o Click the Mare button again, to hide the panels. Now, go
pack and this time, click on the small triangle and choose
Histogram. The floating panels will appear again, but this time
the Histogram panal will be uppermast in the group of tabs
visible in the panel.




Filter View

Window Help

Images

v Tools

Actions

Adjustments
Color Swatches
Effects
Favorites
v Filters
Graphics
History
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o A5 an alternative to this method of controlling the panel's
visibility, yvou can show and hide the various panels by
going to the File menu and choosing Window. From here, you
can access those selfsame panels, via the More button and the
small triangle next to it

Entire Image

o You can also drag one tabbed panel off the main tabbed

group and drop it onto the single panel floating on its own.

For example, if vou dragged the Histogram off as a single panel,
voul could drag the Actions tab across from the original panels,
drop it onto the Histogram panel and merge them.

PANELS AND THE PANEL BIN

Hl.-.mgr@

Channel: | Caolors

Source: | Entire image

Mean: 191.08 Level:
Std Dev: 2B.33 Count:
Median: 1897 Parcentile:

o If wvou call up the tabbed panel group again, yvou can click
and drag on any of the named tabs on that panel and set
them afloat, on the workspace, as a panel on their own. The
panels can be dragged anywhere around the workspace to suit
vour working oreferences when editing.

o You can, therefore, set up a tabbed group that contains
vour preferences only and then clicking the cross in the top
left of the panel can close the original group. Click More to hide
and show the custormn panels. If you close the custom panel, it will
qo back to the default, tabbed aroup.

Source: | Entire Image -
Mean: 191.08 Lewvel:
Std Dev: 28.33 Count:
Median: 197 Percentile:
Pixels: 273750 Cache Level: 4
Cuhﬁﬁwutnhnk =
' Default - U B

o You can also drag two panels away from the main tabbed
group and dock therm together. Drag one out on its own,
then drag another and position it at the bottom of the single
panel. A small blue line will appear, to indicate that the two
panels can now be docked together one above the other.

Histogram -= i ram -

Color Bwanchas = bl

F— | Entire muge

hean: .08 Lewrl:

L Std Dew: 2833 Counk:
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@ To save space while yvou are working, if vou don't reguire
the docked panels you can easily collapse them until you
need them again. Double-click on each name tab and that panel
will collapse down leaving just the name tab visilzle, Click it once
to open it again.
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Customise the
Panel Bin

As you become more proficient with the Photo Editor Expert mode, you
may find that it is preferable to switch from the Basic mode to a Custom
mode for more targeted effects and tools to suit your needs. In Custom
mode, the Panel Bin can display more than one panel at a time.

Actions
Adjustments
Color Swatches
Favorites
Histogram
History

il Info
+ ‘ E > . Navigator

Graphics  More Custom Workspace .

el

The beauty of the Custom mode, when arranging your Panel e In the Expert mode workspace, go to the small triangle
Bin, is that you can arrange the panels you use the most (to the right of the More button), on the Taskbar, at the

and dock them so you are not cluttering up your workspace and bottomn far right of the screen and click it. At the bottom of the
editing window with toco many panels, You also have the benefit meny that pops up, select Custom Workspace to activate the
of not neading to use the Menu comrmands to access them. custom mode.

Ef
more X

o When you switch to the Custom Workspace, vod'll notice o Mow in the Custom Workspace: Layers, Effects, Filters,

that the icons for: Layers, Effects, Filters, Styles and Styles and Graphics are all tabbed and docked at the top of
Graphics have been removed from the Taskbar. You can still the main Pane! Bin. To display any particular panels and access
access those panels, but the custom mode has moved them. their contents simply click each of their name tabs.

Only the More button remains in the bottom right of screen.
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o Just as in the Basic Workspace, yvou can still access other
panels by going up to the File menu, choosing Window
and then choosing which panel you want to open. You will see
that there is also the option to hide the Panel Bin or rest Panels
entirely. The More button can also be usad, as before,

CUSTOMISE THE PANEL BIN

o By clicking on the More button, you can open the floating
tabbed group containing the Info, History, Navigator,
Actions, Color Swatches and Histogram panels. From here, you
can drag either the entire group, or individual panels, onto the
bottom edge of the Panel Bin, by their name tabs.

o When you drag the floating panel group over the bottom
adge of the Panel Bin, a blue line will appear to let you
know that you can dock the floating panel to this new position.
When you let go of the mouse, the panel will appear docked to
the bottom edge of the Panel Bin.

o You can take that idea further by opening another panel
or dragging maore panels, that are currently floating, and
cock them beneath the ones yvou added previously, This means
yvou can have a Panel Bin that contains just the panels you want,
arranged how you want,

Histogram | Actions

Histogram Help i
Help Contents

Close TE" Group

Channel: | Colors v

o You can dock as many panels, under each other, as your
monitor resalution and workspace allows. This i1s a great
way to keep your Editor window free of clutter and panels you
don't need. Any tabs you want moved, to create a different order,
can be dragged into a new position or docked elsewhere.

@ Firnally, if yvou decide you want to remove one aor more of
yaur panals, you can simply click on a desired name tab to
bring that one to the front and then yvou can click on the small
Menu icon in the top right of the panel window and choose Close
to remove that single panel.
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How to Correct
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and Enhance

Using the Instant Fix option within Elements Organiser is usually enough to
save an image that is in need of adjustment. For the remainder, you may be
in need of the Photo Editor as it offers a lot more control. It is also important
to understand a photo’s inherent problems so you can correct it accordingly.

Create glass pane effects

Add a sp

i {;dl‘tﬂl’ Editor

RECENT FILES ‘

dia Sart HBy: |Hr.-'.u-|:.1 -

External Editor

Pe Photoshop

Video Editor

Photo Editor

Bl &

fix  Editor > Slideshow : Hon

o l'he Photo Editor can be accessed from the Home Screen when
viou first open up Photoshop Elements. IF yvou don't yvet know
which images yvou are likely to be working on, it is better to open
Organiser first and locate the photos in need of some attention. We
have some photos with various problems in our example.

B v 9 ¢c H E E 9

Photo Bin - Teal Oplions - Unda Aedo Rotale Layout Orgarizer Home Screen

o When you click the Editor button, it will open with the
photos you had selected in Crganiser, displayed in the
Photo Bin, ready for working on. If it isn't already, click on
the Expert mode at the top of the screen to put you in the
workspace with its more advanced toolset.
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o Highlight one or more of the images you want to work on
in the Photo Editor and then go to the Editor button down
irn the bottom left of the taskbar. There 15 a small arrow next to
It ana this opens up editing options In other programs. For this
example, just click on the main Editor button.
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mages

] T Quick  Guided
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o Depending on whether yvou've already been using the
Expert mode, for good housekeeping, go to Window >
Reset Panels to put all panels back in their default arrangements
and pasitions. If you can't find your photos, or the Photo Bin, go
down and click on the Open Fhoto Bin button, in the taskbar,
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9 To the right of the taskbar, click on the small arrow beside
the More button. From the menu that appears, choose
the Histogram option. The tabbed group of panels will appear,
with Histogram as the active panel. The histogram is a graphic

representation of the tonal values spread, from darkest to lightest.
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HOW TO CORRECT AND ENHANCE
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Mean: 131.08 Level:

S5id Dev: .31 Count;
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o Change the Channel setting by clicking on the menu and
changing it from its default of Colours to RGB. This gives a
more Ei'ﬁﬁpl:fii}d nistogram -:..“‘JiSDE'y’. If there is a small 'J.-'C'!|G'-.-".-' alert
symbol in the top right corner of the display, click on it to refresh
the histogram information.

Histogram ‘

Channel: RGB -

_ LI
Source: | Entire image ”
Mean: 14888 Lewad: 247
Std Dev: 32,90 Count: O
Median: 154 Eercentile: 100.00

Piwals: GOO00D0 Cacha Laval: 1

o Cur first, example image, has a histogram with reasonable
Image data at either end of the graph, but the large dig In
the micdle suggests areas of the tonal range where it s lacking in
midtone contrast. A lack of midtone contrast can make an image
look a bit dull, lifeless and underexposed.

Histosgram

Channel: RGB -

Source: | Entire image v|
Maan: 45.08 Levals
Sid Dav: 34,23 Coumnt:
Median: 36 Parcantila;
Pizeds: BO0DO0OO Cache Leval: 1

o The final image shows a histogram that is very biased towards
the left of the graph. This is an image where the majority of the
tonal range is made up of shadow, with very little mid-tone detail
and almast no highlights. Any image with a histogram pushed this
far to the left is very underexposad with little, visible detail.

o [he next photo in our example has practically no data at al
at either end of the histogram. There are no dark shadow
areas and no bright highlights. As a result, all the data is bunched
up in the middle of the histogram. This is an image with little
contrast, since it 1s comprised mostly of middle tones
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@ Cur three example imaages are fairly common in their
deficiencies. However, in genearal, images that are too dark,
too light and lacking in contrast are easy to put right. Now that
their particular problems have been identified, vou can set about
rectifying each of their issues and improve tham greatly.
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| evels
Adjustments

Once you understand what the Histogram is telling you, you are armed with
the necessary information to be able to make effective and dramatic changes
to the overall look and quality of your less than perfect photos. The Levels
adjustment option is a very effective way to improve an image’s tonal range.

Input Levels: i Reset

Auto

iy 4

- Preview
. ~ | B
0 1.00 255
Output Levels:
&
We have another example, which i1s a low contrast image. o In the Input Levels window, the Levels panel will show vou a
The histogram shows the tones in the photo bunched up In recreation of the histogram for that image, displaying how
the rmiddle of the graph. To access the Levels adjustment, go to the tones are distributed. Directly below the window are three
Enhance > Adjust Lighting > Levels. The Levels panel will open. sliders: the shadows slider to the left, the mid-tone slider in the
To begin with, make sure the Preview option is checked. centre and to the right, the highlights slider.

-

k ::h-i

o Manual Levels adjustment is usually based on personal
praference, although the image here clearly requires more

o Mext, click and drag the highlights slider to the left so it
touches the right edge of the graph; the lighter parts of the

contrast. To begin, click on the shadows slider and move it to image will get brighter. Continue to tweak both the shadow and
the right s0 it touches the left edge of the graph. As you do, the nighlight shiders, until you have the spread of dark and light tones
image will get progressively darker. that vou prefer.
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LEVELS ADJUSTMENTS

9 MNow you can tackle all the middle tones in the image.

Click on the mid-tone slider and drag it either to the left to
brighten all the middle tones, or to the right to darken them. A
small amount will make a significant difference, so be subtle with
Vvaur inputs.

Cancel
Histogram Channel: | RGB  ~ | '
Channel: RGB - input Levels: q Reset
Auto
‘ o - @ Preview
61 0.72 183
Source: | Entire Image v i ke

o After some tweaking of all three sliders, the image now
has a lot more contrast and is a fairer representation of the
original scene, at the time of capture. The muddy low-contrast
image is now stronger with more saturated colours, as a result,

o If vou look at the Histogram panel, you will see that it shows
the original histogram display, along with the new adjusted
varsion overlaid, so you can see the difference. Now the graph
has a more even distribution of tones from shadow to highlight
rather than being bunched in the middle.

Set Black Point

o The Set Black Point evedropper lets yvou click anywhere

on your photo and whatever tone is beneath it, becomes
the darkest part of the photo. Watch out as this can make your
image far too dark, The Set White Point works in a similar way,
any part of the image vou click on becomes the brightest part.

o Although the Levels panel has an Auto button, to make a
best guess at how to adjust the image, it is always preferable
to get hands on, as you can get a feel for the changes you are
making and see the results of your own input. You also have the
option to use the Set Black Point and Set White Point eyvedroppers.

Histogram

MMM@

A N . i

Source:

Entire Image

@ Take into consideration that as yvou make adjustments, vou
run the risk of degrading the image. Any edits will affect it
to some degree, so watch your histogram as yvou edit, the more
gaps appearing in your graph, the more image quality is being
affected and data lost.
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Q)

How to Use
Colour Balance

Although modern cameras and smartphones have good image quality,
even the best device can be fooled by tricky lighting conditions and deliver
a photo that has an unwanted colour cast on it, making it too blue, or too
vellow in the case of tungsten lighting conditions.

QOur example image was taken with some lights that
produce a very yvellow colour cast. The camera that took

e We are going to use the Quick edit mode on the Elements
Photo Editor. If it isn't already in Quick mode, click on the

the photo was set on auto white balance, but even this was mode selector at the top of the screen. To clean up the Quick
not enough to offset the yellow tint (typical of indoor tungsten edit workspace, in case there are any panels floating around, go
lighting, cast over the scene. to Windows > Reset Panals.

i. Adobe Photoshop Elements 2019 Editor File Edit Image Enh. F

Open ~ Before Only
Before & After - Horizontal
« Before & After - Vertfical

Smart Fix b

HE KB
E

Lighting x
Color ¥

A
Adjustments Effects _—

o To modify the colour balance, first open up vour image, It o If it isn't already active, go to the bottom right of the

helps to assess what you're doing so in the top left of your taskbar and click on the Adjustments button. The various

screen, click on the View button. Here you can select a Before & adjustment options availakble are displayed in the panel on the

After - Vertical view, so you can see the effects of your choices. right of the screen. Since our example image has an issue with
poth colour balance and tint, we need to use the Balance options.
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Temperature

9 Click on the Balance button and it expands to show you the
Temperature and Tint tabs. These two controls can help you
get your image closer to how it would look, if the colour cast of
the lighting had been compensated for at the time of shooting.
Beaain with Temperature.

mﬂalﬂlﬂe

—— -

o Ohkwviously, the variants at the extremities may prove too much
for this image, so it's simply a case of rolling over each ocne

to see the result. One or two thumbnail options towards the cooler
end of the variations may be enough. Failing that, for more subtle
cantrol, you can use the slider directly above, or enter a value.

o Here, it s apparent that the image is very slightly too green.
To help offset this, you can compensate by choosing a
more magenta thumbnail. One click toward magenta may prove
too much, s, as with the Temperature adjustment, you can use
the Tint slider instead. In this case, a value of 12 was enough.

HOW TO USE COLOUR BALANCE

o Temperature adjustment is represented by a grid of nine
thurmbnails with your original in the cantre to provide a
reset, if yvou want it. Around it are variations making the image
either cooler in tone or warmer. When you click on a variation
option, it appears highlighted by a blue frame.

o With the Temperature adjusted towards the cooler end,
the image is lcoking a little more neutral than it did. MNext,
vou can click on the Tint tab and use the thumbnail previews to
add more green or magenta to your image, to help remove more
colour cast,

Higtogram

Source: | Entira Image

Sowrce: | Entire Imaga -
Mean: 113.73 Mean: 119.29 Lewvel:
5td Dev: 5738 Count: 5td Dev: 51.58 Count:
Median: 104 Percentila: Medan: 125 Farcantie:

Pigeds: SOMO0O00 Cache Level: 1 Pigels: &000000 Cachea Lavel: 1

@ 5o to Expert mode and call up the Histogram panel, from
here you can compare the before and after effects of yvour
adjustments. At first, there is marked separation of the three
colours making up the image. Once the adjustments are made, the
colours show much less separation. It's not perfect, but it is better.
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Q)

Enhancing
Colour

The Guided edit mode offers ways to affect the colour of your photos. There
are creative colour options such as Lomo Camera Effect, plus a couple of
more technical options for more standard and technical correction of colour
cast in your photos. We will have a look at a more technical approach.

Black & White Fun Edits

ENHANCE COLOR

Fine-tune and enhance the colors in your Easily give
photo., heavily sa

o As you've seen, you can remove a colour cast using the
Quick edit mode's Balance functions. Now compare that

9 The Enhance Color effect can be found under Guided edits
and by clicking on the Colcr category selector. There are

to what you can achieve using the Guided edit modeas, Although several colour effects listed here, but Enhance Color allows yvou
there is a remove Color Cast guided option, in this case, we will to work with a broader set of colour correction options, enabling
look at the Enhance Color option in more detail. yvou to do more with your images.

de O T = @] : : s
D heeds . k) @ Adobe Photoshop Elements 2019 Editor File E

- | After Only

. Before Only
(7o« Before & After - Horizontal
Before & After - Vertical '

Open
Q

pq bird.jpg bottles 2.jpg bo

«

o I our example, we clicked the Open button in the top left o Launch the Enhance Color guided edit and in the View menu
of the screen and navigated to a folder that contains an in the top left bar, above your edit panel, choose the Befora

image of glassware that has a definite colour cast. Select your & After - Horizontal option, so yvou can monitor the effect you are

image and click Open to send it to the Photo Bin ready for the naving on the photo. In the file menu, you can also choose View >

Guided edit to be applied. Fit On Screen or zoom in and out for the best view.
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ENHANCING COLOUR

\ Before & After - Horiz

Use the sliders below to fine tune the
adjustrrent.

Zaom Tool (2)

Hue : e re—
Saturation : em— —
Lightriess :  emmmmm— ——

When using this Guided edit moade, you only hawve two tools o Your first available option is the Auto Fix button. Clicking
in the toolbar on the left of the screen: the Zoom Tool for this will automatically attempt to fix both colour and

zooming in and the Hand Tool for moving the image around. All contrast in the photo. One click will make an improverment and
the other tools you require are in the main panel on the right remove some of the colour cast, but you can actually choose to
hand side of the screen. click Auto Fix several more times for continuad enhancement.

Use the sliders below to fine tune the
adjustment.

Hue :
Saturation :
Lightness :
o EBelow the Autc Fix button, vou are presented with three o If vou move the Hue Slider to the left, colours are shifted
sliders, which you can use to add further fine-tuned through the spectrum. Yellow becomes red, Turguoise turns
adjustments to the Hue, Saturation and Lightness of your photo. green, blue shifts to turguoise and red becomes purple. In this
Start by clicking and dragging the Hue slider to experiment with case, small shifts of the three sliders are enough, but it could still
how it shifts colours. do with a little more punch.

Show Open Files —

Independently adjust the
and mid-tones of hy
perfect exposure.

A

Photo Bin - Tool Options

2
Undc

e rm T

o Click Mext in the lower right and then click Dorne. Go to @ In our example, the Highlights slider is fine at its default,
the Basics category and choose Lighten and Darken as but pushing the Shadows anad Miatones sliders to the right,
vour Guided edit. We will forego the Auto Fix option here and creates a lot more contrast. You can experiment with vour own
just concentrate on the three sliders that you can use to contro images until you have something that suits your taste. Then you

Shadows, Highlights and Midtones. can click Done and Save yvour image.
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Q)

Quickly Resize &=
Your Photos

Odd as it may seem, resizing photos is hot something people generally
have to worry about, particularly when submitting images to social media
sites since automatic processes normally do the work for you. If, however,
you need to meet a very specific size requirement, then read on.

@ Adobe Photoshop El | i R -

Dg man-815785.jpg man-34
2(

Expert

Black & White Fun Edits Specia i

{r

8, VRK.

o Open up the Elements Photo Editor and click on the e Before you start, in the top, far left corner of the Guide
mode selector panel at the top of the screen, then choose workspace, click on the Open button {not the small arrow
Guided. This switches you to the Guided edit mode. Before next to it). This opens up a browser window where you can
starting, vou will need a photo that requires some specific sizing navigate to the image you need to resize. When you have It,
and scaling. double-click or click it and then click on the Open button,

Show Open Files -

After (Roll over to see Before.)

Resize your photos for Web or Print.

1. Select an output option.

Easlly resize your pho printing or
by the vk,
‘ \ L i . |
@ ; i ..':', : ..-F‘
— . Web Fs
Photo Bin - Tool Options - Undg g R o
o The chosen phote will now appear in the Phote Bin of the o Listed in the panel, on the right of the screen, are the steps
Guided adits workspace. The Resize Your Pholto guided neaded to resize the photo. The first choice you need to
edit can be found in the Basics category. Click its preview anc malke is whether your image is intended for YWeb or Print usage.
it will launch the resize editor using the photo currently in the Qur example is intended for use on the web, but it is a large SMB
Fhoto Bin. file that's nearly 6000 pixels on the long adge.
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QUICKLY RESIZE YOUR PHOTOS

\

Print

Web

2. Select a size option

Short Edge X
Width & Height 2 | px

File Size

3. Click Apply to apply the changes to your
photo.

9 Since we want to reduce the size of the image significantly

o Cur example had its Long Edge reduced from 5981 pixels
for Internet use. click on Web. Under Select A Size, you can

widle to 800 pixels wide. IF you choose Width and Height,

choose from a number of options to suit your preference. Mow you can then specify these measurements to create a cropped
vou can specify, in pixels, what the target size of either the long box, within which you can move the preview image by clicking
or short edae of the photo is going to be, and dragqing it, until yvou have a crop that vou like.
Resize Your Photo
What would you like to do next? Save As: _mudﬂ_adm 2 4_],,.9__ @ ‘
Save: Tags:

. Web Print

- § Shared Folder « o8 @ SicE on
Continue Editing: B8x10in v

| B [ |

In Quick InBxpert W :| 10,0 |in |:| H:| g0 |in
BOch4bBadb&Bal beard-
Shrink to Fit

Share: IPEG

o When you have your preferred crop, you can click the Next o If you reset the Resize Your Photo procedure and choose
button and choose vour Save, Save As or Continue Editing Print, as yvour Output Option, yvou're presented with some

options in ether the Quick mode or Expert mode. Any image similar size options, along with some typical print sizes such as
you choose to Save As, will be saved with an ‘edited-1" extension, 2x10". Choosing one of these will give you the option to check
to tell it apart from your ariginal image. the Shrink To Fit button.

{ Setect Prirar
HF Dgkled D500 saries =

i) Select Paper Sae:
A4 -

b Sabeest Prive Sira:
schynl Suow [I540cm ., =

| |orep sa R
e[t [= coples
L3
:‘J I:-:'- I=pge Ty B e
i 1k i
o Shrink To Bt will make sure the entire image is smal @ Unlike the Web output aption, when yvou click an the Naxt
enough to fit in the 8x10" print size, while still maintaining button to access the Save or Continue Editing options,

its original proportions. In doing so, you may find that there are vwou also have the Print option dialog box available, where wou
some white spaces either side of the image, Be aware that these can print out yvour resized Ex10" image onto the paper size of
will be saved as part of the actual photo. YOouUr choice.,
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Selecting Fine

Q)

This tutorial
content is
available for
download

Fage Detall

In many respects, making complex selections is time-consuming and tedious.
This is particularly true if you are trying to make a selection of some very fine
detail, such as hair or fur. Using a Lasso, or even the Quick Selection tools, will
prove difficult and this is where the Refine Selection Brush can help.

o We have an example image of a dog that we would like
to cut out of its background and either use it 1sclated as it
stands, or dropped into another background. When it comes to
selecting and cutting out, fur, hair, grass and foliage make for a
testing time.

—
’I o H‘ e Launch editnr wnrkspace fur ‘detalled edits-

e We can open the image of the dog from either; the
Elements Organiser workspace, by selecting it and then
clicking on the Editor button down in the taskbar, or we can go
straight to the Photo Editor and choose Cpen in the top left of
the workspace, or File = Open from the file menu.

: ¥ Resize Windows To Fit
: | Zoom All Windows :
= p— e ) - s —r
@ : | t ! - | - ..l-- |j:| . : il | -
Photo Bin “Tool Options®  Undo Redo  Rotate Layout O pol Options-  Undo  Redo

o If it isn't already active, we can go down to the taskbar and
n the lower left corner, click an the Tool Options button.
Mow, whatever tool we choose from the main toolbar on the left
side of the screen, will display its availlable options in the Too
Options panel.
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o We begin this example by choosing the Quick Selaection
Taal (A) from the toolbar. In the Tools Options panel below,
we will see a number of other available tools and settings. We
will need these to help the process of selecting the dog's fur
more accurately.




- 3

e e e

o We'll make the Size of yvour Quick Selection Brush about 60
pixels and then move tha cursor onto the image of the dog,
near the edges of its fur, Now we click and slowly begin to drag
the cursor around the inside edge of the dog. The selection will
grow bit by bit as it moves.

i
i
i}

o
|

g

- |-. mmmm e

# 5 ¢

o After clicking on the Refine Edge Selection Brush in the
Tool Options panel, any part of the image outside the edge
of the Quick Selection will appear in red. We'll make the Size 500
px and Snap Strength and Selection Edge to their maximums
Then push the View Opacity to 100%, to make it solid red.

We drag the Edit Selection Edae brush around the edge

of the dog, making sure to paint any areas of the fur edge
that need to be more refined. If necessary, we'll go back over
any areas to make sure we have all the fur edges painted, before
latting go of the mouse button.

SELECTING FINE EDGE DETAIL

o n g 4 =]
'\IF.fII. I-'.!-'.': I

- ¥

L

P
amn

o If the selection goes wrong and we choose too much of the
background, we can press Cmd + £ to undo one step ana
try again, keeping the cursor further away from the fur's edage. It
doesn't need to be a super-accurate selection at this point. Once
we have the whole dog selected, we can proceed.

o Carefully hover the cursar over the edge of the selection
where It turns red and the cursor should change from the
larger Add Selection cursor to the Edit Selection Edge brush.
Once we see this, clicking and holding the mouse button will
activate it. Now we can start to move the cursor.

Layar Vi Copy

@ The edge selection will be refined, so now we'll click on any
selection tool, such as the Lasso, then right-click the dog.
After choosing Layer Via Copy to create a new layer that contains
just the dog, we can turn the Background layer off. We can save
this file as a PSD and place a new background behind it if we want.
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QY

Cleaning
a Scene

For anyone out taking photos on holiday or sightseeing, it can often be a
frustrating scenario when you want to capture a scene, but it is always filled
with cars or people meaning you never get a clean, empty shot. Thanks to the
Photomerge option, you can remove any unwanted guests from your photo.

SELLE
1M FETY 151
ey | i — i P [

If vou are trying to capture a scene that is always busy,
nere's a great photographer's tip. Set up your camera on

o We have an example street scena that demonstrates the
principle. It was never quite clear of people, but several shots

a tripod and shoot a sequence of iImages wheare people are in wiere taken and loaded into Elernents Organiser. The best three
many different positions in each shot. This can be used to vour shots, which offered the most varied positicns of people, were
advantage later. chosen as the most useful in aiding our scene-cleaning attempt.,

Photomerg:

Show Open Files

i — "
e - e |
:

v Photo Bin - Tool Options- Ul Easily remove moving objects, like cars, from
o Highlight the imagses you are going to use and then click o The images are named remove 1, remove 2 and remove Z
the Editor button, down in the taskbar. The Photo Editor Click on the Guided mode selactor at the top of the screen
will open and the selected images (three in our example) will and then choose Photomerge from the list of guided edits below.
appear down in the Photo Bin. If the Photo Bin isn't visible, click The one we are going to use is the Photomerge Scene Cleaner.
the Photo Bin button and it will appear. Click its preview, to open it up.
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_Adobe Photoshop Elements
Select (Command + Click) 2 to 10 photos in

the Photo Bin and then click Photomerge
Scena Cleaner again or Salect Open All.

Cancel m)

- @ D

Undo Redo  Rotate Organizer Home Screen

-, > c

Phato Bin -

CLEANING A SCENE

9 You may be prompted to choose photos, or just click
Cpen All to continue. For clarity, our three images are now
highlighted from left to right as blue, vellow and green. Drag one
photo (green in our example) onto the grey Final base image
panel, on the right.

o There are thres sets of people we need to remaove from the
Firal green image. Click on the blue image in the photo bin,
to make that the Source image in the left hand panel. Choose the
Pencil Tool, choose a Size and then paint diagonally over the first
couple in the centre of the right-hand Final image.

o This action selects the corresponding area in the blue
image and pastes it over the same spot In the Final image
on the right. Since the blue image had nobody in that spot, the
couple in the Final image are removed. Do the same with the
maore distant couple on the right of the Final image.

EAIEIFEEE]

o Mow draw a diagonal line that covers the far right couple
on the Final image and the clean portion of the yvellow
image will be pasted on the green Final image. The last couple
from the street scene are removed. You can use the Eraser Tool
to remove portions of the pencil strokes, iIf needed.

o Mow we need to remove the last couple from the very far

right of the Final shot. Click on the yvellow image, to make

that the new Source, in the left-hand panel. You will see the two
Pencil Tool marks you've already used, marked in blue, overlaid

on the yellow image for guidance,

@ If wvou should require it, there is an Advanced Qptions tab
voau can click to help you align your photos, if they weren't
taken on a tripod. You can click the same feature in different
photos to be used as alignment guides. Then you can click Next

and choose to Save or Continue Editing.
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The Artwork

| ibrary

Photoshop is much more than just a photo editor for improving a photo’s
brightness, contrast and saturation. If you dig a little further, you will see
that it can also double as a creative and versatile design tool to aid you in

the creation of amazing art projects.

i y F R 1 1 1 :'-.Ir-l#-f: ! l-.[:.l =
i | 3 = ,E';IE!E'_I,!.- j:l'
1 " n;':‘l-q e"_u;.."-.._"'h-.;'r i
| y s Shboh S
f i i Tk TR ToR Tl
0% Ak ik
WHR L i ___..'".l'f__'ﬁ;;-'_; l"?:
w Bl =
N N f T b
. .
. ‘5‘

File | Edit

Find View Help

elect f‘;
Delete Selected Items from Catalog...

Rotate Selected Photos 90° Left
Rotate Selected Photos 90° Right

Edit with Photoshop Elements Editor...
Edit with Premiere Elements Editor...

o The Elements Photo Editor provides you with a large and
varied collection of effects, textures, shapes and frames
that can be accessed either through the Create function, or in
the Guick or Expert edit modes. In this example, we will open the
Export edit mode and take a look at the Graphics panel.

9 Starting in Elements Organiser, you need to check that you
have no images highlighted before opening the Editor. To
pe sure, go to the file menu and choose Edit = Deaselect. You can
also use Cmd + Shift + A on a Mac, or Ctrl + Shift + A ona PC, to
deflect all images,

* % % * %
10/1/2018 10:55

g hong-kong-1990268.jpg

F B o
imm Fix Editor - Slideshow - |

| Actions
Adjustments
Color Swatches
Favorites
Histogram
History

E_ Info
Navigator

Layers | Effects

Filters [ Si

Sl g ¥ ?i', ‘e’

=
feee
-

Normal i |

o Click on the Editor button down in the taskbar, to open

up the Photo Editor, then use the picker at the top of the
screen to choose Expert mode. If vou've previously been working
in the Editor and moved your panel layouts around, you can go

to Window > Heset Panels to put it back to its default layout.
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o Mow, click on the small arrow next to the Maore button in the
bottom right of the taskbar and choose Custom Workspace
from the menu that appears. The Layers, Effects, Filters, Styles
and Graphics buttons will be moved to the top of the Panel Bin,
in tabbed groups.




THE ARTWORK LIBRARY

Create ~ Share ~ Create ~ Share ~
yles | Craphics k. i Graphics Help =
. Graphics | ] Help Contents
Opacity: | |~ || | Small Thumbnail View

Medium Thumbnail View

/ Large Thumbnail View -

Add Frame
Close
Close Tab Group

] ¥

» don !"ap"ﬁ ol

9 For example, click on the Graphics tab to bring it to the
front. For a better look at the available graphic items, go to
the small menu ican, in the top right of the Panel Bin, click it and
chose Large Thumbnail View from the menu. You can also widen
the Panel Bin by dragging its left ecdge outwards.

Create ~ Share -~
Layers | Effects | Filters | Styles | Graphics =
I_By Type ~ | Backgroun... ~ |
b | ~
. b | ™
45 ! "

Below the set of Panel Bin tabs, vou will see two menus.
These allow yvou to sort what is displayed by choosing a
category from each menu. The first is a broad setting that filters
by certain categories, such as Type, Color, Event and Mood. The
second lets yvou choose from context sensitive lists for each choice,

Autumn
Spring
Luyers | E Summer
By Seas... ¥
 Show All |
b | - i
5 ; ?J.I.-
Q e . | Dfanga __-.fil.l
| 2 | Pastel . : ‘i%
W .‘- " pink rll.'l :I‘l'
b Purple
Red

o You can use these two sorting menus to view the available
content in any number of permutations. If, in the first menu,
vou choose By Colour, yvou can then select a context sensitive list
of colour choices from the second menu. Choose By Season and
the second menu displays the four seasons to filter your search,

Graphics

L
£
>

o Your other chaice, for displaying Graphics content, is to
click on the Show All option in the first menu. When you
do this, all the content currently stored on your machine will be
indexed in one long list. To be able to view all the content, you'll
need to drag the scrollbar to the right of the Fanel Bin.

Create ~ Share ~
Layers | Effects | Filters | Styles | Graphics =
_ByWord ~ |[bun Fi
Show All v |
\A 225
SeC i
AT\ J53%
RHIvd KN W,

o If yvou choose By Word then in the second menu, instead
of a list, you are presented with a text entry box where you
can type in your own s2arch word and then click Find to see
what is available, based on the word you tyvped in. For example,
type in 'sun’ and any item matching will be displayed.

Layers | Effects | Filters

Blur

Brush Strokes
Distort

MNoise

Film Grain

|
. o |

Dry Brush

@ The other tabs behave slightly differently, as they have only
one menu. Filters, for example, lets yvou choose from (and
view) a single category at one time, or yvou can choose the Show
All option to list all the Filters available in one go, as you did with
the Graphics panel.
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The Favourites
Panel

Having explored the contents of the artwork library, you would be forgiven
for feeling a little overwhelmed by the huge number of graphics, textures and
backgrounds available. However, with a little bit of thought and time, you can
select a group of favourite artwork items and set up a Favourites panel.

ew Window Help

Images

v Tools

Actions
Adjustments
Color Swatches
Effects F2
Favorites
Filters

v Graphics
Histogram

R i o s

u" ]_‘(' 1
Basic Blac... Basic Whi... Circular Vi...

o Open the Editar, go to the file menu and select Window =
Favorites. When a floating tabbed panel group appears,
vou can drag the Favorites tab off the main group to isolate it
and close down the other GQroup of tabs. Drag the Favorites panel
to the lower right of the screen, next to the Fanel Bin.

b b

o

Favorites

9 Click the Favorites tab and drag it over the lower edge of
the Panel Bin. You will see a blue line appear indicating you
can dock the Favorites panel beneath the Graphics panel list.
Click the top edge of the Favorites panel and drag it upwards to
enlarge the panel window.

bage |

Favorites b —

Remave from Favorites -

Details...

Ermlaf' I Soft Edge

# —

1

o You will see that the Favorites panel already contains a

few basic examples. For a clean slate, click on each of the
samples in turn to highlight it, then click on the trash can icon in
the top right of the Favorites panel header bar. You can also right
click each sample and choose, Remove From Favorites.
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Create ~ Share -~
Effects | Filters | Styles | Graphics =
 ||wood | Find
———— . _
! '_HL.J-;_
- -
N

o Mow you can begin the process of choosing your favourite
graphics itermns. If, for example, you are looking far wood
graphics, you can set the first menu to By Word and then enter
the word "wood' into the text field and click Find. From the Filter
menu below, choose the Show All option.




Create ~ Share ~

Styles

Graphics =

Find

9 Any graphic itermn that has "'wood' as one of its kevwords will

be displayaed as a match, in the paneal below. If you require

a specific graphic item, instead of Show All, choose one of the
other cptions such as Frames and then only frame graphics that
match will be displayed.

Create ~ Share ~
Graphics =
v Backgrounds
b ‘ b
3 .fl
':"- '._. '

— | g

Favorites -

N [ %
P> s
Wood An...

o Click on one of the items you want and drag it down onto
vour Favorites panel That graphic item will then be added to
vour Favourites panel, you can continue to drag down more items.
You can change your search parameters at any time to find other
iterms that you want.

By Object = | Flower b

Shapes >

Favorites

{Jﬁ-‘:

@ &
oK

II i

o Replace the word 'wood' with ‘paper’ and click Find. Then
change the Filter menu option to Backgrounds and any
bhackground items with paper, as a match, will be displayed.
Mow you can drag down your preferred selections of paper
background to go with your wooden frame graphics.

o Change your top two menu options to By Object and
Flower then select Shapes as your Filter listing and a series
of black and white flower graphics will be displayed. As with the
previous steps, you can drag across any that you want to use
regularly, or for a particular project.

LI'HII'I | Effects I Filmers I E'I]ﬂll i Gl’lﬂr Favarites &
 Vintage '_.' -
b | & | . | -’- H-E
— - Adobe Photoshop Elements
— ] Downloading Content: 0% Complete
: Grey Chev... Ruled Paper Wood An... led rl Wood An.. a
kS > ; ~
% -
.I L.\_ * ¥
Flower 25 Handmad... " e
wer25 Handmad..  High

o You are not limited to dragging favourites from the Graphics
pangl alona. The Effects and Styles panels can also be

searched by a particular type, or by clicking Show All and the results

can be dragged down onto the Favorites pangl. Be aware, anything
from the Filters panel cannot be dragged onto the Favorites panel.

@ The Graphics library only contains a small number of
installed items, but many more are available. If a swatch
has a small blue arrow in its top right corner, this indicates it
Is an online asset. You can place it in a project and it will be
cdownloaded on demand and stored in yvour library,
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How to Make
a Photo Book

The option to create a printed Photo Book is found under the Create menu
in the top right of the Organiser and Photo editor screens, next to the Share
button. The techniques and skills you'll be learning are applicable to the
other options in the menu, so let's find out how to make one.

Create ~ Share -~

Ratings = # & % # # [ |Auto Curate

W Tags

¥ Keywords

[] @ Nature
[ @ Color
[] @ Photography

o Information

+'

* * T *
10/1/2018 10:52
scotland-1761292.jpg

T % % *
10/1/2018 10:54
boat-house-192990.jpg

o In our example, we are going to make a Photo Book of
some of our favourite landscape photos. The process starts
by opening up the Elerments Organiser and choosing a number
of likely candidates for the book. We have a folder of 45 possible
landscapes photos ready for inclusion,

Share -~

Ratings 2| 5q)| slideshow M€

r_“ *
W 5 rhow Collage Fon
] .

[: H=N Photo Primts
E - Photo Book

Create -~

T

[2-°  Greeting Card

o When you have yvour selection of photos ready, go to the top
eft of the Media Browser and click on the Create button. A
menu will appear with all the various options available. Click on
the Photo Book option and the Photo Editor, which will be used to
make the Photo Book, will be opened up automatically.
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9 Depending on how many pages your book is intended to
be, vou may not want all the photos to be included. If that
is the case, vou can simply highlight the ones you are likely to use
when constructing the bock. Press Cmd and click on each photo
yvou want to use. If you want them all, press Cmd + A to select all.

Heztn. Al phofe SO0kE can be i on your Seging primiesn,

B featst it Srketod brege [27] momber ot Pages

o Once the Photo Editor has opened, the Photo Book creator
will open. The first panel on the left shows vou the available
zize it can print that matches your locally installed printer, Click
on one of the Size options. We chose the 12.00 x 12.00 inches
option, for a square format.




MNote: All photo books can be printed on your desktop printer.

q.ﬂ;utuﬂll with Selected Images 2 | Num

9 At the bottom left of the screen, is the Autofill With
Selected Image checkbox. Make sure this is unchecked;
otherwise, your book will be automatically and randomly filled
with your images before you've had a chance to use your own
input as to placement and compaositicn.

10 L L

A

|

ed on your desktop printer.

8 | Number Of Pages

o Directly below the Themes panel s the Numioer Of Pages
box. Click on this and type in how many pages you woulg
like to form yvour book. For example, if you type 8, it will create an
eight-page document, plus a title page. Click OK and the assets for
this theme will be downloaded, if vou haven't used them before,

+ Show Files selected in Organizer

M vy S5 ¢c B 9

Photo Bin ‘Tool Options: Undo Redo

Organizer Home Screer

o If wour selection of images chosen within Elements Organiser
are not visible, click en the Photo Bin button in the lower

left of the taskbar to make them visible, Now you have the basic
components you need to assemble your Photo Book, Before you do,
you can make changes if yvou wish.

HOW TO MAKE A PHOTO BOOK

Themes Preview

el

o Mext to the Sizes panel is the Themes panel. This contains
a number of styles you can use for your Photo Book. |t vou
click on each one, it displays a preview of the results for that
particular theme. We opted for the Monochrome theme, as it was
simple and bold.

Click here to add photo
or
Drag photo here

il - e — . EEECE
& — .
m T W s 5|
- — -

o
regpee

o Cince the artwork assets have been downloaded, the book
will be assembled. It will preview the Title Page as well as
shiow you the page layouts in the right hand paneal. Since the
Autofill option was deselected, the picture boxes are all Currantly
blank and awaiting images to be dragged onto them manually

@ When vou choose a Theme, it creates the Photo Boolk: it

is done automatically and generates random layouts with
each page of the book having a varying number of picture boxes,
at different sizes and in different numbers. If you review the
layouts and want to change them, you can.
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_ | B |
S Three Photos v
. T
| ke —
O BB + A bd | A™ &d
Pages LayEL_rts Graphics _ :

0 Having reviewed the previews, we decided that page & Tr*r—*- right hand panel will display a number of layvou Jl'.-: Wi
needed to be altered, since the arrangement of three smal t_ur- apply to page 5 to change the design. There are: the
Images was Not going o be very II’T"IIDEH tful for our lands oape Different Layouts options for multiple mages and text, I'H"r 2 |5 the
images. If yvou look down in the lower right of the ’r,-r:.thar there is Jne Photo layout choices and finally the Three Photos and Two

a button marked Lavouts. Click this to view alternate page layouts., Photos layouts.

4 &

Adobe Photoshop Eler

2 Click

Downloading Content: 0%

Click here o add photo Click here to add phote i Py T

(LR T =L VIR g e

‘- [ ] ar ! o L
. Dirag phota hers Drag phato here e

@ Choose a layvout you would like to try, then -r'u’L: and drag ® For our example, we chose a simple two-photo layout

that option before dropping it onto page 5. Note that any with text, clicked it and dragged it across to Lhe page we
layout design that has a small blue triangle in its top right corner wanted to alter. You will see a progress bar as it takes affect and
Indicates that it i1s an onling asset, Once you drag it over to your then the new one will appear on page 5. If you don't like it you
page, It will be downloaded automatically. can press Cmd + 7 to undo, or try another I.:n.m It from the list,

Click fere W o=
ar

Drag photo Nere

Drag

Photobook Title Here Photobook Title Here

Your Text Hare Your Text Hare

@ Click on the Pages button to go back to vour preview, Your @ Mow vou can continue the F:-F-““'-I—:-ES by adding your images to
choices for amending your page layouts don't end there. For the blank picture boxes. Make sure your Phota Bin is visible
example, on page 4, yvou can actually click and drag each picture and start adding photos. Drag cne :I"Iut » at a time from the Photo
box to a new position and by using the carner control points, scale Bin and drop in onto vour picture boxes, Be aware, if yvou click a
the box or rotate it to make a number of custom page layouts. photo but don't hold and drag, it will cpen up in its own window.

152 BDM's Independent Manual Series | Volume 19




B —0—

t

@ Each photo that is dropped into a picture box, will display a
small contral panel that lets you: rotate it left or right. alter
the size of the image within the picture box or replace it with
another image. You can also click and drag the photo to move its
position within the box.

@ Your Text Here
"

Horizontal Type Tool (T)

@ [he title page and page 5 both contain text, which vou
can alter. In the left hand toolkar, click on the Horizontal
Type Tool; the Photo Bin will be replaced with the Type Options
Panel. To start, take your type cursor and double-click on the
Photobook Title Here text, to activate it

B
P —

@ Continue to drag and drop vour photos into their respective
picture boxes, if vou have a photo in the wrong box, you can
simply drag and drop the correct one over the top and it will be
replaced automatically. Once you have it looking how you want,
return to the title page.

o E
- CEEE

¥ EEEE
B[

Type - Horizontal

1T | Myriad Pro Light Condensed m -m B J] U
: :Ln-;:;m Condensad | - | Size: (18pt | v | .: = =

Leading:  {Auto) E| Tracking: o ‘3

| !?|g - -

‘Tool Options’  Undo Redo

[ . o
ﬁ nl K
Organizer Home Screen  Print

@ The text will be highlighted and yvou can type in a new fitle.
Couble-click it again and you can go to the search fonts
menu and, iIf you wish, choose a new font. You can also change
Its size or colour and even warp the text. Alter the sule-Title and
vou can move on and edit the other text in the bock.

3
5
[T

@ If the running order of the spreads is not auite right, yvou can
alter that too. In this example, we decided that page 7 and 8
should be in front of the current page 5 and 6. Swapping the two
spreads 15 simple; click and drag 7 and 8 in the preview so it sits
above the current page 5 and & and it will be inserted there.

pam BDM)
ersonal) @
HD
photo book 1.pse
Format: Photo Project Format
Save: As a Copy
Layers
Organize: Include in the Elements Organizer

@ Your first Photo Book is complete. Go to File > Save As

and navigate to a folder where yvou would like to save your
project. You'll notice that it will be saved in a PSE Photo Project
Format, Give it a name and make sure both Layers and Include In
The Elements Organiser are checkad,
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Photo Book
Advanced Mode

Having created a Photo Book and saved the document, you can try a more
advanced tweak that will pep up yvour book's backgrounds. To do this you use
the Photo Book Advanced Mode. Essentially this opens your spreads in Expert
mode in the Photo Editor and you can access the layers that make up the book.

@ Adobe Photoshop E

iE v photo books -

Shared Folder

&

photo book 1.pse

| Advanced Mode

o Start by going to File > Open and navigating to your saved,

o Click on the Advance Mode button, situated in the top
PSE Photo Book artworlk, Double-click it to open the Photo

left corner of the edit window next to the toolbar. When

Editor. You will see the Mode Selector buttons at the top of the vou click it, vour pages becorme editable anda if yvou lock at the
screen but if you click them, nothing will happen until yvou first pottom right of the taskbar, yvou will see that a Layers button has
activate the Advanced Made. appeared, next to the Pages button.

™ E@ _DZMonochrome 011

I frame
| .. _DIP- )

o Click the Lavers buttan and all the layers, masks and text
that were automatically created for the Photo Book's title

® I T TEXTLT@$$ $/layouts/Squ...

S B Background,”
|

o Mow that we are in Advanced Maode, it 15 possible to edit
the Background file and replace it If yvou want to insert a

page, will be displayed in the Layers Panel Bin. The layer we new graphic background, go to the taskbar in the lower right
want to concentrate on is the bottom Background layer, which is and click on the Graphics button. When you deg, all the available
currently a black Smart Object. Graphics will be listed in the Graphics Fanel Bin.
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9 Scroll down and choose whatever element vou would like to o If it neads to be downloaded, vou will see a download
use as a replacement for the black background. Remember progress bar and then the graphic you chose will appear

that if an item has a blue triangle in the corner, It Is an online asset as the new DEJCHQ'“CLJ"Wd imagc. LIy e:-;am;:lc Uses g3 BHCHQFGUI"IQ
and will need to be downloaded first. Drag your choice across and called Dark Brown Sille. You can drag/double-click any number of
cdrop it onto the black background, or double-cliclk it. graphic items to try them out, until vou have the one vou like.
L 8 vl _TxTRame : Flle Edit Image Enhance Layer
= { Maw [
@ § v _TXTFrame . Open.., *0
4 T TEXTLT@ES S layouls/s Open in Camera Raw... “¥O
Open Recently Edited File |

Llose

File Info...

Background 3 Organize Cipen Files...
4 Frocess Multiple Files...
import

o Click on the Layers button. The layer that originally contained o Go to Pages, choose another spread and then click back
the Background has been replaced by yvour choice of on Lavers to view all the layers making up that spread. You

graphic. If vou add a Levels adjustrment layer above it vou can can also add your own images to use as background if you want.
rmake it darker or lighter to suit your taste. Add a Hue/Saturation Make sure the Background layer is active and go to File > Place.
adjustment above that and you can alsc change its colour. Find an appropriate file, select it, then click Place.

o Your chosen image will be placed an a naw laver above the @ With the photo now in place, you can add adjustment
Background. The placead file will have control points around its layers above it to alter its look to whatever you like. In
edges that yvou can click and drag to scale and move it. Use these our example, a Hue/Saturation layer was added to de-saturate

points to scale the image until it fills the entire double page spread. the colour and make it lighter. Once you have added other
backgrounds, If required, yvou're ready to print vour book.




Take
Your SKkills
Further

Now that you've experienced what Elements has to offer
and how the major tools work, it's time to try out some more
involved projects to help you hone your skills. The Quick and
Guided workspaces are all well and good, but if you really
want to understand more about digital manipulation then it's
time to fire up the Expert workspace and dive in. There's an
old saying: 'the best way to learn, is to do'. With that in mind,

let's do it!
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TAKE YOUR SKILLS FURTHER

This tutorial
content is

available for
download

lue skies are wonderful. They mean we are having a lovely sunny day. This is particularly

meaningful if you live in the UK, which is often the butt of jokes about its horrible weather.
No better time then to get out and take some photographs. The only problem you may find if
you're anything like us, is that landscapes shot on days like this can look a little dull. The light is
great, but the sky is lacking in any drama and it’s just a big, blue, empty canvas. Sometimes the
sky is lovely but it’s in the wrong part of the image in relation to the landscape you were trying
to shoot. Well, there is an answer to your woes with sky swapping. It requires your primary photo
and a photo of a cloudy sky.
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File Edit Image
New (4
Open... _ ®0
Open in Camera Raw... AW 18
Open Recently Edited File (4

Enhance L

e mmm
A

g

o To begin yvou will need vour primary photograph. Go to File
> Open (Cmd + O) and use the file browser to navigate to
the location your photo is stored. You can double-click the image
to open it or highlight it and then click on the Open button in the
lower right of the browser window.

o [he first thing that will need your attention though is the
harizon. In the case of this shot, the camera was tilted
slightly and it means the horizon is not on the level. Luckily, there
is a tool that can help us sort this out with just a few clicks

Doc: 38.6 ; >

o Cur example is a shoreline image taken on a beautiful blue
sky day. Unfortunately, that blue sky just looks a bit empty
and is in need of a little attention to make it more appealing.

All the trees and rock details below make the image lock a kit
battom-heavy. Some clouds should help.

[+ Rotate All Layers
¥ Autofill edges

o o to the toolbar and in the Modify section and then click
on the Straighten Tocl (FP) to make it active. When you do
this, the options panel at the bottom of the screen will display
all of the available parameters and options available for that
particular chosen tool,

M )

[+ Rotate All Layers

e When the image 15 straightenad, vou can choose how the
crop is dealt with once the photo is rotatea. You don't want
to lose too much of the photo so choose the Grow or Shrink
Canvas to Fit option. This way, it won't matter how much the
Image rotates, it will not be cropped.

—5

r:

o Since rotating the mage will create blank areas at the
adges of the photo, you can also select the Autofill Edges

option. This uses the Content Aware Fill technology to analyse

the nearest textures at the edges and fill in the blanks using

cloned texture,
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Mow wou can actually straighten that horizon out. Take the
Straighten Tool and click and drag a line across a tilted

area that you know has to be level. In the back of this photo is a
shoreline which can be used as a guide, Drag along it from left
to right.

g

1]
=

m B
==

m O =

o When vou let go of the mouse, the Straighten Tool rotates
the image enough to level out the shoreline. The entire
image rotated about &%, which has created blank areas as the
canvas expanded to make sure the photo was not cropped.

i

100%

Opacity:

o VWhen you choose to Autofill the edges, the blank areas are
now analysed and then filled with similar textures. Because
of the random fractal nature of the trees, rocks and sea, the filled
areas match very well, with no cbvious cloning errors to be seen.

@ It yvou click on the layer thumbnail for the photo, you can
rename it. We called ours 'shore’. Mow the image is ready
far its blue sky makeover. Go to File » Open (Cmd + O) once
again and navigate to the folder where your cloud replacement
ohoto is kept.

)

N tutornals

Shared Folder

E =

N

shore.jpg tree.jpg

o Our example clouds were chosen because they are litina
similar way to the primary photo at roughly the same time
of day. This is an important consideration since you want the
clouds to look as if they belong in the shot; otherwise the effect
15 going to look very odd.
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Daouble-click the clouds' image to open it. Since yvou anly
need the clouds, you can selectively choose just that area

2,

to add to the primary photo. Go to the toolbar and choose the
Rectangular Marquee Tool (M), You can use this tool to drag a
selection box from the top left corner to the right horizon.




Editor Fie Eait Image Enhance Layer

Undo Rectangular Marquee

i~

N !

Copy

Paste
Paste Into Selection

Delete
Fill

otroke (Outline) Selection...

Define Brush from Selection...

Jefine Pattern from Selectior

When vou let go of the mouse the selection yvou drew
will become active with black and white dashes known
as 'marching ants’. With the selection active, go to Edit = Copy

(Cmd + C) to copy the selected sky area to the clipboard ready
to use in your photo.

* shore.jpg @ 34.]

ENHANCE

® @
s 4

@ Go to the toolbar and choose the Maove Tool (W), You can
use this to physically click and drag the clouds into the top
left corner of the photo and set about making it the right size to
maktch the dimensicons of the primary photo.

SKY REPLACEMENT

5 ;7""-“""‘-#5' -‘l‘"i}

L"'-:ﬁl .

@ Click on the document tab of vour primary photo to make
it active and go to Edit = Paste (Cma + V) to paste the
copied clouds onte the current photo. It will automatically appear

centred on its own layer so as not to destroy the shoreline photo
below it By default the new layer 15 called 'Layer 1,

@ You will see that an active layer element will have control
points around its perimeter. You can click and drag these
control points in order to scale the clouds to fit the new photo.

In this example, clicking and dragging the far right centre contro
point to the edge of the photo.

J U Oa 5

IHnrrml * |

0 You can rename 'Laver 1" as clouds’. Now click on the little
ave icon to the left of the 'clouds’ layer thurmbnail. This will
make it invisible for the moment. You need to work on the 'shore’
layer, so click its thumbnail to make it active.

@ Go to the toolbar and choose the Quick Selection Tool
(A). You need to use it to make a selection of the sky area.
With the Quick Selection Tool active, yvou will see various options

available in the tocl options panel at the bottom of the screan.
Choose a brush size of about 50 pixels.
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@ Use the Quick Selection Tool to start selecting just the blue
sky. Drag the cursor over all blue areas, avoiding all others,
and it will automatically select as you go. Because the tree line

Is of a different colour and hard-egdged, the selection tool has no
real difficulty in choosing just the sky.

9 Simply start to brush over the areas where the sky meets
the horizon line and trees. The Refine Edge tool will make
more accurate, targeted refinements, particularly around the tree
areas. If you are happy that the selection is as good as it can be,
you can click OK to proceed.

Yoelnla &

i Normal

Add layer mask

@ With all of the sky selected, vou can now use the Eafine
Edge tool to make the selection even more accurate. Click
the refine Edge button in the tool options panel to open the
Refine Edge dialog panel. In this case, the default Edge Detection
anc Adjust Edge settings will be fine,

JJde aa s

| Normal - |

@ The selection edge will be refined, ready for the next step.
Click the 'clouds' layer visibility icon to make it visible
again and you will see the selection, denated by 'marching ants’,
overlaid on the clouds. Keep the selection active and make sure
the ‘clouds’ layer is also active.

I
i

@ Click on the Add Layver Mask button in the layer aptions
panel and a layer mask will automatically be added to the
‘clouds’ layer in the shape of the active selection. Anything inside
the selection is white, anything outside the selection is black,
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@ When you Alt + left-click on the layer mask thumbnail, yvou

can view the mask on its own in Black and white, You can
ze2 how the Refine Edge Tool has quite accurately masked the
trees and horizon. You can Alt + left-click the layver mask again to
return to the normal view.




SKY REPLACEMENT

Photo Filtar...

Ireert
Thrashold...
Pasterize...

@ With masks, the rule of thumb to keep in mind is that white
reveals part of a masked image, whereas black will conceal
areas of your photo. In this case, the clouds are allowed to be
visible but anything below the trees is hidden by the black areas
of the mask.

@ It would be good if the sky was just a little darker to match
the exposure of the primary photo. Keep the ‘clouds’ layer
active and click the Create New Fill or Adjustment Laver. Select

Levels from the menu that appears. A 'Levels 1' adjustment layer
will be added above the ‘clouds' laver.

W -=

Opacity: [100% | =

Rename Layer...
Edit Adjustment

Duplicate Layer...
Delete Layer
Group from Layers...

@ Right-click the ‘Levels 1" adjustment layer and choose
Create Clipping Mask from the context menu that appears.
his will clip the adjustment layer to the 'clouds’ layer which is

ir

=
directly below it in the stack. Any adjustments made will only
affect the 'clouds’ layer and nothing else.

The sliders in the Levels panel allow vou to darken and

lighten the Shadows, Midtones and Highlight areas of the
photo. Dragging the Midtones slider to the right slightly will
darken the sky. You can experiment with all the sliders until you
hawve something vou like,

@ A srmall box with an arrow will appear to the left of the
adjustment layer thumbnail to indicate it has been clipped
to the layer below. A Levels dialog panel will open automatically,
ready for you to make adjustments to the clouds.

@ With that, yvour sky replacement is complaete: vou can o to
File > Save As and save yvour lavered document as a P5D
file, This will keep all yvour edits intact should you ever want to
revisit this image and make more amends to it,
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hanks to digital technology you can be a makeup artist and control exactly how you want

your subject to look. Naturally, there are numerous ways you can go about retouching
skin. Some techniques are very simple but do not give natural results. Some people take it to
extremes and end up with their models looking like mannequins. All we are looking to do is
make our model’s skin look as healthy and glowing as possible. We are going to use a technique
called frequency separation. Simply put, you break the base image down into two components.
One layer carries just colour and tonal information, the other layer holds detail and texture. This
means you can work on one, without affecting the other. It’s a simple and effective method.




o Dur example 1s from a portrait shoot of a yvoung moael.
Open your photo in Elements as a new document. The
voung lady has little makeup applied and she has some spots
that the foundation couldn't cbscure so we are going to improve
Far complaxion by removing the blemishes from her skin.

FREQUENCY SEPARATION

Create ~ Share ~
Y Ue 0 a E o =
Normal - Opacity: |100% |~

o Click the 'Background' layer to make sure it 1s active: it will
highlight in blue to let you know it is selected. Then press
Cmd + J to create a duplicate layer. Name this layer 'colour’.
Highlight the 'colour’ layer then press Cmd + J once more to
create yel ancther layver which you can name 'texture’,

Create ~ Share ~

m

Opacity: |100%

lexture copy

+

o Make sure the texture’ laver is now highlighted and press
Cmd + J one more time to create a layer that will be called
"texture copy'. These are all the layers yvou need to begin creating
vour two main layers of texture and colour to edit.

T =
T -
Opacity: |100%

i

Joenoae &

o Make texture copy' and texture’ invisible for the moment
by clicking on their visibility icons to hide them. Make the
'colour' layer active, What vou are going to do is turn this layer
into colour data only. To do that vou need to blur this layer to
remove any obvious detall.
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lect  Filter View Window Heip

Filter Gallery...
Correct Camera Distortion...

Ad|ustments
Artistic

Blur

Brush Strokes
Distort

Moise
Pixalate
Render
Sketch
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Average

Blur

Blur Mare
Gaussian Blur...
Lens Blur...
Motion Biur...
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Gaussian Biur
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Radius: Pinels
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e Go to Filter = Blur > Gaussian Blur to call up the blur dialog
panel. Set the blur Radius to about 15 pixels. You have to
apply just enouagh blur to remove any hard details but leave the
general shape and colour intact. Do not over blur the image anc
merge colours together too much.

Select  Filter View

Window Help

Gaussian Blur o F
Filter Gallery...

Filter View

Gaussian Blur #£F
Filter Gallery... ’

Window Help

Correct Camera Distortion...

Adjustments
Artistic

Blur

Brush Strokes
Distort

Moise

Pivalats

e Make all the other lavers visinle again and make the texture
copy' layer at the top of the layer stack active. You need to

apply the same blur amount to this layer. Go to Filter and the top
menud item will be the last effect you applied. You can also press

Cmd + F to apply the last filter you used.

Correct Camera Distortion...

Adjustments Equalize

Artistic Gradient Map...
Blur Invert .. ol
Brush Strokes Posterize..””
Distort Threshold...
MNoise Photo Filter...
Pixelate

T L B R g lLEmE
i w e I 13

o The texture copy’ laver is bDlurred to the same degres as
the 'colour’ layer. You can use this layer and the un-blurred
‘texture' layer below it to create the second component needed
for the skin retouch. To do this, go to Filter > Adjustments >

TR

Invert (Cmd + ) to invert the 'texture copy’ layer colours.
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Opacity: | 50%

texture

o All the colours of the texture copy' layver will be inverted
lilke a colour negative. With the 'texture copy' layer still
active, move the Opacity slider down to 50%. What vou see now
is 2 combination of the 'texture’ layer below and the current layer
at 50% opacity. These two layvers need to be merged.




FREQUENCY SEPARATION

Opacity: [100%

Edit Adjustment

Duplicate Layers...
Delete Layers
Group from Layers...

Simplify Layer

Enable Layer Mask
Create Clipping Mask

Link Layers

a8iecl LInKeO Layers

Merge Layers
Merge Visible
Flatten Image

o Hold the Shift key and click on the "texture’ and "texture

copy’ layers to select them both, then right-click them to

call up the context menu. Choose Merge Layers to merge them
into one layer. You can rename this layer 'texture’ now that it is

ready to use.

e dae ks

" Normal - |

iexture

Opacity: |100% |+

Set the blending mode for the layer

@ Mext, keeping the new texture’ layer active, go to the Blend
Mode button and choose Linear Light from the dropdown
list that appears. This will blend the ‘texture’ laver into the ‘colour’
layver below and the result of the two should look identical to the
ariginal image.

JJeoeda b

| Linear Light |

P e T L . SR

[ texiure

ENHANCE

@ ¢ 9 M|

W W

hol Options:  Undo  Redo  Rotate  Layout Organizer Home Screen

o You now have your two components. The top 'texture layer
15 detail only with no colour data and the 'colour’ layer 1s
only colour information with no real detail. This is the process

of frequency separation in action, Editing i1s much simpler now
colour and detall are separated from each other,

@ Click on the texture layer to make it active, Texture will be

yvour first stop for cleaning up the skin. Go to the toolbar
and choose the Clone Stamp Tool (5). When vou click on it,
vou will see various options become available down in the tool
aptions panel.

wynvbdmoublicationscom 167




TAKE YOUR SKILLS FURTHER

Go to the brush picker and choose a hard round brush. You

can alter its size later. Hard brushes generally work better
for the kind of cloning of skin we are about to do. You can use
the Size slider to set a brush of about 25 pixels, To begin with,
keep the Aligned box unchecked and keep Mode as Normal.

@ Mow you can move your cursor over the nearest area of
blemished skin you want to retouch. You should see a
realtime representation of the clone source at the cursor position.
When you click over a blemish, the clean source area will be
‘stamped’ over the blemish,

o Take you time with this part of the process. Keep changing
yvour clong source to avoid the build up of repeating
patterns that give the game away as to the use of cloning. You
can use the Size slider to make the brush larger or smaller, If
needed, as well.
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@ Mow the process of cleaning the skin can start. Place vour
cursor over an area of skin that is clean and unblemished
close to the first area you wish to start retocuching. Press the Alt
key and a small target cursor will appear, Left-click the cursor
over the clean skin to set that as your clone source.

Mow vou can carefully begin to clone clean skin over the
blemishes on her face. You can always press Alt and choose
a new area of clean skin as your clone source if the texture
changes too much and needs to be updated. Remember that all
these edits are only happaning on the 'texture' layer.

Once you are happy that her forehead is done, you can

make amends to any other areas of her face and neck that
might need cleaning up. You can remove wrinkles in exactly the
same way by cloning smooth skin over them. Stray hairs can also
oz cleanad up as well.
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Mow that the 'texture' layer is completed and her skin is @ Make the texture’ layer invisiole and make the ‘colour’ layer

looking great, you can turn your attention to the 'colour’ active. Go to the toolbar and choose the Lasso Tool (L) The
layer and even out any mottling that may be present. This is Lasso optional panel will show you various options available for
an opticnal step, but it does give the portrait that extra level of this tool. Go to the Feather slider and set it to about 35 pixels to
professionalism and is very flattering. soften the selection vou are about to make.

o
La o

cl to selection

@ There is a small amount of mottling visible on her forehead @ Press the Shift key or click the Add button in the options
which we want to remowve, as well as softening the shadows panel to add more selections. An area around her left cheek

around her left cheek, nose and chin. Draw around the areas you has also been included and again, softened by 35 pixels to avoid
want to soften with the Lasso Tool. Join up to your start point any hard edges to the colour. Keep this selection active for the
and the selection will be closed and softened by 35 pixels. next part.

" A &

@ 50 to the menu and choose Filter > Blur > Guassian Blur to @ If wou want, vou can also do the sarme to the highlighted
call up the blur dialog panel. Set the Blur ratio to about 20 areas of her right cheek to give more of a matt finish to her

pixels or howewver much you feel is needed to blur those areas a skin. It behawves a bit like adding more digital makeup foundation
sufficient amount, to remove any mettling from her face. Click to her skin, When you are happy, you can go to File > Save As
Ok to blur the selectea parts of the image. (Shift + Crmd + 5) to save your finished result.
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Cnmpﬂsiting is the combining of visual elements from separate sources into single images,
often to create the illusion that all those elements are part of the same scene. In this tutorial
we will be looking at a fairly typical approach for the two main elements of the image which is
the grey/neutral background compositing technique. Shooting your main subject against a grey
screen gives them a well defined edge that makes the process of blending them into another
environment all the easier. Grey screen compositing is the choice of many graphics professionals
and is easier to do than you might think. We have a scenario in which we have a photo of our
subject and want to put them into a much grander environment than just a grey background.

] 11: i L. \“ ."‘1.._
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| _MRK2220.jpg _MRK2221.jpg cell

comp girl.jpg COMP room.|pg S [

d girl edited.jpg girl edited.psd

o o to File = Open and navigate to where the componeants o We have ‘girljpg’ and room.pg’. You will see that the girl i1s
for the scene are stored. In this example, we have our on a grey background. All the lighting gear and extraneous
subject image and a ballroom scene in which to put her, items present in the shot have been cloned out leaving just her
Highlight your images and click Open to create two new tabbed and a plain grey background. The grey background is a key part
documents in Elemeants. of this process,

nents 2019 Editor File EAGt Image Enhance Layer Select Filter View

Undo Select Canvas nz

0% (Layer O, RGB/A) * g2

Copy #®C

Paste €V
Paste Into Selection i AT

Delete

Fill Selection...

Stroke (Outline) Selection...

Defing Brush from Selection...
Define Pattern from Selecion...

iClaar [ ]

Color Sethings...

Freset Manager...

atart Dictation...

o The other image we will be working with is a photograph o For the momeant, return to the 'girl’ document and click on
of a baroque ballroom. There is a perfect spot upon which the layer lock icon next to the layer thumbnail to unlock the
the girl can be placed. Now, you have the two images that will be layer. Go to the ‘room' image and do the same. Press Cmd + A to
combined. You wil see that it is not done in the conventional way select all pixels on that layer and then press Cmd + C to copy the
that vou might imagine but is very effective nonetheless. room’ image, or go to Edit = Copy.
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)p Elements 2019 Editor File Edit Image Enhance

Undo Make Layer

Revert

pg @ 50% (Layer O, RGB/8) *

e Go to the 'girl’ document and go to Edit = Paste ar press
Cmd + V to paste the copied room image into the 'girl’

document. It will appear on its own layer above the 'girl’ layer.
You can name this new layer 'room'. For the moment, click the
visioility icon of the room’ laver to make it invisible,

B
Ll
i1
L

A R L s i o

o Click the "girl’ layer to make it active. You need to make a
solection of her outline to start the compositing process,
G0 to the toolbar and select the Magic Wand Tool (A). Although
the Magic Wand is a fairly simplistic selection method, it actually
works really well in these situations.

Refine Edge...

N OE O E m O E m m m W m W
o e 5 - =

J
N

J
N

o Set the Magic Wand Tolerance to about 34 and make sure
the Contiguous button is checked. Position the cursor over
the grey background surrounding the girl and left-click. The
Magic Wand will select as much grey as the Tolerance setting
dictates. Now we need to aad the parts it missed.
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o Click the Add To Selection button and a small plus symio
will appear on your cursor to indicate anything selected will
be added to the currently active selection. Now vou can click and
add more grey areas until all the grey is selected.
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JJe[e & f =
| Normal M Opacity: [100% |

Opacity: [1!:]{}55_

: - [Layer mask thumbnail
I
*

N o

T — e | qirl
4 ki i |
o Make the 'room’ layver visible and active again. You will see @ Go to the laver options panel and click on the Add Layer
the selection you just made overlaid on the image as a Mask button. When you do, a mask in the shape of the
series of black and white dashes known as ‘'marching ants’. This selection will be added to the 'room' layer. Anything within the
selection can be used to create a mask in the next step. pounds of the selection will be white and anything outside the

bounds will be black. White reveals and black conceals.

Rultiply
Caolor Bum
|I Lirstsar Burm

Crarigar Color

Socroan

Eaolor Dodge
Lirar Dodge |Ada)
Lighter Calgr

|
I
Lighten |r

LIVETLE

Soft Ligh '
Mard Light

wivid Light

o You might notice that the girl looks a little too much like a @ Any area of the neutral grey 'qirl’ background that is

cut out figure. You can remedy that by changing the Blend plendea with the 'room’ layer makes no visual difference
Mode of the 'room' layer to Owverlay. This blends the pixels of the but any parts of the grey background darker than about 50%
‘room’ layer into the ‘girl’ layer. Only the girl is unaffected by the gray show up. This is great since the girl's shadow now appears
olend because of the mask on the layer above. on the grouna.
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@ Mow we can begin to make the whaole image more
cohesive. With the 'room’' layer active go to the layers
palette and click on the Create New Layer button. Call this new
layer 'mist’. We are going to add a subtle atmosphera behind the
figure which is a popular thing to do in images like this.

@ Keep the ‘mist’ layer active and go to the toolbar and
choose tha Brush Toal {(B). In the tool options panel at the
bottom of the screen, choose a large soft brush of about 700
pixels. Keap its opacity at 100%. Make sure the foreground colour
s white,

U U@ O a8 o -

Opacity:

Rename Layer...
Edit Adjustment

Duplicate Layer...
Delete Layer
Group from Layers...

" Normal -

Simplify Layer

Disable Layer Mask
Create Clipping Mask ..

Link Layers
Select Linked Layers

Copy Layer Style
Paste Layer Style
Clear Layer Style

@ Take the brush and paint white on the 'mist' layer around
the upper part of the girl's outline. You will be painting over
wvour foreground figure of course but we can actually use the
mask on the 'room’ layver below to help us remedy the issue.
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@ Right-click the 'mist' layver and choose the Create Clipping

Mask option from the dropdown menu that appears. When

yvou clip the 'mist’ layer to the 'room' layer, it inherits the mask as
well, Suddenly, the mist is appearing behind the girl even though
It is on the layer above.




@

0 The 'mist’ laver will now have small arrow 1con next to its
thumbnail to indicate it is clipped to the layer below. At the
moment the white brush strokes look way over the top. Reduce
the Opacity to about 40% and add Gaussian Blur to the mist to
soften it if yvou want as well.

FOnm

) 100% | Tablet Settings... [

==

QOrganizer Home Screen

@ In the toocl options panel, chose a soft brush, click on the
Brush Settings button and change the Roundneass setting
to 50% and the Angle to -90°. This will make the brush owval
rather than circular. Set the Size to about 400 pixels and ensure
that the foreground colour is still white.

COMPOSITE IMAGES

@ Mext yvou can add some subtle lighting effects to the
candles and windows for a moody feel. Create a new layer
and name it ‘'candles’. Make sure it is at the top of the layer stack
and active. Go to the toolbar and choose the Brush Tool (B)
aqain if not still selected.

@ Start to dab yvour white oval brush over each candle group
in the scene. You can use the Size slider to alter the size
to match the candle sizes that are dotted around the scene.
Although the brush strokes are currently white, you can use
Slend Modes to get a nice glow on those candles.
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Darken
Multiply
Color Burn
Linear Burn
Darker Color

Lighten mist
Screen
Color Dodge L
Linear Dodge (Add)
Lighter Color

Overlay
Soft Light
Hard Light
Vivid Light
Linear Light

Pl i Lol

@ With the 'cancles’ layver still active go to the Blend Mode
button and choose Linear Light from the dropdown list that
appears. There will be no apparent change at the moment but
the next step will create a cosy glow for the candle flames.

Al ..i _
HuigfSaturation
“ © Learn more about: Hue/Saturation |_
| S
Masier - | e
Hiug: 18 L
ﬂ
Saturation: 50
e e ——
Lightness: E
+
c
Eada

@ Go to Enhance > Adjust Colour » Adjust Hue/Saturation
(Crmd + U to call up the Hue/Saturation dialog panel. First,
make sure the Colorize button is checked. Then set Hue to 19,
Saturation to 60 and Lightness to -31. This colours the white
orush strokes orange and blends them into the layvers below.

o6 de i |

@ I s mist

@ You can do a similar technique with the windows. Create a
new layer called 'windows' and use your oval white brush
to paint large dabs of white on the three main windows. You can
use the Size slider again to adjust brush size to match the size of
each window.

Solid Color...
Gradient...
Pattern...

Levals...
Brightness/Contrast...

Hue/Saturation... .
Gradiant Map... *
Photo Filter...

Imvert
<  Threshold... -
Postarize...

@ MNow set the Blend Mode of the 'windows' layer to Owverlay,
then go to Enhance = Adjust Colour > Adjust Hue/
Saturation (Cmd + U again and click the Colorize button so it is
checked. Make Hue 34, Saturation 81 and Lightness -12 to add a
warm glow to the windows.

@ Mow, yvou can add colour effects to tie the foreground and
background elements together. Go to the layer options
panel and click the Create New Fill Or Adjustment Layer button.
Choose Hue/Saturation from the dropdown list that appears.
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@ A 'Hue/Saturation 1" adjustment laver will be addead to the
top of the layer stack. All the layers below it will be affected
oy what adjustments are made. A dialog panel will open and now
go to Saturation and choose a value of about -30 to desaturate
the whole imaage slightly.
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BEFORE AFTER

odging and burning have their roots in the days of analogue photography, long before

digital cameras and computers were in use. Dodging refers to the technique of lightening an
image at the darkroom stage by reducing the exposure of a photographic print in specific areas.
Burning is the opposite, where parts of the image are exposed for longer onto the print, making
those areas darker. With the advent of digital technology the process is done on a computer but
the basic principle and its terminology remain the same. In our example we had a basic image
that was lacking in contrast; using the dodge and burn techniques, brightness and contrast were
selectively added to produce a much stronger image.
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DODGING AND BURNING
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o Eegin by opening a relevant image to work on. Go to File = o The image were are using as our example is a moody
Open (Cmd + O) and navigate to the location of the image portrait but it is guite low in contrast. You could use levels

vou wish to work on, Our example is a portrait named 'dodge adjustments or brightness and contrast, but they are quite global

and burnjpg’. Double-click it to open or select it and press Open amends. LIsing Dodge and Burn Tools you can be much mare

at the bottom of the browser window. selective in your approach.
s - 5 e = : ¥ ~ il -
Y ogena o = STR S - I @ =
Normal 1*] Opacity: [100% | « | | Normal ~r| Opacity: |100% l v |

Layer from Background...

o It's good procedure to work on a duplicate of your image o Right-click your 'Background’ base layer and choose
rather than your original. You never know when yvou might Duplicate Layer from the menu that appears. The Duplicate
nead to call upon it. It's better to have it and not need it, than Laver dialog panel opens and you can choose a name for your

neaed It and not have It new layer and then click OK at the top right of the panel. A new
duplicate layer called 'base’ is created for you.

@ &, ﬁ, a E-IE ﬁl vg le "Edit Image Enhance Layer

Lindo Name Change &®L

I Revert

R 100%

' Normal - | Opacity: |100%| ~

TS

Fill Layer...

Stroke (Qutline) Selection...

Letfine Brush..
Defing Pattern...

o You can use a great little non-destructive method, as we o o to Edit = Fill Layver to open the Fill Laver panel. Rathear
did, for applying Doage and Burn effects to your image than selecting the dual options of Foreground Colour or
without altering its pixel data. Make sure the 'base’ layer is active Background Colour, choose 50% Grey as the fill option. The

and then go to the layer options panel and click the Create A reason for this will become apparent in the following steps. The
MNew Layer button. Mame this new layer 'dodge’. ‘dodage’ layer is filled grey, obscuring the portrait for the moment.
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Create ~ Share ~

JJe. 08 5 o =
v Normal | Opacity: |100%| =
Dissolve

Darken
Multiply
Color Burn
Liraar Burn
Darker Color

Lighten

Screen

Color Dodge

Linear Dodge (Add)

o Keep the 'dodge’ layer active and go to the Blend Mode
button and choose QOwerlay as the blend. Because the gray
is 50% neutral it will not be visible using Overlay as the blending
mode. Anything lighter or darker will have an effect on the layer
below, This is key to the non-destructive method.

Whance  Layer

_Hﬂw
e

Window Help

Layer... . {+#EN
Layer from’Background...
Group...

Group from Layers...

Duplicate Layer...

Delete Layer

Rename Layer...
=y pam e LT '|"_'l
Layer Style Layer Via Copy

Mew Fill Layer

Marmea: ILIynr‘I
] Use Previous Layer to Croate Chpping Mask

Codlar; _Hme v

Mode: | Overlay |  Opacity: 100 = |%
|+ Fill with Owerlay-neutral color (S0% grey)

o Go to Layer > New > Layver (Shift + Cmd + W), The New
Layer panel will open. Under Name, call the layer ‘burn’.
Keep Colour as None and under the Mode button, choose
Overlay as the Blend Mode. Then make sure the Fill with Overlay-
Meutral colour button is chacked.

Uverlay -

—

o Begin by making the 'dodge’ laver active. It will highlight in
blue to confirm it is active. Go to the toolbar and choose
the Dodge Tool (O). The tool options panel will show yvou the
avallable parameters you can apply to the Dodge Tool.
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o We needed a second layer just like the 'dodge’ laver and
could have just pressed Cmid + J to duplicate it but we
wanted to show you another method of creating the 50% grey
layer with the blend mode applied and ready to go.

® A new layer called 'burn’ will be created for vou that is
already filled with 30% grey and set to the Cverlay Blend
Mode. You now have the two layers needed to start Dodaging,
to make the picture lighter and Burning, to make areas of the
picture darker.

’

i Set exposure for stroke

O

i
) IE - . :
E T R

= 9 ¢ D-m m f

bolOptions:  Undo  Redo _Rotate

hs——

@ Under Range, choose the Midtones Painting Maode and
under the Brush picker, choose a soft brush of about 200
pixels. You can use the Size slider at any time to alter the brush
size if required and also use the bracket keys [ and ] to scale the
orush. Set the brush Exposure to 10% or less.




DODGING AND BURNING

@ You can now begin to lighten specific parts of the portrait.
It will be a subjective thing depending on your preferences
but areas that are currently the lightest can be made lighter to
begin to increase contrast. Start brushing over areas like the
forehead, cheeks and nose.

@ Continue to build up the brightness with your brush strokes
on the 'dodge’ layer. Work around the stubble, hair angd
eyvebrows to increase the brightness. If yvou feel yvou've applied

too many brush strokes N one area, you can always press Cmad +

Z to undo a number of steps and try again.

-b.Hle

... .

0 Once an area of the layer is dodged to pure white, it cannat
get any brighter. However, if you feel the effect still isn't

strong encuagh, you can always duplicate the layer for a more
intense effect and adjust the layer opacity If required.

@ With each individual stroke of the brush, those light areas
~ill be made lighter and lighter. Using an Exposure of 10%

or less means that you can be a bit more subtle and build up the

lightening effect gradually rather than zpplying it all at once.

t and click the ‘dodge’ layer thumbnail, you

@ If wvou press &

can see exactly what is happening on that layer, Any part of
the image that is lighter than 50% grey has its brightness aclded
Lo the layer below because of the blending method used. Alt +
click again to return to the normal view.

If vou compare the dodged version of the portrait to the
f_mgln-j vou can see how the brightness has been focussed
on, making the face more three dimensional with the addition
of those brightened skin areas. If you are happy with the docge
aeffects so far, vou can turn your attention to the ‘ourn' layver.
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@ Click the 'ourn' layer to make it active and swap from @ Just as with the Dodge Tool, choose Midtones as the
the Dodge Tool to the Burn Tool by either prassing O Painting Mode by clicking on the Range button. Keep the
until the Burn Tool is highlighted or click on its icon in the too orush as a large soft one and Exposure at 10% or lower,

options panel.

@ Start to add brush strokes on the 'burn’ layer to the darker @ If vou Alt and click the 'burn' layer, you can view that layer
areas of the photo. We started around the eyves and in isolation. Now, any dodged area that is darker than 50%
darkened the sides of his forehead, under the nose and the sides grey I1s added to the lavers below, darkening the portrait. Alt 4
of the cheeks. Again, apply the brush strokes singly and build up click again to return to the normal view.

the darker areas until you have it as you want it.

@ Because vou are working on separate layers, you can @ It it lcoks like the Tourn’ laver effect is too strong, vou can
return to the 'dodge’ layer if you want, swap the Burn Tool always click on the layer Opacity slider and reduce that

for the Dodge Tool again and continue to brighten areas of the layer's opacity to about 70%. we also duplicated the 'dodge’ layer
image to your taste. In the case of this image, we went back and and set the second layer to about 20% opacity bringing a little
orightened the ayes themselves, extra contrast to the brightest areas.
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.hannel: | Master

htm;: _:k- ﬂ.
[ ] Colorize

@ The naxt few steps are optional and down to parsonal taste.

50 to the layer options panel and click on the Create New
Fill or Adjustment Layer button. Select Hue/Saturation from the
menu that appears to set it as an adjustment laver above the
layers already created

@ Cne additional tweak was to add a Levels adjustment and
push the Highlights and Midtones sliders to the left; this
helped boost contrast a little more and highlighted all the work
already done with the Dodge and Burn Tools.

@ We wantaed to recuce the saturation of the image a little
When you add an adjustment layer to the layver stack the
properties panel for that laver will be displayed automatically, We
used the Saturation slider to reduce saturation to about -35

@ A side by side comparison now shows how much the image
has been transformed with the use of targeted brightening
of midtones and also selective darkening of certain areas to
increase the overall contrast of the Image that wasn't present in
the original.

Create = li'ﬂl'!_
e 08 5 T

Mermal -

Dpacity: '-;:-;;';.E
m I Il. I

&« I 1

Hua{Saturation

& I

@ With that vour Dodge and Burn project is completed. You
have applied some very focussed brightness and contrast
adjustments to bring out more detail and create a more dramatic
looking image.

E" 'l people

Shared Folder

_dodge and _dodge and 80c54b6adb68a3 bi
burn.jpg burn.psd 99569c¢...e0ce.jpg

». 7 ’
I d
@ You can choose to flatten the image, by going to File >
Save As (Shift + Cmd + 5) to create a new file under a new

name, or save the document in its layered form as a Photoshop
compatible PSD file,
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TAKE YOUR SKILLS FURTHER

Using Selective

3 Tt e . . -

content is
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available for R ey i e s
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o First of all, vou will need an original phote which has a nica
range of colours, or at least one strong colour you can pick
out, We have used a shot of a fantasy owl image with a snowy
blue background. We have a great display of colours that should
convert to black and white with no issue.

Duplicate: Background

As: |monag
Destination
Document: [ owl.jpg

Name:

o Make sure your base layer, called 'Background’ by default, is
active and then move our mouse curscr over the layer ang
right-click it. A small menu will pop up. Choose Duplicate layer
from the list to create the new layer. A box will appear where you
can name your new layer ‘'mono’. Press OK to continue.

W om W W
o

o Bacause we always strive to work In a non-deastructive
mannar, yvou will need to create a duplicate image by
pressing Cmd + J and name it ‘'monag’. This new duplicate layer
will appear above your base pheto, so that one is safe, Before we
move on, hera is the alternative method for creating a new layer.

Enhance Layer Select Filter
Aubo Smart Fix
Aubo Smart Tona..
AUt Levels
Aubo Conirast
Aubd Haze Removal

AL pen
Auto Red Eye Fix H$R pro

Bopust O

ﬁ-ﬁr:u.mmnmmnmnmmw

Eﬂl Emch siyle uses » dMerent smoent of the red, greesn, |nd|:-|u|-n1
I =
Cionwe

Haze Remaoval..
Adjust Sharpness... | Adjust Intensity:
15 And! "'..E“'
Green: i —
Blum: o
- Conirast: -

o Make sure the 'mong’ layer is active and then go to Enhance
= Convert To Black And White. The Convert To Black And
White panel will appear and you can choose from a number of
preset conversion methods, or yvou can use the Adjust Intensity
sliders until you have a conversion that you like,

Create 2 |
T oeona 5k SRS
Normal o ! Q @
~ SELECT

We've completed our conversion to mong. We've brought
out a lot of mid-tone detail and added some contrast to
make the image quite punchy, but keeping a good range of tones.
You now have the newly created black and white copy 'mong’ as
yvour top layer and vour colour original on the laver below.

o Make sure the 'mong’ laver is active. It will be highlighted

in blue just to confirm it is the selected layer. Now go to

the toolbar and choose the Lasso Tool (L), We will be using this
selection tool to draw out a couple of areas on the image that wil
ultimately reappear in colour,

weavbdmoublications.com 185




o You can draw in a free form fashion using the Lasso Tool
as if you were drawing with a pencil. If you prefer, however,

you can use the Polygonal Lasso Tool instead which draws in a
series of connected straignt lines by clicking on the image on a
point-to-po

L Dasls.

Refine Edg

R R R T

¥ O C ) EH =H

Undo Redo HRotate

ool Options Layout Organizer

o Mow we need to bhe able to add more R—Il—r'ﬁ-’, areas. Go

o the Tool Options menu at the b r:.l:-m of the screen and
choosa Add To Selection ‘f’:nw cursor will now have a small A
wmbol next to it, indicating it will now be able to add another
5-??|F!-F..' on to the one you h.—m—. already.

o Whatever vour preferred selection method, select the main
area of one of the owl's eyes. Don't worry If yvou cannot
accurately select the eye, Just get the main details selected
When you have drawn around that area and joined up with the
start ::-r the selection, yvou will see the marching ants appear.

@ 'F.IF 1 wour preferred method that you used to add the
H-.— add the second eye to the selection. Again,

1 join up the to the start of the newly selected area,
mat ;l: "I,_-l ants will show vou now have the second eye selected
as well as the first,

Cre Create ~ A

Create ~ Shi

I, E},@ﬁ ~g

Add layer mask v

Opacity:

| Opacity: |1

Layer mask *thumbna|

Background Background

A

o Mow we need to create a mask that hides the eves of the
W c!'1-.'j keeps the rest e mono layer visiole. With the

'mong’ ez,f-:r a;:tn-c go to the tﬂp of vour layers palette and click
on the Add Layer Mask button. A layer mask will be added to the
mono' m-;&r in the shape of yvour selection

A

186 BOM's Independent Manual Series | Volume 19

Layer mask thumbn

Background ==

A

@ The main bady -3' the mask neads to be white, with the
actual selection filled in black. You rTuzr natica it is the other

> colours of the mask
s of the

way around. Just press Cmd + | to invert the
he mask on the ‘'mono’ layver is allowing the orange eye
coloured original to show through.
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@ Your mask should now be pregominantly white, Just the
two areas of the owl's eyes should bhe black. If you Alt +
eft-click on the layer mask, you can view the mask in isolation
Press Alt + left-click on the mask thumbnail again to go back to
YOUR MAIn view.

S ————————— O
Create ~ Share ~

ol @ o & En m =
Solid Color...
Gradient...
Pattern...

Opacity: |100%| ¥

Levels...
Brightness/Contrast...

Gradient Mp ;

@ Photo Filter... I:’E
Invert
Threshold...

Posterize...

® Dan't worry If your mask i1s not very accurate. You can
always use a small brush and alternate between black or

white to hide or reveal masked areas until the owl's eyes are the
-“r“i;-_.-' coloured area in the Image. Thr res
Black and white thanks to the

t of the images will be

Hi Saturation

Channel; | Master -
Hueg: @-— — (2
Saturation: 3 +62
Llnhtness —:}l— 1‘_‘|

[ ] Colorize

@ At ‘hi" point you could call the process done. The 'r**-rr‘.::-'

la nas been Hr_uL-JJ with a mask allowing the orange

eyes to E,Pm through. If vou wanted though, you can change the
r’

colour of the eyes. Go to the top of the layers palette and clic
the Create Mew Fill Or Adjustmeant Layer button.

'~.t_:-r

@ Choose Hue/Saturation from the list to add a layver at the
top of the stack. Now if yvou move the Hue slider around,
yvou can alter the colours of the layers below. Since the 'mong’
aver is black and white, it is unaffected, but the eyes on the base
ayer should change until vou have something yvou like.

WU, i
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This tutorial
4 contentis
F.. ¢ available for
F s download

 BEFORE |}

-----

was taker *perfect sha‘;p focus ' omp! r out of fc -r*L to reglster only
light, dark and colour. Back in the darlcrm en: oo :mmsed the idea was
to sandwich one sharp image an&une;ﬁlt of mge ﬁ} “p]flht both of these at
the same time. Of course, these days, % much mor m efficiently with
digital files. Some professional landscape graphers use th% technique in thEIr work today.
We will apply this technique to enhance a love landscape image.

-'__.-:'J'. - —

=
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THE ORTON TECHNIQUE

o The first step is to choose a relevant image that will work
well once the Orton effect has been applied. Scenes with
leaves, water, grass and strong skies work particularly well, For
our example we have a waterfall image with golden leaves and
fish swimming in the turguoise waters.

| @ Ca

ﬂ Opacity: I

‘: Duplicate: Background

.-: As: | screen
Destination

Document: Lannn.jpg

Name:

o Start by right-clicking on the main '‘Backaground’ layer and
choosing Duplicate Layer from the menu that appears. The
Duplicate Laver dialog panel will open ana you can name the
new layer. In this case, name the duplicate ‘screen’. Click OK to
create the new duplicate.

o k@ % o+ B
s

o If vou are using Elements Organiser to locate vour preferrad
Image, once you have selected the one yvou want to use,
you can right-click the thumbnail image and choose Edit With
Photoshop Elements Editor from the list that appears. This will
open the chosan image in the photo editor,

WU Ue n0ack m =

v Normal
Dissolve

Darken
Multiply
Color Burn

Linear Burn Eq
Darker Color Background a8

Lighten
Color Dodg®
Linear Dodge (Add])

o Make sure the new 'screen’ layer is active, It will be
highlighted in blue to let yvou know it is active. Then yvou will
need to click on the Layer Blend Mode button at the top of the
Layer Palette menu. Select Screen as your blend mode from the
list that appears.

Opacity: [11:_:0%_

Duplicate Layer... . Duplicate:
| Delete Layer _ :
: litpl
B Group from Layers... AS: | mu 'tpﬂ
Destination

Document: orton.jpg

Create Clipping Mask Name:

o The first thing vou will notice is that the overall effect of the
blend has made the image vary bright. The brightnass of
the 'screen’ layer is being added to the background layer. There
15 no need to worry about this as the next steps will take care of
the issue.

o Keepn the 'screen’ layer active and right-click that layver
again. Choose Duplicate Layer from the list that appears
once more and name this new duplicate 'multiply' in the dialog
panel, Click OK to proceed and the new layer will be added to
the top of the layer stacl.
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|gmo a 5 U OgPWo & &
' Solid Color... | .

Croate new fill or adjustment layer | Multiply |

@ 1 Hue/Saturation
Gradient Map
Photo Filter. F
@ 3 Irvert
Threshold
Posterize
mesy |
o Mext, vou will need to change the new 'multiply’ layer's o Keep the 'multiply’ laver active and then go to the Laver
blend mode to Multiply. The image will become very dark Options panel directly above the layers stack and click on
as if it is underexposed. That's OK though as we can remedy the the Create New Fill Or Adjustment Layer icon. From the list that
issue. We will need to add an adjustment layer to modify the appears, choose Levels as your adjustment type. This can be
overall image brightness. Jsed to alter the image brightness problem,
Hormal - - C ﬁ & EL Hug/Satdration '
Solid Color... O r——
Normal 4 Gradient... Op ,."r-“\.
Pattern... Hug: == ) fi 1 -5
o Saturation: ' ) +50
L!_'Bhlr“" £/Co Lightness: e— W]
nes ntrast...
| N | Colorize
@ I Hue/Saturation... .
Gradient Map...
J " Photo Filter... r
@ § Invert
— Threshold. P
Posterize.
@ { _ ‘ Background e
- !
s & Reset
o An adjustment layer appears above your three current @ Click on the Create New Fill Or Adjustment Layer icon
ayvers. With the Levels Adjustment active, its Properties tab again and this time select Hue/Saturaticn from the list. A
will open and yvou can lighten the image by pulling the miadle Hue/Saturation adjustment layer will appear above your previous
slider to the left. Adjust until it roughly matches the original Levels 17 layer. We took this example to +50 Saturation and
image's brightness. altered Hue to -5 to increase reds in the image.
Multiply opa Bt View
. Fiter Galleny..
= E - H Correct Camera Distortian...

Adjus T res
Artistic

Brush Strokes
Distonrt

bumrage
Edur
Edur More

Lars Blur...

T Y Y Y Y Y YFYTYIYETYY

Motion Bhr...
Radial Blur...
Smart Blur....
Surface Blur...

rw

Mk Sollect kon

0 As we mentioned in the introduction to this piece, the Orton @ Click on your 'multiply' laver to activate it. Go to the top
effect is created by one sharp image and one out of focus menu bar and select Filer > Blur > Gaussian Blur. The

image combined in such a way as to produce the dreamy look we Gaussian Blur dialog box will cpen and here you can set your blur
are after. At this point all the layers contain sharp images, so we value by altering the Radius value, This value is governed by the
need to remedy that now. resolution of yvour image.
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@ The first thing to note i1s that very large values do not work
well at all for this effect. At 300 pixels, the image looks
guite muddy. In fact, even for an image the size of our example,
only 15 pixels was encugh to generate the soft, dreamy effect we
wers after.

@ Mow we have our 'Ortonized’ image ang we could call it
finished. However, we can take this a stage further and

use masking to bring some areas back Into sharper focus a9alin,
Areas like the foreground trees either side of the image can have
the effect removed, to draw the ayve,

Normal - Opasity: |10 Narmal - Opacity: |1

@ ® 3 Levels 1
a I & I
@ I &® I
@« I ® 3

@ Click your topmost layer to activate it then press Shift +
Alt + Tmd + E to create a new layer that is the merged
varsion of all current layers. Mame the new layer 'merged’. Turn
off visibility of all layers except your original 'Background’, Hue/
Saturation layer and this new ‘merged’ layer.

0 Anply the black brush to the ‘'merged’ layver mask (not
the image itself) over the foreground trees and roots. As
vou brush, the dark areas of the mask lets more and more of
the sharp '‘Background' layer show through. Continue to brush
foreground areas until you are happy.

Create ~ Shi

€ - a5

g Hue/Satu

di Levels 1

miulitply

Brushi < —

Opacity: =)

) Il E q

| Rotate Layout Organizer Home Scr

100%
il

@ Click on the Add Layer Mask button at the top of the layers
palette to add a mask to the 'merged’ laver. Make sure the
merged’ layver mask thumbnail 15 active. Go to the toolbar and
choose the Brush Tool. Select a brush of about 400 pixels and
100% opacity. Make sure the brush colour is black,

w N om N
.

| A

@ If wou Al + left-click an the layer mask thumbnail, vou'll be
able to see the results of your brushwork on the mask. Alt

+ left-click on the layer mask thumbnail again to return to normal
view, You can now save your Orton image as a P5D to complete

the process.
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GLOSSARY

Glossary

For your reference, we have listed many of the terms you'll encounter

as you become

Active layer
The layer currently selected in the
Lavers panel,

Adjustment layer

A laver that lets vou 2pply colaur
and tonal adjustments to vour
mage withaut permanantly
changing pixel values. Lse
adjustment layers to experiment
with colour and colaur tones. Yo
can think of an adjustment layer -3:':
a veil through which the underlving
ayers ara seen.

Adobe Bridge

Bridge s a :-r-'*w ser application
produced by Adobe Svstams as
part of the Creative Suite and

5 usually installed alongside
Fhoteshop, [ts main function is as
the file management hub of the
Creative Su |l-’— It can be used to
open, manage, rate and rename
files as well c*:- edit their metadata.

Adobe RGE

The RGE colour space profile by
Adobe Systerms, Incorporated. It
provides a large gamut of colours.

Aliasing

Tre jaaged effect seen al the
edges of diagonal lines, arcs and so
n, caused by pixels lining up in a
sawhbaobh pattern,

Alpha channels

These are masks which let you
anipulate, isolate and protect

specific parts of yvour images

Anti-aliasing

The smoothing of jagged edges

in digital images by avaeraging the
colours of the pixels at a boundary.

Artefact

Any unexpected and undesirad
change Lo a digital image caused
by incorrect settings or faulty
processing. Examples include
Blooming, maoire, sharpening and
noise

Aspect ratio

The ratic of an image's width to its
height, It is used to determineg how
an image fits on a page or monitor.

Background layer
The bottommost layer in an image,
usually containing tha image data
e Background laver is always
ocked, If vou wanl to change its
_J:a:-ﬂn arder, blending mode ar
oacity, you must first convert it to
a mn_:J.J'-“.r [zver,

Backlight
ght coming from a source behind
the pholtoaraphed sulbjec

Batch processing

Parforming one or more automated
l:. ks to a selected group of files at
the same time.
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Bit depth
The “1l]"“'||:1'." of colours used to

represent & pixel in an image. A
1-bit imagea |’ black and white, an
8-bit image can have 256 colours
ar shades of grey and a 16=bit
mage can hawve 65,536 colours.

Bitmap image

An image consisting of rows and
colurmns of pixels in computer

memory; alsa :I-.-]||~?.‘l:| a raster image

Bitrmap file formats include BMP,

GIF, JPEG, P5D, PICT and TIFF.

EBits per channel
Determines how many tones each
colour channeal can cantain

EBlack Point

m image editing, the black point

5 a tonal agustment that sets the
point at which the deepest shacow
detail in the histogram is clipped

© black,

Elending mode

A feature that controls how pixels

nanimage are attected by a

|:, airting or ecditing tool. The Blena
alour is applied o TI"' h ase colour

_-:: produce a new ,_U r, the result

c_‘-:j:-l-:j:l_lr When applied l:'_: lavers, a

blending mode determines how the

pixels in a layer blend with pixels in

avars bereath it

Brush preset
_a-._ orush with preset settings
for size, thicknass and 50 on
Photashop includes several brush
presets far you to choase from and
W Can Create a large number of
vour own presets as well

Burning
The selective darkening of part of
an image

Camera raw format

A format describing data exactly as
L5 captureq By a camera sensar,
with N iIn-camara processing
applied

Canvas

Ihe workspace around an existing
mage, within the image window,
Laver ca?_a may lie outside the
canvas but it will be clipped to the
canvas when the image is flattenad.
You can change the size and colour
af tha canvas.

Channel

A term for describing the colour
data Iin an Image. A L'_.Ir_:l' K and white
grevscale image has one channel,
an RGCE image has three and a
CHY KR image has four Ordinarily,

a channel describes either red,
green or blue, which are blended Lo
creste all calours.

Clarity
Found in Adobe Cameara Raw. It
Behaves like an intelligent version

more experienced with photo editing.

of Contrast and only alters contrast
within the middle tones of your
mage

Clipboard

The termporary holding area for
data stored with the Cut or Copy
COmMMmancs

Clipping

The lozs of aithar highlight

or shadow details when tone
nformation is forced 1o pure white
ar lack,

Clone

To paint with the Clone Stamp tool.
You must sat a sampling point o
the active layver befare you paint with
the Clone Stamp tool,

CMYK

Cyan, magents, vellow and black
arg the inks most printers use to
produce colour images. Photoshop
noludes full support for CMYK
mode

Colour cast

A urwanted or unaxpected colour
shift in a photo, For example, a
photo taken indoors without a
camera flash may have too much
wellonw

Colour channels
'he component colours from which
.‘|I ~olours inan imags are created,

Euhll*- rL[ rs to red, green and blue
(RGB)
Colour depth
Measures how much colour
nformaticn 1s available to disgplay or
prict each pixel in an image Graater
calour depth means more available
coelours and more accurate colour
representation in the digital image

Colour management
A system used to achieve consistent
COIoUr a3 an image travels from one
device to another; far example, from
camera to computer or computer [o
grriter

Colour temperature

The degree of haat, in Jegrees
Kelvin, that an object would have to
absorh before it -:1 awed in & certain
colour. Each colour is associated
with a colour termperature, as ars
various kinds of light

Compression
A technigue that reduces the file size
of bitmap images.

Cropping

Trimming a patrtion of an image to
rprove its compaosition or to create
a frame around it

Dithering

Th-::- approximation of an unavailable
olour through the use of two or

more availzble colours,

DMG (Digital Megatiue]

An open standard file Fformat

ideny 'eldu—*ri kay ""UL.-Uz‘ Syestems thal
provides an alternative tao proprietary
camera raw files,

Dodging
e selective lightening of any part
of an image.

Dots per inch (dpi)

A measure of printer resolution. High
dpi settings produce prints with fine
clatail. Used for monitors koo,

Duotone
A two colour greyvscale file that uses
Pwa custom inks

EPS

Encapsulatad PostSoript, A file
format used to save images that
will be used inillustration and page
layvout programs.

EXIF

[:‘-’.:"1-..[ geable Image File Format.
A standard for simplifyving the
exchange of data between cameras
and soffware. The data ma y include
camera modal, date and time tha
photo was taken, camera settings,
shiutter speed and 5o an

Exposure

A measure of the armnount of

hight in which a photo was taken
Lnderexposad digital phatos are too
darlk, overexposed ones, too light

Feathering )
Mhe softening of an edage of a
selection,

Flle Format

The structure of how information

15 L"H oded in a computer file. File
formats are designad 1o store

SpEC cific types of information, such as
JFEG and TIFF for image or rcL-;Lr-'
cdata, Al for vector data and PDF for
document exchange

Fill layer

Ao bvpe af laver that contains a solid
colour, a pattern or & gradie rt as an
interchangeable attribute

Filters

Ise filters to clean up oF retouch
wour photos and ar:nlw,.- cpecial
art effects that give your image a
different appaarance

Flattening
Merging of all visible layers into the
Background laver to reduce file size

Font _
A zet of letters, numbers

Gamut o
Mg ranga of Colour thal a device
Can regragduce.

Gaussian blur
A softening effect appled through




a bell-shaped distribution of tones
and colaurs,

Gradient

Any of several methods far
achieving a smooth transition
between two adjacent colours,
which also include bBlack and white

Greyscale

A single channel imaage that
includes only black, white and
shades of grey. Depending on the
bit depth, greyscale images can
reproduce a number of shades of
gray

Halftone

A monachrame image made up of
variably sized dots simulating the
shades of grey in a photograph. ILis
used for reproducing photographs
or PostScript printers and printing
presses

HDR (High Dynamic Range)

& process that combines multiple
exposure variations of an image ta
achigve a dynamic ranges exceeding
that of a =ingle exposure.

Highlight and shadow
The lightest and darkest colours in
an image,

Histogram

A bar chart shiowing the
distribution of the pixel values in a
digital image, The horizontal axis
represents levels from O (darkest}
to lightest (255) and the vertical
axis represents the numbers of
pixels at each level,

Hue

The colaur reflected from or
transmitted through an cbject.

In common use, Fue s the
property that allows a colour to be
distinguished as red, blue, yellow
and so on,

Icc

International Colour Consortium.
ICC device profiles are the industry
standard far reproducing colours
accurately across devices such as
scanners, momitars and printers.

Image cache

& section of hard disk space used
as virtual memory. The image cache
speads the an-scresn redraw of
high-resoluticn images.

Image mode
[he colour mode of an image, such
as Grayscale or RGE

Indexed colour

& colour that i rendered by using a
pixel value as an index to & panel of
256 or fewer colours,

JPEG

Joint Photographic Expearts
Group. A committee of experts
that develop algorithms far
comprassing computer image files.
Can be any grachic file 1o which a
JFEG algarithm is applied, JPEG is
the format generally used to share
phatographs over the web,

JPEG compression
& lossy compression techriguea that
reduces image data and file size.

Layer

& mechanism far overlaying and
combining multiple images. Lavers
are like transparent sheets of glass
that you can stack and rearrange.

In addition to ardinary image layers.,
there are special kinds of layers

Layer group
& collection of layvers saved with a
Photoshop image.

Layer mask

A protected area in an adjustrment
lzver. Areas below the mask cannot
e edited,

Levels

Functionality for adjusting colour
and tone. With a Levels adjustment,
you can set shadow and highlight
values to use a full tomal range,
adjust middle tones only, correct
colour casts, and s0 on.

Locked layer

A laver in the Lavers panel that has
the lock icon appliad. No changes
can be made to a locked layer. A
Backaground laver is always locked.

Megapixel

A term used 1o describe digital
cameara resolution, 1 magapixel
aquals ans million pixels.

Midtone

An area that falls betwsen the
brightest highlight and the darkest
shadow

Moire

A wawy striped pattern in an image,
resembling the pattern of waterad
sk, Moire can be an artefact caused
by & camera's inability o capture the
detall in an image.

Moise

An artefact caused by intarferance
of camera arror, Moise is often saen
as stray pixels of unexpected colour
or a generally "grainy” appearance
Certain compression bechniques can
amplify noise,

Opacity

The amaunt something blocks
light. You can change the opacity
of layers, filters and effects so that
more (oF less)y of the underlying
image shows through

Dvergxposure

An overexposed image results from
too much light being allowed to fall
onto the camera sensaor.

Pancrama

A broad view of a subject, usually

a landszcape, made by overlapping
individual shots as they are taken
and then mearging them 1o form ong
wide image.

Perspective

lhe angle or level from which a
photograph is taken, the camera-gye
WIBW.

Pixel

The basic, rectangular unit of data
that a digital image cansists of.

The edges of pixels can produce a
sawtooth pattern unless anti-aliasing
iz used.

Pixel dimensions

The number of pixels along the
Wwidth and height of an image, This is
a measure of the amount of image
data in the photo, not its physical
size when printed or displayed on a
maonitor,

Pixels per inch {ppi)

A rmeasure of image resolution
stored in a camera or computer
file. High ppi settings produce
photographs with fine detail and
large file size.

Plug-in

A software application or module
that provides extended and specific
functionality from within a larger
host application,

PostScript
& language by Adobhe that describes
the appearance of text. graphic

shapes and sampled images on
printed ar displayved pages.

Preset

A preset is an action that can be
applied 1o an image or group af
images, You save a group of editing
settings such as colour balance,
brightness, contrast and saturation,
which can then be applied to your
selected photos.

PSD

The native uncompressed file format
of Adobe Photoshop and Photoshop
Elemants, based on the TIFF
standard,

Quick mask
A mask channel created in Quick
Mask mode in Photoshop

Raw Files

A Raw file is the unprocessed data
captured by a digital camera sensor.
In most cases, cameras write Raw
files using a proprietary file format.
Raw files give the photographer

the advantage of managing image
processing during post-production
rather than latting the camera makea
the processing decisions, as happens
when shoating in JPEG format.

Red eye

The reflaction of the camera flash
from the retina of a photographed
subject, resulting in a red dot in the
subject’s ave, You can eliminate

it automatically when you import
images or by using the Red Eye
Remaval tool.

Resample

[o change the resclution of an image
by changing its pixel dimensions,
Downsampling decreases the
number of pixels and upsarmpling
increazes the numbar of pixels.

Resolution

A measure of the clarity and
sharpness of an image. In digital
images, it is measured in pixels per
inch.

RGE

A model for representing colours on
a computer display. Red, green, and
Blue (RGEE) are combined in different
proportions to represent any colour,

Rule of Thirds

If vou divide an image into three
equal sections both vertically and
horizontally, where the lings intersect
15 commonly regarded as good
placement for the subjects in your
photos.

Sample

To select a colour with the
eyedropper in order to use it with a
drawing or painting tool.

Saturation

The purity, or strength, of a colour.
A fully saturated colour containg no
grey at all.

Selection

A part of an image selected for
manipulation of any kind, duplication
in a layer, colour correction, deletion,
rotation and so on.

Shadow Detail

Refers to the amount of detail that
can be seen in the darkest areas of a
photogaraph,

Sharpening

In photo-editing programs, any
functionality that enhances the
details at the edges of photographed
chjects and pecple.

Skewing
Deviation of the content of an image

GLOSSARY

from a vertical ar honzontal axis.
Skewing can be a cameara affect or
an intenticnally applied effect.

Smoothing

A technigue for averaging the values
of neighkouring pixels to reduce
contrast and create a soft, blurry
effect,

Split Toning

Thiz aoption lets yvou alter the colour
of the shadow and highlight areas of
your images, For example, you can
add a blue colour cast to the darkest
areas of yvour photo but makea the
brightest areas of tha same image
More orange.

Stroke

An outline round an image or part
of an image, ar the characteristics
of the lines created with ane of the
painting or drawing tools, especially
brushes.

Swatches
Preset colours that yvou can choose
from in the Colour Swatches pangl,

Thumbnail Image

A small, low resolution image
praview used on the wak tolink to 3
high resolution version of tha file,

TIFF

Tagged Image File Format. A digital
image farmat widely used for images
that are to be printed or published,
TIFF images can be compressed
lossless by,

Transform

To scalg, shrink, enlarge, skew
distort, rotate or change the
perspactive aof a layer, selaction or
shape.

Transparancy

In digital phatography, the
functionality that supports
transparent areas in an iImage or
image layer, Certain image formats
do not support transgarency.

Underexposure

An underexposed image results from
toa little light being allowed to fall
onto the camera sansor,

Unsharp mask

A technigue that sharpens details in
an image by increasing the contrast
between light and dark areas. The
name originates from traditional
photography, where contrast is
increased by adding a shightly
blurred negative over the original.

Vibrance

Yibrance is a form of intelligent
maturation. &= you increase the
Vibrance in an image, only the
rmiddie tones of your image are
altered first.

Vignetting
an effect whara the edges of an
image fade aut.

Warping

A distortion of an image, often text,
to conform to a variety of shapes
For instance, a line of text can be
warped in the shape of an arc or
wave.

White balance

A function that compenszates for
the different rendering of identicsl
colours under different sources of
light: incandescent, fluorescent,
cunlight and sa on.

White point

A reterence point used to represent
white. This reference paint 15 used
to calculate all other colours in the
maaqe.
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Elements
Manual

Photoshop Elements is a great option for those who want an
extensive toolset that can take on their image editing and
cataloguing needs. From organising your content into cohefent
and easy-to-find folders, to making your photos look z%"
with automated edits and getting hands-on in Expert mode, tRish
manual will take you through the processes in easy-to-follow
steps. Photoshop Elements is powerful and intelligent eng

give you more time to be truly creative.

Get organised

Your hard drive content no longer has to be a mystery.
The Elements Organiser module allows you to find,
catalogue and organise your content. Add keywords to
speed up the process of selecting the relevant images
you want and get organised automatically by date,
people, places and subject matter.

Create quickly
The Photo Editor module is broken down into three

main modules with its own particular set of tools o
and options. You have the Quick Edit module for The Quick
intelligent and fast edits using basic tools and presets 000 Wor space

to swiftly get your photos looking superb. We can
show you how to use colour correction, lighting fixes
and more.

Quick guidance

The next module is concerned with Guided edits.
These are mostly automated step-by-step guides and
you can choose from a selection of tutorials to help
you make amazing-looking artwork with just a few
clicks. There are numerous basic guided edits as well
as more fun and advanced edits. We have a handy
reference guide to them all.

Be an expert

Finally the Expert module gives you access to all the
main editing tools so you can apply more advanced
edits to your photos. This guide takes you through
the various tools available and finishes off with some
more involved projects to really show how you can be
a master image manipulator with creative techniques
and effects.

Take
Your Skills
Further
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